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About this release 

Welcome 

Lotus Notes, Domino Designer, Domino Server, Domino Web Access, Domino Access for Outlook, Domino Offline Services (DOLS), 
Domino for i, Domino for System z 

Welcome to IBM Lotus Notes , Domino, and Domino Designer 
Welcome to the IBM® Lotus® Notes® and IBM Lotus Domino® Server family of software products.  Lotus 
Notes 8.5 and Lotus Domino 8.5 are the latest releases of the world's leading products for information 
management, messaging, collaboration and application development. 

These Release Notes contain information on the many new features and enhancements included in the 
Notes and Domino software products.  For more detailed information on the features, see the online help 
for each product, as well as the "Documentation Updates" chapter of these release notes. 

Before installing, please review the "Installation, migration, upgrade, and configuration information" 
chapter of these Release Notes. 

Lotus Notes, Domino Designer, Domino Server, Domino Web Access, Domino Offline Services (DOLS), Domino for i, Domino for 
System z 

Notes and Domino Help - usage and availability 
Following is information about the Help files provided with IBM Lotus Notes and Domino 8.5 Beta: 

Notes and (New!) Domino Designer Eclipse -based Help 

Lotus Notes and Domino Designer 8.5 include an Eclipse-based Help system that lets you display 
context-sensitive help in a side panel while you work. In addition to help for Notes and Designer, this Help 
includes sections on Sametime Connect, Activities, Feeds, Composite Application Editor, Portal Template 
Library,Google Desktop Search, and IBM Lotus Symphony, all of which might be installed during or after 
Notes client installation. The help travels with its component, and therefore each section is installed on 
your computer in its own path within the Notes data\framework directory. 

You can access Notes client end-user and Domino Designer Help in the following ways. 

z	 Click Help --> Help Contents from the menu bar 

z	 For context-sensitive help, press F1 (Ctrl+F1 for Linux users), click Help --> Dynamic Help from the 
menu bar, or click the "?" in the toolbar or in the top right corner of most dialog boxes 

Also see the Documentation Updates section of these release notes. 
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New! IBM Lotus Domino and Notes Beta Information Center 

Administrative help for the Domino server, Notes client, and Domino Administrator client, as well as 
end-user help, for the 8.5 beta release can also be found in an IBM Domino and Notes Information 
Center: 

http://infocenters.lotus.com/help7/index.jsp 

This Information Center also contains the help for the Lotus Domino 8.0.1 and 8.0.2 (beta) Administrator, 
including Domino Access for Microsoft Outlook (8.0.2 only). Each topic contains a Comments field where 
you can enter your opinion on the beta information so that it can be considered for the final version of the 
documentation. 

Administrator Help 

Lotus Notes and Domino 8.5 Beta includes a Help .NSF file and an information center link (see above) for 
Lotus Domino Administrator help, including server and client installation, upgrade, and configuration. The 
Help .NSF file is installed by default in the HELP directory of your data directory. 

Title Database file name Description 

Lotus Domino HELP85_ADMIN.NSF Lotus Domino server and Lotus Domino 
Administrator 8.5 Help Administrator Help 

You can access Domino 8.5 Beta Administrator Help in the following ways: 

z For the most current help, see http://infocenters.lotus.com/help7/index.jsp 

z Click the link to Help on the Domino Administrator Welcome page 

z Click Help --> Help Topics from the menu bar 

z Press F1 

z Click the "?" in the top right corner of most dialog boxes 

z Click File --> Application --> Open and browse to your local directory or a Domino server 
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New in this release 

Lotus Notes, Domino Designer, Domino Server, Domino Web Access, Domino Access for Outlook, Domino Offline Services (DOLS), 
Domino for i, Domino for System z 

New features in IBM Lotus Notes  8.5

The following list represents an overview of the new features that are available in IBM Lotus Notes 8.5.  

For more comprehensive information about new features, please refer to the Lotus Notes 8.5 Help 

documentation by choosing "Help -> Help Contents" from the menu bar, or on-line at: 

http://infocenters.lotus.com/help7/index.jsp.


General Functionality 

z	 Context menus have been streamlined for Mail, Contacts, and To Do views.  Right-click documents in 
any of these views, and you will see a more concise menu, with options relevant to the context.  
Additionally, you can right-click documents to mark them read or unread. 

z	 Navigate Notes preference fields using the Tab key. 

z	 Automatically compress images pasted into documents.  Note that bitmap (.bmp) images that are 
imported into a Notes document are compressed; bitmap images that are pasted into a Notes 
document are converted to .gif or .jpg format. Choose "File -> Preferences -> Basic Notes Client 
Configuration", and then choose the appropriate setting under 'Additional options' (the setting is 
selected by default). 

z	 Drag-and-drop has been enhanced.  Drag-and-drop between rich text fields in Notes documents 
(Windows only), drag Sametime Contacts names or groups to Notes name fields and rich text fields, 
or drag names from external applications to Notes name fields. 

z	 Roaming User for Notes standard configuration is introduced in this release.  A new Roaming policy 
settings document is introduced to support this functionality, as are two new roaming-specific 

TM
databases (a Feeds subscription database and an Eclipse  plug-in data and preferences database).  
User files configured for roaming now appear in a single Roaming Applications folder on the Notes 
replicator page. A new Roaming preference panel is available for Notes users configured for file 
server-based roaming.  Note: Roaming User in the Notes standard configuration is not supported on 
the Mac OS® or Limux platforms for this beta release. 

z	 When you hover over Live Text and the cursor appearance changes, you can left-click the Live Text 
instance to start an action. If a default action has been assigned, the action runs.  If no action has 
been defined as default, a panel of options appears. 

The right-click Live Text action available in Notes 8.0.1 has been replaced with a Live Text context 
menu which you can access by clicking on the hover icon which displays when you hover over any 
Live Text instance. 

z	 Widgets and Live Text support on the Linux® and Mac OS platforms is introduced with this release; 
previously, Widgets and Live text was available on supported Windows platforms only. 

z	 Notes 8.5 adds support for installation and use on Macintosh OS.  See the "Notes and Domino 8.5 
platforms and system requirements" release note for operating system version support. 

z	 Notes 8.5 adds support for installation and use with Citrix® software.  See the "Notes and Domino 8.5 
platforms and system requirements" release note for version support. Note: This support was initially 
made available in Notes 8.0.1. 

z	 Notes 8.5 adds support for Notes standard configuration installation and use from a USB drive. 
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z	 The Notes basic configuration Allclient install kit is no longer available, however the Notes-only basic 
configuration install kit remains available.  Customers looking to install or upgrade to the Domino 
Designer 8.5 or Domino Administrator 8.5 clients must use the Notes standard configuration Allclient 
install kit. This is applicable to the Windows client platform as there is no Notes basic configuration 
install kit for the Mac OS or Linux platforms. 

z	 The Notes start-up sequence has been reordered as part of a performance enhancement in this 
release. 

Mail 

z	 Type-ahead includes all e-mail addresses stored in a user's contact entry  To select an alternate 
e-mail address, when you begin typing a name, select "Other E-mail Addresses" from the menu that 
appears.  The more frequently-used addresses display at the top of the list. 

z	 A new Folder column in the mail 'All Documents' view displays any mail folders that a document is in. 

Calendar 
TM

z	 Add Google Calendar  entries, another Notes user's calendar, or an iCal® feed.  In the Views panel 
of the calendar navigator, choose "My Calendars -> Add a Calendar".  Once the name you give to the 
other calendar displays in your navigator, click the check box beside it to display its calendar entries. 

z	 Horizontal scroll bar for Calendar views has been added.  When all of the header information for 
calendar entries cannot be displayed completely for a day in a calendar view, the day displays a 
horizontal scroll bar.  You can use a mouse or the keyboard left and right arrow keys to scroll with the 
bar, and display the rest of the header information for calendar entries. 

Contacts 

z	 Importing and exporting contacts is available.  To import external contacts to your Notes Contacts, 
from Contacts, choose "File -> Import Contacts".  If field remapping is required, it can be done first, or 
done in Contacts after the import.  To export your contacts, and to now filter which contacts and fields 
to export, from Contacts, choose "File -> Export -> Contacts". 

z	 Forward contacts as a vCard from Contacts.  Select the contact(s) you want to forward as a vCard 
and choose "Forward vCard". 

z	 Add international sets of alphabet tabs.  Choose the menu icon at the bottom of the tabs column, and 
then choose from Greek, Hebrew, Arabic, Thai, Vietnamese, Japanese, or Cyrillic. 

Notes Applications 

z	 New Notebook (formerly Personal Journal template). The Personal Journal template has a new 
name, and a new look. When you install or upgrade to Notes 8.5, any new Notebook you create will 
use the new template (Notebook8.ntf). In addition, any existing journal template will be updated 
automatically if one of the following conditions are met. 

z	 It is named journal.nsf 
z	 It was created from the Default Home Page 
z	 It was created manually using "File > Application > New" and was subsequently linked to your 

default Home page by using the "Set Journal" option. Journals created this way but not linked to 
your default Home page will not be updated automatically. Use "File > Application > Replace 
Design" to update existing journal templates manually. 
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z	 More seamless failover in mail client and composite applications.  Since version 8.0, the Notes client 
is itself an example of a composite application involving both Java and non-Java components.  In the 
Notes client for this release, regardless of which part (component) of your mail client you are in, 
initiating an action when your mail server is down will cause that component to fail over to another 
server in the cluster. 

For example, if you are working in the Follow Up or Calendar miniview (an .NSF component of your 
mail application) and your mail server goes down, the miniview will fail over.  Moreover, the failover of 
one component triggers all related components to fail over; in the previous example, the failover by 
the miniview triggers the Inbox to fail over as well. 

Sametime in Notes 8.5 

z	 Drag messages to add names to your Sametime Contacts list.  You can drag a Mail message to any 
personal group in your Sametime Contacts list and add all the members of the group to your list at 
one time.  This can also be done with Calendar and To Do entries that have recipients (such as 
meetings or group To Do assignments), and with Contacts entries. 

Lotus Symphony in Notes 8.5 

z	 Performance enhancements, including .ODP and .PPT file format save, application start up, new 
document creation, spell checking in Presentation and Spreadsheet, Presentation page painting, and 
an optimized sidebar refresh 

z	 Interoperability with other file formats 

z	 Improved support for chart rendering, numbering and bulleting with Microsoft Office documents 

z	 Support for opening and playing Microsoft PowerPoint .PPS file format 

z	 Support for displaying Presentation table in OpenOffice.org 

z	 Improved support for graphics and layouts in SmartSuite documents 

z	 Function enhancements in three editors 

z	 Support for the page slider function in Presentation 

z	 Support for the validity list function in Spreadsheet 

z	 Improved support for the Table of Contents function in Documents 

z	 Improved support for spell checking in Presentation template files 

z	 Improved support for configurable default file types when creating new documents 
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Lotus Notes, Domino Designer, Domino Server, Domino Web Access, Domino Access for Outlook, Domino Offline Services (DOLS), 
Domino for i, Domino for System z 

New features in IBM Lotus Domino  8.5

The following list represents an overview of the new features that are available in IBM Lotus Domino 8.5.  

For more comprehensive information about new features, please refer to the Domino 8.5 Administrator

Beta Help documentation, available by choosing "Help -> Help Topics" from the Domino Administrator

client, or on-line at: http://infocenters.lotus.com/help7/index.jsp.


Notes Client Administration /Support 

z	 Notes 8.5 introduces support for file server roaming and IBM Lotus Domino server roaming, for the 
Notes Standard configuration client only.  Server roaming is not supported with the Notes client basic 
configuration.  If you use the Notes client basic configuration, you will roam as in previous Notes and 
Domino releases. 

z	 Notes 8.5 introduces support for installation and use of the Notes Standard configuration client from a 
USB drive. 

z	 Notes 8.5 introduces support for Widgets and Live Text on supported Linux and Mac OS platforms; 
previously this was available only on supported Windows platforms. 

z	 Notes 8.5 supports installation and use on supported Mac OS X platforms. 

z	 Notes 8.5 supports installation and use on supported Citrix platforms. 

Databases 

z	 The Domino Attachment and Object Service (DAOS) reduces the total cost of ownership of 
maintaining any participating Notes database by storing all file attachments in a separate repository 
on the server and retrieving them by reference. Multiple copies of the same attachment in any 
participating Notes database on the server are stored only once, eliminating disk space devoted to 
duplicate storage. 

Groups 

z	 The auto-populated groups feature uses pre-defined criteria to automatically determine and update 
group membership. Use the auto-populated groups feature to apply policies to users and groups 
based on their home servers. 

Policies 

z	 Dynamic policy assignment is a new option for assigning explicit policies that allows administrators to 
assign policy settings to individual users and groups simply by specifying the appropriate user or 
group name in a policy document.  As the organization changes, only the Group document needs to 
be updated. For example, if a user changes jobs or organizations, you do not need to determine 
which policies need updating; the updated group information is applied the next time the effective 
policy is calculated for any users in that group. 

z	 A new Roaming policy page has been added in support of the file server roaming and Domino server 
roaming user functionality introduced in this release for Lotus Notes users (Notes Standard Client 
configuration only).  A Domino 8.5 server is required to see and use the new policy page, and the new 
roaming functionality. 
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Security 

z	 Notes shared login allows users to start Lotus Notes and use their Notes ID, without having to provide 
Notes passwords. Instead, users only need to log into Microsoft Windows using their Windows 
password.  Unlike the Notes Single Login feature in earlier releases, Domino 8.5 does not use the 
Windows password for the Notes ID file.  Instead, it stores a secret used to unlock the Notes ID file in 
a secure way, provided by an external mechanism.  Domino 8.5 uses a Windows mechanism, so the 
secret will only be accessible by users who have logged into Windows. 

z	 A Notes ID vault is an optional, server-based database that holds protected copies of Notes user IDs.  
An ID vault allows administrators and users to easily manage Notes user IDs. When IDs are lost, new 
copies are easily recovered from the ID vault.  When users forget their Notes passwords, 
administrators can provide help instructions that are displayed when users click the new Forgotten 
Password button in the Notes login window.  Authorized personnel can reset (change) the passwords, 
without requiring access to the ID files or the vault. Or a custom self-service agent can be used to 
allow users to reset their own passwords.  Policies are used to assign users to a vault, and copies of 
the user IDs are uploaded from Notes clients to the vault automatically after authentication with a 
server once the policy has taken effect. 

Note: Because ID file synchronization work is still in progress, for beta you should use the vault only 
in a test environment, without production users and user IDs. 

Server 

z	 Console log mirroring causes a new server thread to be created which monitors all messages written 
to the Console Log file, and duplicates those messages into another file.  When the new file is filled, 
the thread closes the mirrored file and creates a new file into which subsequent messages are written. 

Server commands 

z	 New and enhanced server commands include: 

z	 Show Stat Mail - View new messaging statistics in the server console window when you enter this 
command. 

z	 DAOS Prune - Forces objects in the Domino Attachment and Object Service (DAOS) repository that 
are currently awaiting deletion to be deleted immediately, overriding any specified setting for 
deferred deletion. 

z	 Show Tasks - The Show Tasks server command now includes task status from additional mail

router threads, and generates detail regarding router activity.


z	 Show Server and Show Directory - These commands now report whether the Domino Attachment 
and Object Service (DAOS) is enabled, and provide a list of which databases are included in DAOS, 
with details for each. 

Web Server 

z	 The Domino Web server can serve files compressed by gzip (GNU zip); this feature is enabled by 
default.  You must add the compressed file to the appropriate server directory, and certain restrictions 
apply. 
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IBM i Operating System 

IBM i is the new name for the i5/OS operating system, featuring the newest release, IBM i 6.1.  IBM i is for 
IBM Power Systems including AS/400, iSeries, and System i.  For more information, see 
http://www.ibm.com/systems/i/.  

For more information about Domino 8.5 on IBM i and which versions of the IBM i operating system can be 
used with Domino 8.5, see the following release notes: 

IBM i: Getting started

IBM i: Software requirements


Lotus Notes, Domino Designer, Domino Server, Domino Web Access, Domino Access for Outlook, Domino Offline Services (DOLS), 
Domino for i, Domino for System z 

New features in IBM Lotus Domino Designer  8.5 
The following list represents an overview of the new features and improvements that are available in IBM 
Lotus Domino Designer 8.5. For more comprehensive information about new features, please refer to the 
Lotus Domino Designer 8.5 Help documentation, available by choosing "Help -> Help Contents" from the 
Domino Designer client. 

Domino Designer in Eclipse 
Domino Designer moves to the Eclipse platform for Notes 8.5.  This direction moves the application 
development aspects of Notes Domino to the same Eclipse platform that is supported starting with the 
Notes 8.0 client. You can consolidate application development onto the Eclipse platform - an open source, 
pluggable environment that helps you reduce training expenses while promoting reuse and sharing of IT 
artifacts for more efficient development.  Lotus software embraces and builds upon many open standards 
and this move for Domino Designer 8.5 helps you combine collaboration tools and business applications 
for a more productive end user experience. 

Some of the benefits of the move to the Eclipse platform include: 

z Extensible script editor and debugger framework 
z Built-in editors for CSS, XML, HTML 
z Ability to take advantage of the continuing improvements in Eclipse 
z Ability to extend the tool through Eclipse extension points 
z Ability to work with multiple IBM tools in a single container 

New design elements for this version include: 

z XPages 
z Custom controls 
z Server-side JavaScript libraries 
z Themes 
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Application Design 

XPages 

An XPage is a new design element that lets you create Web 2.0-enabled pages based on JSF 
technology. XPages remove the barrier of web programming in Domino by providing advanced page 
design capabilities and complete control of the generated markup.  XPages also allow access to any kind 
of data, and provide an easy method for localizing applications.  XPages are one of the design elements 
available from the Designer Navigator (the left-hand tab of the new user interface).  Refer to the Designer 
online help for more information. 

Note: IBM i does not support XPages in this beta release. 

Specific features of XPages include: 

z	 AJAX-enabled, for example, partial page refresh, type-ahead capability 

z	 Advanced web control library, for example, tabbed panel 

z	 Full support for styling using CSS 

z	 Fully extensible using custom controls (composite controls or Java-based controls), or JSF 

extensions. 


A custom control is a collection of controls that are stored as a single object.  Similar to subforms in 
Domino Designer, custom controls are design elements that you can create once and add to 
multiple pages.  When you update a custom control, every page that uses that custom control gets 
updated with the changes. This saves you design time because you do not have to update each 
separate page. 

Common uses of custom controls include adding a company logo to business documents or adding 
mailing label information to mail and memo pages. A custom control can be a permanent part of a 
page or can appear conditionally, depending on the result of a formula. For example, you might offer 
users a choice of custom mail pages with different graphics and styles for various types of mail 
messages, such as memos, alerts, or letters. 

In addition to reusing custom controls across multiple pages and managing updates in a single 
place, you can also add editable areas to custom controls, create shared libraries of custom 
controls to use across components, and organize custom controls in the Controls palette for easy 
access.  By default, custom controls are stored as XSP and XSP-CONFIG files in your Eclipse 
workspace.  Refer to the Designer online help for more information. 

z	 JavaScript scripting language support for client-side and server-side actions 

z	 Pre-built, simple actions provided for most common cases 

z	 Direct access to Java libraries on the server 

z	 Ability to use new Themes design element - Themes are available for XPages to provide

server-side customization of HTML generation that can be used to define the look and feel of an

application.  


Themes can be set globally, to apply to all applications run on a server, or applied to a single 
application, and different themes can also be applied depending on context.  Additional features of 
themes include: 

o	 A theme can assign values to any XML property, including such functional properties as the 
number of rows displayed by a view. 

o	 Themes can assign values of JSF expressions, which will be interpreted as if that expression 
was in the source. 
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o	 Themes can be used to control all XML properties of an XPage. 

o	 Themes are different from Style Sheets in that they are not restricted to CSS styles.  Themes 
can control all CSS style properties and the body style attribute for web pages served by 
Domino; the same theme can be customized to target the XPages and Domino Web 
environment with different properties. 

Themes are one of the design elements available from the Designer Navigator (the left hand tab 
of the new user interface), and are available under the Shared Resources design element 
category.  Refer to the Designer online help for more information. 

Classic Designer features 

JavaScript controls for display of of rich text - This release permits the display of rich text on the Web as 
a Dojo-based JavaScript control. Dojo is an Open Source DHTML toolkit written in JavaScript.  See 
http://dojotoolkit.org. 

z	 The default styling for JavaScript controls is through the following Cascading Style Sheet (CSS) file 
on the Domino server: domino\data\domino\js\dojo\ibm\domino\domino-default.CSS 
, where domino\data\domino\js\dojo\ is the Dojo directory under the Domino data directory; 
take care if you modify this file. You can modify rich text Web styling through the HTML tab of the 
properties box. 

z	 When designing a Web application, the following options define how rich text displays in a browser: 

o	 "Using HTML" renders the control as HTML and is the default behavior. 

o	 "Using Java Applet" renders the control as an applet. This allows browser users to see 
mouse-over distinctions for items in the outline, including change of color to indicate a 
selected item, and see background items. 

o	 "Using Best Fit for OS" allows the Domino Web server to render the control as it sees fit 
depending on the client browser. 

o	 "Using JavaScript Control" renders the control as JavaScript using the Dojo toolkit.  The 
benefits are similar to using an applet, but the Dojo-based mechanism uses standard HTML 
and CSS. 

o	 To specify how to display rich text, create a rich text field, then choose "Design - Field 
Properties". On the Info tab, for 'Web Access', select "Using HTML", "Using Java Applet", 
"Using Best Fit for OS", or "Using JavaScript Control". 

Ability to enable enhanced HTML generation - the new "Enable enhanced HTML generation" database 
option turns on several new features of the Domino Web Engine.  This includes the following: 

z	 The HTML will be "XML Compatible" meaning that it is parseable with an XML parser. 
z	 Class names are automatically added to the markup for action bar, outline and view.  The class 

names can be used to style the markup. 
z	 Limited support for XPages themes: at the database level one or more stylesheets can be 

associated with every page generated by the web server, and a class name can be associated 
with every <body> tag generated. 
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Specifically, NOTES.INI HTML settings have been added that can be used by editing your NOTES.INI file.  
The following new settings and options are featured: 

z	 DominoStrictHTML=101 - forces the closing of all closable HTML tags 

z	 DominoHTMLOptions=AutoClass=<setting>,Themes=1 

where 

o	 AutoClass -- adds class names to various notes objects, see table 
o	 Themes=1 -- turns on limited xPage theme support in the Domino Web Server 

For example, a web application developer will be able to create a CSS stylesheet that controls the styling 
of a Domino web page for a specific set of Domino objects.  Also, a skilled JavaScript developer will be 
able to manipulate a set of Domino objects in the browser at runtime with JavaScript code. Neither of 
these capabilities existed in previous releases. 

Programming 

LotusScript language 

z	 Date statement - not valid on UNIX or Macintosh OS X operating systems 

z	 Time statement - not valid on UNIX or Macintosh OS X operating systems 

z	 Limits on file operations in LotusScript - No limit to the line length of a Write statement 

z	 Spaces in LotusScript file names - Determines which file handling routines preserve leading spaces 
and which remove them. 

Formula language 

z	 New function - @AbstractSimple. 

z	 New command - CopySelectedAsTable @Command. 

LotusScript/COM/OLE classes 

z	 The NotesAdministrationProcess.AddInternetCertificateToUser method is now 
available for use with the CA process. 

z	 New method - NotesDatabase.GetAllReadDocuments. 

z	 New method - NotesDatabase.GetAllUnreadDocuments. 

z	 New method - NotesDocumentCollection.Intersect. 

Java/CORBA classes 

z	 Running a program - Support for the Sun Java 2 Platform, Technology Edition, v 1.4.2. 

z	 The AdministrationProcess.addInternetCertificateToUser method is now available for 
use with the CA process. 

z	 The AgentContext.unprocessedDocuments property can now run Before New Mail Arrives and 
After New Mail Arrives. 

z	 New method - Database.getAllReadDocuments. 
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Domino Web Access 

New features in IBM Lotus Domino Web Access  8.5

The following list represents an overview of the new features that are available in IBM Lotus Domino 8.5.  

For more comprehensive information about new features, please refer to the Domino 8.5 Administrator

Beta Help documentation, available by choosing "Help -> Help Topics" from the Domino Administrator

client, or on-line at: http://infocenters.lotus.com/help7/index.jsp.


To view the newest Domino Web Access features, you must have a Domino 8.5 server installed.  In 

addition, users must be registered using the Domino Web Access mail system, and the Mail (8.5) mail

template.


z	 A new Ultralite mode provides mail, contacts, and a day-at-a-glance calendar on the Apple iPhone or 
iPod touch. For information on ultralite mode, see the topic "Domino Web Access ultralite" in the 
Domino 8.5 Administrator Beta Help documentation referenced at the beginning of this release note. 

z	 Support for mail policy settings to set or to enforce mail settings for Domino Web Access users. In 
addition to supporting exising settings that can be applied to either a Notes or a Domino Web Access 
user, the Mail policy settings document includes a Domino Web Access tab that includes settings for 
Domino Web Access users only. Note that the offline settings on the Domino Web Access - Offline 
tab are not supported for this Beta release. For information on these settings, see the topic "Creating 
mail policy settings for Domino Web Access users" in the Domino 8.5 Administrator Beta Help 
documentation referenced at the beginning of this release note. 

z	 For Domino Web Access features that send requests to external servers or Web services, such as 
Quickr integration, external calendar overlays, or Widgets,  administrators should use an HTTP-proxy 
servlet to intercept calls and retrieve information from a remote site. For information on how to 
configure an HTTP-proxy servlet, see the topic "Use an HTTP-proxy Servlet to restrict URLs to 
external servers" in these release notes. 

z	 Administrators can define a set of external widgets that can be integrated into the Domino Web 
Access mail client as services. These widgets display in the user's mail file in a Widgets folder, where 
users can click a widget to access it. For information, see the topic "Using widgets in Domino Web 
Access" in the Domino 8.5 Administrator Beta Help documentation referenced at the beginning of this 
release note. 

z	 The full mode of Domino Web Access is on a new tabbed framework for documents and views. This 
new framework has the look and feel of the lite mode that was introduced in 8.0.1. It provides more 
parity with the Notes client, and is more efficient. Although the conversion of the Full mode to the new 
framework is not complete, this Beta release supports the following new features: 

z	 Open a document in a new window - When you are reading a message, you can "tear off" the 
message into a new window by clicking an icon in the document action bar. 

z	 Switcher icons - Located at the top of the left navigation panel. Users simply click an icon to open 
an application. 

z	 Sidebar - This Notes-style sidebar displays a day-at-a-glance calendar and the Help. To open or 
close the sidebar, users click the sidebar icon. 

z	 Preview pane can be viewed on the side or on the bottom of the screen. 

z	 Day-at-a-glance - The day-at-a-glance calendar displays your calendar entries in the sidebar. 

z	 Loading status - When opening documents, tabs display a status icon indicating that a document 
is loading. 

z	 Calendar views - Views that include time slots have been updated with the new look. 

z	 External calendar overlays - Users can add an external calendar to their Domino Web Access 
calendar. 
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z	 Quickr integration - users can include Lotus Quickr links into e-mail messages. 

z	 Console logging --  If something goes wrong, an error message displays in the status bar notifying 
the user of a problem and presenting an easy way to view the console if desired. If another type 
of error occurs, users can press Ctrl and then click the Lotus Domino Web Access logo to open 
the support console. Information displayed in the support console can help developers investigate 
the problem. 

z	 The lite mode introduced in 8.0.1 includes the following new features: 

z	 Users can view their mail quota information. 

z	 From the Inbox or an open meeting invitation, users can accept with comments, or decline with 
comments. 

z	 Users can create meeting invitations. 
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Installation, migration, upgrade, and configuration 
information 

Hardware requirements 

Lotus Notes, Domino Designer, Domino Server, Domino for i, Domino for System z 

Notes and Domino 8.5 hardware requirements 
For a list of the Lotus Notes and Lotus Domino 8.5 hardware requirements for each supported platform, 
please see the release note titled "Notes and Domino 8.5 platforms and system requirements" in the 
'Software requirements' section of this chapter. 

Domino Server 

Domino and DB2 - server requirements 
The IBM Lotus Domino 8 Administrator documentation contains the topic "Supported platforms and 
hardware and software requirements." 

Information regarding which releases of IBM DB2 are supported should be replaced with this information: 

Server Domino/DB2 Supported DB2 Version: 
z	 DB2 Enterprise Server Ed 9.1 FP2 - Microsoft Windows 32-bit 
z	 DB2 Enterprise Server Ed 9.1 interim special build 2a  - IBM AIX and Linux (SLES10 & RHEL5) 

64-bit 
z	 DB2 Workgroup Server Ed 9.1 FP2 - Microsoft Windows 32 bit 
z	 DB2 Workgroup Server Ed 9.1 interim special build 2a  - IBM AIX and Linux (SLES10 & RHEL5) 

64-bit 

Information pertaining to supported configurations should be replaced with this information: 

Server Domino/DB2 Configurations: 
z	 Local configurations - DB2 and Domino installed on the same server 
z	 Remote configurations, same platform - DB2 and Domino reside on separate servers that are 

each running the same OS 
z	 Remote configurations, mixed platform - DB2 resides on an AIX or LINUX server, Domino resides 

on a Windows server 

Note:  Domino 64-bit is not a supported Domino and DB2 configuration. 
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Domino for i 

IBM i: Hardware requirements 
The following IBM iSeries, eServer, System i and IBM Power®(1)

 Systems models are supported to run IBM 
Lotus Domino. 

The following models are recommended: 
z	 iSeries 270, 810, 820, 825, 800-2464 and above 
z	 eServer i5 520-0901 and above 
z	 System i 9405-520 Express models and 9406-520 Value models WITH accelerator 

processor feature 
z	 System i 9407-515, 9406-520, 9406-525 and above 
z	 IBM Power™ 520 Express and above 

The following models are NOT supported:  
z	 iSeries 800-2463 
z	 eServer i5 520-0900 
z	 System i 9405-520 Express models and 9406-520 Value models WITHOUT accelerator 

processor feature 

Memory requirements 

z	 512 MB or more minimum 
z	 512 MB or more per Domino server 

Disk requirements 

z	 2GB of free space minimum. 
z	 4 or more drives recommended 

Use these values as general guidelines for minimum memory and disk space. The requirements for your 
environment may be different. For more information about sizing IBM Power Systems for Domino, use the 
IBM Systems Workload Estimator.  The Estimator is available at the following Web site: 

http://www-912.ibm.com/estimator 

Note: Although a Domino server can run on any POWER systems, the iSeries and System i server 
models are optimized for client/server applications such as Domino.  iSeries 270, 800-2464, 810-2465, 
and eServer i5 520-0901 and 520-0902 are recommended for Notes-based mail or light applications only.  
Partial processor models may not be suitable for compute-intensive applications;  IBM eServer i5 
520-0903 or higher are recommended for CPU-intensive workloads. 

See the System i Performance Capabilities Reference  for more details on specific models. 

http://publib.boulder.ibm.com/infocenter/systems/scope/i5os/topic/books/sc410607.pdf 

See also Upgrade Planning : i5/OS and OS/400 level mapping  for details about which releases of IBM i 
(i5/OS, OS/400) are supported by each of the System i RISC models. 

http://www-304.ibm.com/systems/support/i/planning/upgrade/osmapping.html 

Footnotes 
(1) 

The new IBM Power Systems unify IBM's integrated platform, IBM System i™, with its UNIX operating 
system platform, IBM System p™.  For more information see:  http://www.ibm.com/systems/power/ 
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Lotus Notes, Domino Server 

Tested Smartcard packages 
Smartcard functionality has only been tested under Win32-based operating systems. The following 
smartcard packages have been tested with this release of Notes/Domino, and indicated packages (*) 
have caveats listed below. Untested smartcards that include PKCS #11 libraries may work with this 
release of Notes/Domino. Entries left blank indicate functionality that has not been tested with this 
release. 

Smartcard Package Lock ID with 
password 

equivalent on 

Lock ID 
With Key 

on 

Removing 
token will 
generate 

Use 
pre-loaded 
keys and 

Sign with 
RSA keys on 

token 

Decrypt with 
RSA keys on 

the token 
token Smartcard 'F5'-style 

logout 
X.509 

certificates 
ActivClient 5.4 yes yes yes n/a yes yes 
ActivClient 5.4 with 
CAC tokens 

no (R/O 
token) 

yes yes yes yes yes 

Aladdin eToken RTE 
3.65 

yes yes yes n/a yes 

A-Trust a-sign Client 
v1.2.2.1 (*) 

yes yes (7.02+) yes yes yes (1536 
bits) 

n/a 

Belgian eID v2.5.9 
(*) 

no (R/O 
token) 

yes yes yes yes no 

Datakey CIP 4.07 (*) yes yes yes n/a yes 
Estonian eID (*) no (R/O 

token) 
no (*) no yes yes yes 

Eutron CryptoIdentity 
Cryptokit 3.7.1 

yes yes yes n/a yes yes 

GemSafe Libraries 
4.2.0 SP3 (*) 

yes no yes yes yes n/a 

IBM Embedded n/a n/a no no 
Security System 
with Client Security 
Software 
v6.01.0037.00 
Rainbow iKey 2032 
SDK v4.7.0 
Rainbow CryptoSwift yes yes n/a n/a yes yes 
eCommerce Server 
Accelerator PCI 
CS400 model 2.2.6a 
(*) 
Secude v5.6 (*) no yes yes yes yes yes 

Smartcard Package Caveats : 

z	 The technique introduced in 7.0 to "Lock ID With Key on Smartcard" will be used with all tokens 
that support C_Sign for CKM_RSA_PKCS with input lengths up to k-11 bytes, in accordance with 
the PKCS#11 specification.  New techniques for locking the ID file using a private RSA key on the 
smartcard were added in later releases for some tokens that do not support the full range of input 
lengths, and those tokens are marked with (version+) in the relevant columns of the above table.  
ID files locked with these new techniques can not be used by older versions of Notes/Domino; 
attempts to do so will result in an "Unsupported ID file version" error. 

z	 Aladdin eToken RTE 3.65 has been tested with this release using eToken PRO USB 64k tokens 
and eToken NG-FLASH USB tokens. 
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z	 The Belgian eID was tested with run-time version 2.5.9, and we highly recommend that 
customers upgrade to the most recent version of the Belgian eID Run-time software. Users will 
receive redundant PIN prompts from the PKCS#11 library as well as Notes due to the token 
failing to set the CKF_PROTECTED_AUTHENTICATION_PATH token flag, but setting 
"allow_sso = false" in the  Belgian eID configuration file beidbase.conf will eliminate the duplicate 
prompts. However, setting that variable and rebooting with the token in the reader may result in 
the PKCS#11 library hanging when first attempting to use the smartcard. This problem does not 
appear to occur when the ID file is locked with a key on the smartcard. 

z	 The DataKey CIP 4.07 software installs multiple PKCS#11 libraries. dkck201.dll uses PKCS#11 
v2.01 and has been tested successfully with Notes; dkck232.dll uses PKCS#11 v2.00 and does 
not work with Notes. 

z	 The Estonian eID was tested with the PKCS#11 library from id-card-installer-0.7.exe (2/14/2006)  
Using this version of the library, the pre-loaded certificates could be imported into the ID file and 
used for S/MIME signing and decryption, but smartcard login was nonfunctional. It is possible that 
a newer version of the smartcard drivers will fix the token limitation that prevented the "Lock ID 
With Key on Smartcard" action from succeeding. 

z	 The GemSafe Libraries 4.2 SP3 returns CKR_DEVICE_ERROR instead of 
CKR_TOKEN_NOT_PRESENT from C_GetTokenInfo when no token is in the reader. If Notes 
fails to automatically activate a workaround for this token bug, it may be necessary to manually 
set PKCS11_TOKEN_BUGS=128 in the notes.ini file.  Due to the occasional failure of this token 
to report slot events, it may also be necessary to hit F5 and log out of Notes in order to force a 
PIN prompt when using keys on a smartcard when the ID file is not secured with that same 
smartcard. 

z	 The Rainbow CryptoSwift eCommerce Server Accelerator fails to report that RSA cryptographic 
operations are performed in hardware.  If you are having difficulty performing cryptographic 
operations (including importing X.509 certificates or exporting RSA keys) with this device, setting 
PKCS11_NO_HWCHECK=1 or PKCS11_TOKEN_BUGS=2 in the NOTES.INI file will activate a 
workaround in Notes/Domino for this problem. 

z	 The Secude token cannot perform cryptographic operations with a number of smart card readers 
due to the high power demands of that token. Please confirm that your token readers are 
supported by Secude before deploying this package. If you are having difficulty signing S/MIME 
messages with a key on these smartcards and are using a supported token reader, setting 
PKCS11_TOKEN_BUGS=1 in the NOTES.INI file will activate a workaround in Notes that may fix 
this problem. and upgrading your Secude software may fix this problem. 

Caveats and Warnings : 

z	 An entry of "n/a" in the "Use pre-loaded keys and X.509 certificates" column does not necessarily 
indicate any incompatibility with the smartcard package, but simply means that we did not have a 
sample pre-loaded token to test against. 

z	 Current versions of the Entrust CA create non-compliant PKCS#11 attributes for certificates and 
keys. Support for these keys and certs is limited; see "Problems using Entrust certificates on 
smartcards" in these release notes for more details. 

z	 Read-only tokens, such as many national identity "eID" cards and Common Access Cards, can 
only be used to lock the ID file through the "Lock ID with Key on Smartcard" action, which was 
introduced in ND7. The "Enable Smartcard Login" action that was introduced in ND6 requires 
write access to the token. 
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z	 The "Lock ID with Key on Smartcard" action will search all slots for the key needed to unlock the 
Notes ID file.  Therefore, if a token is lost or locked out, a new token can be used with the old ID 
file, as long as the new token contains the exact same certificates and keys with the same key 
identifier (CKA_ID) attributes.    However, if an ID file is smartcard-enabled using the "Enable 
Smartcard Login" option, then ID File Recovery must be used if the token is lost or locked out in 
order to revert the ID to a conventional password. 

z	 The only way to revert a smartcard-protected ID file to a conventional password is through ID File 
Recovery.  ID File Recovery should be configured for an ID file before the ID file is 
smartcard-enabled. Recovering a  smartcard-protected ID file will revert the ID file to use a 
password and will restore any keys that were pushed onto the smartcard from the ID file, as long 
as the recovery information was not changed after the key was pushed down to the smartcard.  

z	 Password expiration should be disabled in a user's person record before they smartcard-enable 
their ID file. 

z	 Password checking will result in only a single smartcard being usable with a given ID file, even 
across multiple computers or platforms.  In this scenario, one copy of the ID file should be 
smartcard-enabled, and then that version of the ID file should be copied to all of the other 
respective computers.  That single smartcard will now be required for all of the copies of the ID 
file. 

z	 Server setup will not function with a smartcard-protected server ID.  In order to use a 
smartcard-protected ID with a server, finish server setup with a password-protected version of the 
ID file, then add the path to the PKCS #11 library in the server's NOTES.INI 
(PKCS11_Library=<path to library>), and finally smartcard-enable the server's ID file on a client 
or using the SECManipulateSC C-API function. 

z	 Single Logon, which synchronizes the Notes and Windows passwords, cannot be used with a 
smartcard-protected ID file. You must restart Notes after disabling Single Logon before 
smartcard-enabling an ID file. 

z	 Notes uses version 2.01 of the PKCS #11 API to communicate with smartcards and other 
PKCS#11 devices. PKCS #11 libraries that only implement version 2.0 will not result in an 
"F5"-style logout when the card is removed from the reader.  Updated libraries may be available 
from the smartcard vendors. 

Sample PKCS #11 Library Install Paths : 

z	 c:\WINNT\system32\acpkcs211.dll (ActivClient 5.4) 
z	 c:\WINNT\system32\eTpkcs11.dll (Aladdin eToken RTE 3.65) 
z	 c:\WINNT\system32\asignp11.dll (A-Trust v1.2.2.1) 
z	 c:\WINNT\system32\Belgium Identity Card PKCS11.dll (Belgian eID) 
z	 c:\WINNT\system32\dkck201.dll (Datakey CIP 4.07) 
z	 c:\WINNT\system32\opensc-pkcs11.dll (Estonian eID) 
z	 c:\WINNT\system32\sadaptor.dll (Eutron CryptoIdentity CryptoKit 3.7.1) 
z	 c:\Program Files\Gemplus\GemSafe Libraries Admin\BIN\gclib.dll (GemSafe Libraries 4.x) 
z	 c:\Program Files\IBM ThinkVantage\Client Security Solution\csspkcs11.dll (IBM Client Security 

Software v6.01) 
z	 c:\WINNT\system32\dkck201.dll (Rainbow iKey 2032) 
z	 c:\WINNT\system32\Cryptoki22.dll (Rainbow CryptoSwift eCommerce Sever Accelerator) 
z	 c:\Program Files\Common Files\SECUDE\itsecp11.dll (Secude v5.6) 
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Software requirements 

Lotus Notes, Domino Designer, Domino Server, Domino for i, Domino for System z 

Notes and Domino 8.5 platforms and system requirements 
The platforms and operating systems listed in the table below are applicable to the Lotus Notes 8.5 and 
Lotus Domino 8.5 release, and may not necessarily pertain to other Notes and Domino releases. 

For Domino Web Access system requirements, please refer to the release note titled "Domino Web 
Access system requirements". 

For web browsers supported, including Web Mail and the Domino Web Administrator, please refer to the 
release note titled "Web browsers supported". 

Operating system patches, service packs, and other updates are not specified in the tables that follow.  
Note that operating system vendors frequently release updates. For the most recent information 
regarding updates, see the Lotus Knowledge Base online at http://www-3.ibm.com/software/lotus/support/ 
or contact your local Lotus Support representative. 

Notes, Domino Administrator, Domino Designer clients 

Notes Client (Standard configuration ) 

Platform Microsoft Windows Linux
(1) 

Macintosh
(1) 

Supported operating 
system versions 

Microsoft Windows XP 
Professional, Service 
Pack 2 

SUSE Linux Enterprise 
Desktop (SLED) 10 
XGL 

Macintosh OS 10.5.x 

Microsoft Windows XP 
for Tablet PC 

Microsoft Windows 
Vista: Enterprise, 
Ultimate and Business 
Editions 

RedHat Enterprise 
Linux (RHEL) 5.2 
Desktop 
Note: AIGLX is not 
supported, and must 
be disabled 

Microsoft Windows 
Vista for Tablet PC 

Ubuntu 8.04 LTS 
Desktop Edition 

(See also the "Linux ­
required packages and 
updates" release note) 

Processors supported Intel Pentium or higher 
and compatibles, or 
equivalents 

Intel Pentium or higher 
and compatibles, or 
equivalents 

Intel only 

Windows XP - Pentium 
4, 1.2GHz or higher 
Windows Vista - 

Pentium 4, 1.2GHz or 
higher 

Pentium 4, 1.2GHz or 
higher 
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Notes Client (Standard configuration ) cont'd 

Platform Microsoft Windows Linux
(1) 

Macintosh
(1) 

RAM Windows XP - 512 MB 512 MB minimum; 1 512 MB minimum; 1 GB or 
(Additional memory 
requirements are subject 
to your operating system 
requirements) 

minimum; 1 GB or 
more strongly 
recommended 

Windows Vista - 1 GB 

GB or more strongly 
recommended 

more strongly 
recommended 

minimum; 1.5 GB or 
more strongly 
recommended 

Disk space 

(Minimum amounts are 

Install directory (C:\) -
900 MB or more 
recommended 

Install directory (/opt) 
- 1.5 GB minimum 

Install directory ( 
/Applications) - 1 GB 
or more recommended 

the disk space required 
for installing default files. 
More space is required if 
databases are replicated 
or copied locally) 

Video Hardware support for 
OpenGL 

128 MB video RAM 
(with XGL-compatible 
video driver from 

32 MB video RAM or more 
recommended 

hardware OEM for 
SLED 10) 

/etc/X11/xgl-hard
ware-list 

Monitors supported Color monitor required 

1024x768 screen 

Color monitor required 

1024x768 screen 

Color monitor required, 
256 colors or greater 

resolution minimum resolution minimum 1024x768 screen 
resolution minimum 

Protocols 
supported 

NetBIOS over NetBEUI No No No 

NetBIOS over IP
(2) Yes No No 

NetBIOS over IPX
(3) Yes No No 

SPX No No No 

SPX II No No No 

TCP/IP Yes, IPV4 and IPV6 Yes Yes 

X.PC Yes No Yes 
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Notes Client (Basic configuration ) 

Platform Microsoft Windows Macintosh
(1) 

Supported operating system 
versions 

Microsoft Windows XP Professional, 
Service Pack 2 

Macintosh OS 10.5.x 

Microsoft Windows XP for Tablet PC 

Microsoft Windows Vista: 
Enterprise, Ultimate and Business 
Editions 

Microsoft Windows Vista for Tablet 
PC 

Processors supported Intel Pentium or higher and 
compatibles, or equivalents 

Intel, PPC 

Windows XP - Pentium 4, 1.2GHz or 
higher 
Windows Vista - Pentium 4, 1.2GHz 
or higher 

RAM 
(Additional memory requirements are 
subject to your operating system 
requirements) 

Windows XP - 512 MB minimum; 1 
GB or more strongly recommended 

Windows Vista - 1 GB minimum; 1.5 
GB or more strongly recommended 

512 MB minimum; 1 GB or 
more strongly recommended 

Disk space Install directory (C:\) - 900 MB or Install directory ( 

(Minimum amounts are disk space 
more recommended /Applications) - 1 GB or 

more recommended 
required for installing default files. 
More space is required if databases 
are replicated or copied locally) 

Video Hardware support for OpenGL 32 MB video RAM or more 
recommended 

Monitors supported Color monitor required; 256 color or greater monitor 
1024x768 screen resolution required; 1024x768 screen 
minimum resolution minimum 

Protocols supported 

NetBIOS over NetBEUI No No 

NetBIOS over IP
(2) Yes No 

NetBIOS over IPX
(3) Yes No 

SPX, SPX II No No 

TCP/IP Yes, IPV4 and IPV6 Yes 

X.PC Yes Yes 

Citrix® support information

The Notes Client is supported on Citrix Presentation Server 4.5, on Windows 2003 server (32- and 64-bit), 

using Citrix ICA (Independent Computing Architecture) clients.
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Domino Administrator Client , Domino Designer 

Platform Microsoft Windows 

Supported operating system 
versions 

Microsoft Windows XP 
Professional, Service Pack 2 

Microsoft Windows Vista: 
Enterprise, Ultimate and 
Business Editions 

Processors supported Intel Pentium or higher and 
compatibles, or equivalents; 

1.5 GHz or higher 
recommended 

RAM Windows XP - 512 MB 
(Additional memory minimum; 1 GB or more 
requirements are subject to strongly recommended 
your operating system 
requirements) Windows Vista - 1 GB 

minimum; 1.5 GB or more 
strongly recommended 

Disk space Install directory (C:\) - 960 
MB minimum 

(The minimum amounts are the 
disk space required for installing 
default files. More disk space is 
required if databases are 
replicated locally or copied 
locally) 

Monitors supported Color monitor required 

Protocols 
supported 

NetBIOS over NetBEUI No 

NetBIOS over IP
(2) Yes 

NetBIOS over IPX
(3) Yes 

SPX No 

SPX II No 

TCP/IP Yes, IPV4 and IPV6 

X.PC Yes 

Footnotes 
1 

Available for the Notes client only, not for the Domino Administrator or Domino Designer clients. 
2 

Only Microsoft TCP/IP is supported. 
3 

Both Novell NetBIOS and Microsoft NetBIOS over IPX are supported. 
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Domino Server 

32-bit Domino Server
(1)

 - Table 1 

Platform Microsoft Windows Linux Sun Solaris 

Supported operating 
system versions 

Microsoft Windows 
2003 Server Standard 
Edition 

Novell SUSE Linux 
Enterprise Server 
(SLES) 10 x86 (32-bit) 

Sun Solaris 10
(4)

 (64-bit 
kernel), March 2006 patch 
cluster or higher 

Microsoft Windows Novell SUSE Linux 
2003 Server Enterprise Enterprise Server 
Edition, Sevice Pack 2 (SLES) 10 x86_64 

Microsoft Windows 
(64-bit) 

2003 Server x64 Red Hat Enterprise 
Edition Linux (RHEL) 5.0 and 

5.1 (32-bit) 
Note: XGL and 
SELinux must be 
disabled 

Red Hat Enterprise 
Linux (RHEL) 5.0 and 
5.1 (64-bit) 
Note: XGL and 
SELinux must be 
disabled 

(See also the "Linux ­
required packages and 
updates" release note) 

Processors supported Intel Pentium or higher 
and compatibles (32-bit 
and 64-bit chips as 

Intel Pentium or higher 
and compatibles (32-bit 
and 64-bit chips as 

UltraSPARC III and higher 

appropriate), or 
equivalents 

appropriate), or 
equivalents 

RAM 512 MB minimum 512 MB minimum; 512 MB minimum 
512 MB or more 512 MB or more 512 MB or more 
recommended per 
CPU 

recommended per 
CPU 

recommended per CPU 

Disk space 1.5 GB minimum per 1.5 GB minimum 1.5 GB minimum 
partition 1.5 GB or more 1.5 GB or more 

recommended recommended 

Disk swap space 2 times the physical 2 times the physical 3 times the physical RAM 
RAM installed RAM installed recommended 

recommended 

Monitors supported Color monitor required Any standard display Any standard display (local 
(local or remote) or remote) 
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32-bit Domino Server
(1)

 - Table 1 (cont'd) 

Platform Microsoft Windows Linux Sun Solaris 

Protocols 
supported 

NetBIOS over 
NETBEUI 

No No No 

NetBIOS over IP
(2) Yes; No (64-bit) No No 

NetBIOS over IPX Yes; No (64-bit) No No 

SPX
(3) No No No 

SPX II No No No 

TCP/IP Yes Yes Yes 

TCP/IP IPV6 Yes  Yes Yes 

X.PC Yes Yes Yes 
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32-bit Domino Server
(1)

 - Table 2 

Platform IBM AIX 

Supported operating system 
versions 

IBM AIX 5.3
(4)

 (64-bit kernel), 
ML05 or higher 
xlC.rte 8.0.0.5 or higher 

IBM AIX 6.1
(4)

 (64-bit kernel), 
Service Pack 1 
APAR IZ10223 
APAR IZ09961 
APAR IZ10284 
APAR IZ08022 

Processors supported PowerPC 

RAM 512 MB minimum; 
512 MB or more 
recommended per CPU 

Disk space 1.5 GB minimum 
1.5 GB or more 
recommended 

Disk swap space Same amount as physical 
memory required; 
recommend 2 times the 
physical RAM installed 

Monitors supported Any standard display (local or 
remote) 

Protocols supported 

NetBIOS No 

NetBIOS over IP
(2) No 

NetBIOS over IPX No 

SPX
(3) No 

SPX II No 

TCP/IP Yes 

TCP/IP IPV6 Yes 

X.PC Yes 
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64-bit Domino Server - Table 1
(5) 

Platform Windows IBM AIX 

Supported operating system 
versions 

Microsoft Windows 2003 Server 
x64 Edition, Service Pack 2 

64-bit IBM AIX 5.3, 
ML05 or higher 
xlC.rte 8.0.0.5 or higher 

64-bit IBM AIX 6.1, 
Service Pack 1 
APAR IZ10223 
APAR IZ09961 
APAR IZ10284 
APAR IZ08022 

Processors supported Intel EMT64 or higher and PowerPC 
compatibles, or equivalents 

RAM 512 MB minimum 512 MB minimum; 
512 MB or more recommended 512 MB or more recommended 
per CPU per CPU 

Disk space 1.5 GB minimum per partition 1.5 GB minimum 
1.5 GB or more recommended 

Disk swap space 2 times the physical RAM Same amount as physical 
installed memory required; recommend 2 

times the physical RAM installed 

Monitors supported Color monitor required Any standard display (local or 
remote) 

Protocols supported 

NetBIOS No No 

NetBIOS over IP
(2) No No 

NetBIOS over IPX No No 

SPX
(3) No No 

SPX II No No 

TCP/IP Yes Yes 

TCP/IP IPV6 Yes Yes 

X.PC No No 
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128-bit Domino Server - Table 1
(6) 

Platform IBM i 

Supported operating system versions IBM i 5.4 

IBM i 6.1 

(see the "IBM i: Software requirements " Release Note for additional 
information) 

Processors supported
(7) IBM iSeries model 270 or 8xx servers, eServer i5 model 

520 and above, System i 9405-520 Express models and 
9406-520 Value models with accelerator processor 
feature, System i 9407-515, 9406-520, 9406-525 and 
above, IBM Power™ 520 Express and above 

(see the "IBM i: Power Systems hardware requirements " Release 
Notes for additional information ) 

RAM 512 MB minimum; 512 MB or more per Domino server 

Disk space 2 GB minimum; 4 or more drives recommended 

Disk swap space N/A 

Monitors supported Any standard display (local or remote) 

Protocols supported 

NetBIOS No 

NetBIOS over IP
(2) No 

NetBIOS over IPX No 

SPX
(3)

, SPX II No 

TCP/IP, TCP/IP IPV6 Yes 

X.PC No 

Footnotes 
1 

If you are running with DB2 as the Domino datastore then you must add additional DB2 install requirements. DB2 9.1 
is supported in the current release.  NSFDB2 support is not available using Domino for System i. For additional install 
requirements, please see "Setting up and using Domino and DB2" in the Domino Administrator Help. 
2 

Only Microsoft TCP/IP is supported. 
3 

Domino clusters and partitioned server configurations do not support the IPX/SPX protocol. At this time, IBM does 
not plan to provide IPX/SPX network support for future releases of these features. 
4
 The 64-bit kernel must be installed and in use on these systems, even though the OS is 32-bit.  The use of the 32-bit 

kernel is no longer supported on these platforms.  Please see the OS vendor documentation for questions on 
enabling/using the 64-bit kernel.  (On Solaris, the 64-bit kernel is used by default on supported hardware; this is not 
the case for AIX). 
5
 See "Domino 64-bit: Known issues" in these release notes for more information. 

6
 The IBM i operating system only runs on 64-bit hardware and has been enabled for 64-bit for a long time.  It is a 

virtual machine architecture which supports both 128-bit and 64-bit pointers.  All software products that run on IBM i 
(i5/OS) have 64-bit addressing capabilities.  This includes Lotus Domino and all related software products, like Lotus 
Sametime, Lotus Quickr, Lotus Enterprise Integrator, etc. 
7
 For more details on specific models, see "System i Performance Capabilities Reference" at 

http://publib.boulder.ibm.com/infocenter/systems/scope/i5os/topic/books/sc410607.pdf. 
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Lotus Notes, Domino Server 

Linux - required packages and updates 
Notes client 
For Notes 8.0.x, it is recommended that the latest updates for SLED 10 are installed.  At a minimum, the 
latest versions of the following subsystems are required: 

metacity
compiz
xgl 

The following packages are required for client feature support on xSeries (32/64-bit OS) SLED 10: 

alsa-32bit-1.0.11-32.2 
atk-32bit-1.10.3-15.2 
audiofile-32bit-0.2.6-17.2 
cairo-32bit-1.0.2-27.4 
compat-libstdc++-5.0.7-22.2 
cups-libs-32bit-1.1.23-40.6
dbus-1-32bit-0.60-33.2 
dbus-1-glib-32bit-0.60-33.2
esound-32bit-0.2.36-19.4 
expat-32bit-2.0.0-13.2 
fontconfig-32bit-2.3.94-18.5 
freetype2-32bit-2.1.10-18.5 
gconf2-32bit-2.12.1-27.2 
glib-32bit-1.2.10-609.2
glib2-32bit-2.8.5-21.2
glibc-32bit-2.4-31.2 
glitz-32bit-0.4.4-21.2 
gnome-vfs2-32bit-2.12.2-58.10 
gtk-32bit-1.2.10-907.2
gtk2-32bit-2.8.10-39.12
hal-32bit-0.5.6-33.10 
libart_lgpl-32bit-2.3.17-17.2
libbonobo-32bit-2.10.1-24.4 
libgcc-4.1.0-28.4 
libgnome-32bit-2.12.0.1-26.6 
libgnomecanvas-32bit-2.12.0-19.2 
libgnomeprint-32bit-2.12.1-20.6 
libgnomeprintui-32bit-2.12.1-20.2 
libpng-32bit-1.2.8-19.2 
libstdc++-4.1.0-28.4 
libxml2-32bit-2.6.23-15.2 
mDNSResponder-lib-32bit-107.5-9.2 
openssl-32bit-0.9.8a-18.4 
orbit2-32bit-2.12.4-17.6 
pango-32bit-1.10.2-23.2 
popt-32bit-1.7-271.4
resmgr-32bit-0.9.8_SVNr75-18.4 
unixODBC-32bit-2.2.11-21.4 
xorg-x11-libs-32bit-6.9.0-50.14
zlib-32bit-1.2.3-15.2 
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The following packages are required for client feature support on xSeries (32/64-bit OS) RHEL 5 Desktop.  
Note: If there is no comparable patch available for RHEL, there is no need to apply one. 

alsa-lib-1.0.12-3.el5 
atk-1.12.2-1.fc6 
audiofile-0.2.6-5 
audit-libs-1.3.1-1.el5 
avahi-0.6.16-1.el5 
avahi-glib-0.6.16-1.el5
cairo-1.2.4-1.fc6 
compat-libstdc++-33-3.2.3-61 
cups-libs-1.2.4-11.5.el5
dbus-1.0.0-6.el5 
dbus-glib-0.70-5
e2fsprogs-libs-1.39-8.el5 
eel2-2.16.1-1.el5 
esound-0.2.36-3 
expat-1.95.8-8.2.1 
fontconfig-2.4.1-6.el5 
freetype-2.2.1-16.el5 
gail-1.9.2-1.fc6
gamin-0.1.7-8.el5 
GConf2-2.14.0-9.el5 
glib2-2.12.3-2.fc6
glibc-2.5-12 
gnome-desktop-2.16.0-1.fc6 
gnome-keyring-0.6.0-1.fc6 
gnome-menus-2.16.0-2.fc6 
gnome-vfs2-2.16.2-4.el5 
gnutls-1.4.1-2 
gtk2-2.10.4-16.el5
krb5-libs-1.5-17 
libart_lgpl-2.3.17-4
libbonobo-2.16.0-1.fc6 
libbonoboui-2.16.0-1.fc6 
libcap-1.10-26 
libgcc-4.1.1-52.el5 
libgcrypt-1.2.3-1 
libglade2-2.6.0-2 
libgnome-2.16.0-6.el5 
libgnomecanvas-2.14.0-4.1 
libgnomeprint22-2.12.1-9.el5 
libgnomeprintui22-2.12.1-6 
libgnomeui-2.16.0-5.el5 
libgpg-error-1.4-2 
libICE-1.0.1-2.1 
libjpeg-6b-37 
libpng-1.2.10-7 
libselinux-1.33.4-2.el5 
libsepol-1.15.2-1.el5 
libSM-1.0.1-3.1 
libstdc++-4.1.1-52.el5 
libX11-1.0.3-8.el5 
libXau-1.0.1-3.1 
libXcursor-1.1.7-1.1 
libXdmcp-1.0.1-2.1 
libXext-1.0.1-2.1 
libXfixes-4.0.1-2.1 
libXft-2.1.10-1.1 
libXi-1.0.1-3.1 
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libXinerama-1.0.1-2.1 
libxml2-2.6.26-2.1.2 
libXrandr-1.1.1-3.1 
libXrender-0.9.1-3.1 
libXt-1.0.2-3.1.fc6 
openssl-0.9.8b-8.3.el5 
ORBit2-2.14.3-4.el5 
pam-0.99.6.2-3.14.el5
pango-1.14.9-3.el5 
popt-1.10.2-37.el5
startup-notification-0.8-4.1 
zlib-1.2.3-3 

Domino server 
The following packages are required for server support on xSeries (32/64-bit) /System z (64-bit) SLES 10 
(equivalent required for RHEL 5 - which may mean additional RPMs including compatible RPMs)*: 

glibc-32bit-2.4-31.2 
libgcc-4.1.0-28.4 
libstdc++-4.1.0-28.4 

in addition, due to Java, the following packages are required for the server (some may not be needed on 
System z (64-bit))*: 

alsa-32bit-1.0.11-32.2 
atk-32bit-1.10.3-15.2 
cairo-32bit-1.0.2-27.4 
compat-libstdc++-5.0.7-22.2 
expat-32bit-2.0.0-13.2 
fontconfig-32bit-2.3.94-18.5 
freetype2-32bit-2.1.10-18.5 
glib-32bit-1.2.10-609.2
glib2-32bit-2.8.5-21.2
glibc-32bit-2.4-31.2 
glitz-32bit-0.4.4-21.2 
gtk-32bit-1.2.10-907.2
gtk2-32bit-2.8.10-39.12
libgcc-4.1.0-28.4 
libpng-32bit-1.2.8-19.2 
pango-32bit-1.10.2-23.2 
resmgr-32bit-0.9.8_SVNr75-18.4 
unixODBC-32bit-2.2.11-21.4 
xorg-x11-libs-32bit-6.9.0-50.14
zlib-32bit-1.2.3-15.2 

* These names are from the library dependency lists on a SLES 10 64bit xSeries system, which is why some of the 
RPMs say "32bit" in their name.  The names may change slightly if you are running any other version of Linux, but the 
"gist" remains the same: you need the given package (such as libstdc++) and the given level (4.1.0).  Sometimes a 
higher level is OK, but other times you need the given level or a compatible level (C++ is an example where you need 
the given level or compatible RPM, like compat-libstdc++-5). For example, on RHEL 5 you need 
compat-libstdc++-33 and compat-libstdc++-296 to get the correct C++ level of libraries for both Java and Domino.  If 
there is no comparable patch available for RHEL, for example, then you should be ok with not applying the 
patch/package. 
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Domino for i 

IBM i: Software requirements 
Required and optional software for IBM Lotus Domino 8.5 for i. 

Software i 5.4 i 6.1 
i Operating System 5722SS1 5761SS1 
Licensed Internal Code 5722999 5761999 

Required Individual PTFs 
(1) 5722SS1 SI24683 5761JV1 SI30218 

5722SS1 SI27294 
5722999  MF40520 

Host servers 5722SS1 Option 12 5761SS1 Option 12 

Qshell 5722SS1 Option 30 5761SS1 Option 30 
Portable App Solutions Environment 5722SS1 Option 33 5761SS1 Option 33 
TCP/IP Connectivity Utilities 5722TC1 5761TC1 

IBM HTTP Server 
(2) 5722DG1 Option *BASE 5761DG1 

IBM Developer Kit for Java 5722JV1 Option *BASE 5761JV1 Option *BASE 
J2SE 5.0 32 bit (J9) 

(3) 5722JV1 Option 8 5761JV1 Option 8  

IBM Developer Kit for Java 5722JV1 Option *BASE 5761JV1 Option *BASE 
i 5.4 - Java Developer Kit (J9) 5722JV1 Option 11 5761JV1 Option 11 
i 6.1 - Java SE 6 32 bit (J9)  

(4) 

i 5.4 - IBM iSeries Access Base 
(5) 

i 6.1 - IBM System i Access Family 
5722XW1 Option *BASE 
5722XW1 Option 1 

5761XW1 Option *BASE 
5761XW1 Option 1 

DOMINO SOFTWARE 
Lotus Domino 8.5 (5724E62) 5733L85 Option *BASE 5733L85 Option *BASE 
Lotus Domino 8.5: C API

 (6) 5733L85 Option 1 5733L85 Option 1 
Lotus Domino 8.5: Release 8.5.0 5733L85 Option 10 5733L85 Option 10 

Footnotes 
(1) 

See the Lotus Domino Required System Fixes Web page for the latest information at: 
http://www.ibm.com/systems/i/software/domino/support/ptf.html. Always have the latest PTF levels applied to your 
system. Refer to the Preventive Service Planning (PSP) Web site for the latest cumulative, group and individual PTFs 
available for the release: http://www-912.ibm.com/s_dir/sline003.nsf/sline003home 
(2) 

Required if you plan to use the IBM HTTP Server plug-in for Domino or any i Web services.  
(3) 

Default JVM required for Domino 8.5 Public Beta 1.  Optionally, specify JavaUseClassicJVM=1 in the notes.ini to 
override the default J9 JVM and use "classic"; Java Developer Kit 5.0 5722JV1 Option 7 must be installed or a JVM 
load failure will occur.  
(4) 

Default JVM required for Domino 8.5 Public Beta 2 and general availability.  Optionally, specify 
JavaUseClassicJVM=1 in the notes.ini to override the default J9 JVM and use "classic"; Java Developer Kit 5.0 
5722JV1 Option 7 must be installed or a JVM load failure will occur.  
(5) 

Install these options if you plan to manage your Domino environment using i Navigator, the graphical user interface 
for managing i. The latest service pack is available at: 
http://www.ibm.com/systems/i/software/access/windows/casp.html. 
(6) 

Install this option if you run any application that uses the C API interfaces.  The C API option is not multi-version 
capable.  

Use the Display Software resources (DSPSFWRSC) command to list the installed software.  The 
Resource ID or Licensed Program (LICPGM) value for Domino is "5733Lxx" where "xx" represents the 
Domino version and release level.  The value that follows the Description field (for example, 5724E62) is 
the IBM Lotus Passport Advantage product ID. While both values may be used to refer to the Lotus 
Domino product, the Resource ID (LICPGM value) is specific to IBM i and licensed program installation.   
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Additional Software requirements 

Using i Navigator Tasks on the Web 
Refer to the release note "IBM i: Using iSeries Navigator tasks on the Web " for additional software 
requirements and information on managing Domino servers from the Web. 

Using IBM HTTP Plug-in for Domino 
The following are the software requirements for the IBM HTTP Server plug-in for Domino: 

i 5.4 i 6.1 
IBM HTTP Server for i5/OS 5722DG1 5761DG1 
HTTP Group PTF SI99114 n/a -

Support is available in the base OS 
Individual PTFs SI19429 - Domino plug-in for HTTP 

server (powered by Apache).  Included 
in Group PTF 

n/a ­
Support is available in the base OS 

To check the HTTP Server PTF level, enter the command DSPPTF 5722DG1.  To check the HTTP Group 
PTF level, enter the command WRKPTFGRP and use option 5 (display) to see the group PTF contents.  
See also the following Web page: 

http://www.ibm.com/systems/i/software/domino/apachedom/ 

For more information about using the HTTP Server (powered by Apache) to forward HTTP traffic to 
Domino servers, refer to Chapter 16 Using IBM HTTP Server with Domino in the "Domino 8 for System i 
Help (Installing and Managing Guide)" at: 

http://www.ibm.com/developerworks/lotus/documentation/domino/#systemi 

Lotus Notes, Domino for i 

IBM i: Tivoli License Compliance Manager 2.2 
The IBM Tivoli License Compliance Manager, version 2.2 fixpack 2.2.0-TIV-TLCM-FP0001 and PTF 
22F0001 provides license management support for i 5.4. 

Complete details can be found at the following Web site: 

http://www-1.ibm.com/support/docview.wss?uid=swg24012719 

Domino for i 

IBM i: Features not available with Domino 8.5 
The following features are not available with Domino 8.5 for IBM i: 

z	 The XPages feature is disabled in Domino 8.5 public beta 1. 

z	 DB2 datastore and related Query View and Domino Access View capabilities 

z	 Integration with and forwarding events to the Tivoli Enterprise console 

z	 Activities server.  To use Activities with Notes 8, the Activities server must be deployed to a 
supported platform. Refer to the Lotus Connections documentation for more information on 
Activities server configuration options and and deployment.  

z	 The feature Fault Recovery restart in less than  30 seconds with Full NSD 
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z	 IPV6 support with i5/OS varies depending on the release, as indicated in the table below: 

Feature i 5.4 i 6.1 
Domino server 
configuration (*) 

IPV4 / IPV6 IPV4 & IPV6 

i Navigator and i 
Navigator Tasks on 
the Web 

IPV4 only IPV4 & IPV6 

HTTP (Apache) 
Plugin 

IPV4 only IPV4 & IPV6 

FTP IPV4 only IPV4 & IPV6 
Java console IPV4 only IPV4 & IPV6 

(*) You can configure a Domino server to communicate using IPV6 using the CFGDOMSVR CL 
command or configuration wizard (domwzd). 

z	 Domino for i does not support the batch installation feature using the LODRUN command with 
physical media.  The OS400/INTLENG/BATCH directory files were removed from the CD when 
the Domino product grew to require a second CD for installation. 

z	 iSeries Cluster Enabled Domino is not available.  For more information on System i High

Availability (HA); see http://www.ibm.com/eserver/iseries/ha/


z	 xSP hosting has been removed. If the CFGDOMSVR or CHGDOMSVR commands specify 
XSP(*YES), the setting is ignored. 

z	 SNMP Agent 

Domino Server 

Supported LDAP directory servers 
This release of Lotus Domino supports the use of the following LDAP directory servers: 

z	 IBM Tivoli Directory Server 6.1 

z	 Lotus Domino 7.0.x and 8.0.x 

z	 Microsoft Active Directory 2003 

z	 Sun Java System Directory Server 6.1, except on i5/OS 

Domino Server, Domino Web Access 

Domino Web Access system requirements 
Client Hardware Requirements 

z	 Recommended for better performance : 
z	 Windows -- Pentium IV  2.0 GHz with 512 MB of memory 
z	 Linux -- Pentium IV  2.0 GHz with 512 MB of memory 
z	 Macintosh -- Intel 2.0 GHz with 512 MB of memory 

z	 Minimum requirements : 
z	 Windows -- Pentium III 1 GHz with 256 MB of memory 
z	 Linux -- Pentium III 1 GHz with 256 MB of memory 
z	 Macintosh -- G4 1 GHz 256 MB of memory 
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Client Operating Systems and Supported Browsers 
Domino Web Access runs on the following client operating systems: 

Microsoft Windows XP Professional and Microsoft Windows Vista Enterprise Edition using the following 
browsers: 
z	 Internet Explorer 6 and 7 
z	 Mozilla Firefox 2.0.0.13 or later 

Novell SUSE Linux Enterprise Desktop (SLED) 10 using  the following browsers: 
z	 Mozilla Firefox  2.0.0.13 or later 

RedHat Enterprise Linux (RHEL) Desktop 5.2 using the following browsers: 
z	 Mozilla Firefox  2.0 or later 

Macintosh OS X 10.5 using the following browsers: 
z	 Mozilla Firefox  2.0.0.13 -- Note: Does not support Domino Off-Line Services (DOLS), local


archiving, and Lotus Sametime awareness


z	 Safari 3.1.x -- Note: Does not support Domino Off-Line Services (DOLS), local archiving, and 
Lotus Sametime awareness 

Apple iPhone and iPod Touch firmware version 1.1.4 (for the ultralite mode). 

Citrix Presentation Server 4.5 on Windows 2003 
z	 Clients using Citrix Presentation Server 4.5, on Windows 2003 server (32- and 64-bit), using Citrix 

ICA (Independent Computing Architecture).  Note: Does not support Domino Off-Line Services 
(DOLS). Must use the 32-bit browser on a 64-bit version. 

Browser Support notes 

z	 Attempting to access Domino Web Access through unsupported browsers results in the display 
of an unsupported browser notice. Netscape 4.x users may see hangs and/or crashes when 
encountering the Domino Web Access unsupported browser page. If you are a Netscape 4.x user 
and you encounter these problems, you should open your mail file using the WebMail UI directly 
through the &ui=webmail switch. This is documented in the topic "Switching to WebMail" in the 
Domino Web Access help. 

z	 Domino Web Access will not work if JavaScript is disabled or if session cookies are disabled. 

Server Requirements 
See "Notes and Domino 8.5 platforms and system requirements" in these Release Notes for a complete 
list of server operating systems and requirements. 

Certified Proxy Servers 
z	 SunOne Portal Server 6.2 
z	 IBM WebSphere Edge Server 2.0.2 efix 49 
z	 Tivoli Access Manager 6.0 

Adobe Acrobat 
Adobe Acrobat Reader, Version 4.0 or higher to print calendars. 
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Lotus Notes, Domino Server 

Web browsers supported 
The following are the Web browsers supported, by application: 

Application Browsers supported

Notes Client
1 

z 

z 

z 

z 

z 

z 

z 

Microsoft Internet Explorer 6 - Windows XP SP2 

Microsoft Internet Explorer 7, version 1.0 or better - Windows XP SP2 

Microsoft Internet Explorer 7, version 7.0.6000.16448 or better - Windows Vista 

Mozilla Firefox 3.0 - Windows XP Professional, Windows Vista 

Mozilla Firefox 3.0 - Red Hat Enterprise Linux (RHEL) 5 Desktop 

Mozilla Firefox 3.0 - SUSE Linux Enterprise Desktop (SLED) 10 

Safari 3.0 - Macintosh OS 10.x 

Web Mail and 
Web-enabled templates 

z 

z 

Microsoft Internet Explorer 6, 7 - Windows platforms only 

Mozilla Firefox 2.0 - All supported platforms 

Domino Web 
Administrator 

z 

z 

Microsoft Internet Explorer 6, 7 - Windows platforms only 

Mozilla Firefox 2.0 - All supported platforms 

Domino Web Access z 

z 

Microsoft Internet Explorer 6, 7 - Windows platforms only 

Mozilla Firefox 2.0 - All supported platforms 

Not applicable to Domino Designer. 

Lotus Notes, Domino Server, Domino for i, Domino for System z 

KeyView filter formats supported 
The 32-bit Domino 8.5 server and Notes 8.5 client are using version 9.2.0.12 of the KeyView filters.  The 
128-bit Domino 8.5 server (IBM i) uses version 9.2.0.12 of the KeyView filters.  64-bit Domino on Windows 
and 64-bit Domino on AIX are using version 10.2.0.2 of the KeyView filters.  The same file formats stated 
below are supported for filtering on the 64-bit Domino 8.5 server. 

Note: Indexing of .zip files are not supported by Notes and Domino. 

The following file formats are supported by Notes 8.5 and Domino 8.5 for filtering, as indicated in the table 
below: 

Word Processing Formats: 

Attachment Type Version 
ANSI (TXT) 
ASCII (TXT) 
HTML (HTM) 
IBM DCA/RFT  (Revisable Form Text ) SC23-0758-1 
DC 
Rich Text Format / Wordpad (RTF) 1 through 1.6 
Unicode (TXT) 3,4, .UNI and .TXT 
Adobe Maker Interchange Format 5, 5.5, 6, 7 
(MIF) 
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Word Processing Formats (cont'd): 
Attachment Type Version 

Applix Words (AW) 3.11, 4, 4.1, 4.2, 4.3, 4.4 
Display Write (IP) 4 
Folio Flat File (FFF) 3.1 
Fujitsu Oasys (OA2) 7 
JustSystems Ichitaro (JTD) 8 through 2005 
Lotus AMI Pro (SAM) 2, 3 
Lotus Word Pro 96, 97, Millennium Edition R9 

(Windows Only) 
Microsoft Word for PC (DOC) 4, 5, 5.5, 6 
Microsoft Word for Windows (DOC) 1 through 2002 
Microsoft Word for Macintosh (DOC) 4, 5, 6, 98 
Microsoft Works  (WPS) 1 through 2000 
Microsoft Windows Write (WRI) 1, 2, 3 
WordPerfect for Windows V5 (WO) 5, 5.1 
Word Perfect for Windows V6 or 6, 7, 8, 10, 2000 
Higher (WPD) 
Word Perfect for Macintosh 1.02, 2, 2.1, 2.2, 3, 3.1 
Word Perfect for Linux 6 
XyWrite (XY4) 4.12 

Spreadsheet Formats: 

Attachment Type Version 
Applix Spreadsheets 4.2, 4.3, 4.4 
Comma Separated Values (CSV) No specific version 
Corel Quattro Pro (QPW, WB3) 5, 6, 7, 8 
Lotus 123 for Smartsuite  (123) 96, 97, Millennium Edition R9 
Lotus 1-2-3 (WK4) 2, 3 , 4 , 5 
Lotus 1-2-3 Charts (123) 2, 3 , 4 , 5 
Microsoft Excel for Windows (XLS) 2.2 , 3 , 4 , 5 , 96, 97, 2000, 

2002 
Microsoft Excel for Macintosh (XLS) 98 
Microsoft Excel Charts (XLS) 2, 3 ,4, 5 , 6, 7 
Microsoft Works Spread Sheet (S30, 1, 2 , 3 , 4 
S40) 

Presentation Formats: 

Attachment type Version 
Applix Presents (AG) 4.0, 4.2, 4.3, 4.4 
Corel Presentations (SHW) 7, 9, 10, 11, 2000 
Lotus Freelance Graphics for 2, 96, 97, 98, Millenium Edition 
Windows (PRE) R9 
Lotus Freelance Graphics 2 (PRE) 2 
Microsoft Power Point for Windows 95, 97, 2000, 2002 
(PPT) 
Microsoft Power Point for PC (PPT) 4 
Microsoft Power Point for Macintosh 98 
(PPT) 
Microsoft Project (MPP)  (Extracts 98, 2000, 2002 
metadata only) 
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Display Formats: 

VersionAttachment type 
Adobe Portable Document Format 1.1 to 1.4 
(PDF) 

Graphics Formats (Filter SDK): 

Attachment type Version 
AutoCAD Drawing Format (DWG) R13, R14 and R2000 
(Standalone: Does not extract 
metadata) 
AutoCAD Drawing Format (DXF) R13, R14 and R2000 
(Standalone: Does not extract 
metadata) 
Computer Graphics Metafile (CGM) No specific version 
(Embedded) 
Enhanced Metafile (EMF) (Embedded No specific version 
and Standalone) 
Lotus Pic (Pic) (Standalone) No specific version 
Microsoft Visio (Extracts metadata 6 
only) 
Tagged Image File (TIFF) 5 
(Standalone: Extracts metadata only) 
Windows Meta File (WMF) 3 
(Embedded and Standalone) 

Multimedia Formats: 

Attachment type Version 
MPEG - 1 Audio Layer 3 (MP3) ID3 Versions 1 and 2 
(Extracts Meta Data : Summary 
Information Only) 

Container Formats: 

Attachment type Version 
Microsoft Outlook (MSG) 97, 2000, 2002 

Binary Formats:


Nothing Supported in the Filter SDK.
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Lotus Notes 

Lotus Sametime servers and available features 
You must have a Sametime server to use the Sametime features in IBM Lotus Notes 8.0.1.  Notes 8.0.1 
Sametime features are supported with the Sametime 8.0 server.  The following features are available: 

z Text chat 
z Rich Text Editor 
z Emoticons 
z Availability (on-line) status 
z File transfers 
z Screen captures 
z Voice chat 
z Video chat 
z Telephone conference calls (telephony) 
z Multiple communities 
z Gateway communities 
z Instant meetings 
z Geographic location awareness 
z Alert me whens 
z Privacy lists 
z Selective Do Not Disturb 
z Announcements 

All of the Sametime product documentation, including the IBM Lotus Sametime 8.0 Information Center, 
and the latest Readme file for Sametime 8.0.1, can be accessed from the IBM Lotus Sametime 
documentation page on Lotus developerWorks at: 

www.ibm.com/developerworks/lotus/documentation/sametime 

Installation notes 

Lotus Notes 

Uninstall before installing Notes 8.5 beta 
Before installing or upgrading to Notes 8.5 beta, you should first uninstall your existing Notes client. 

Lotus Notes 

Notes 8.5 Beta install on Linux 
Enhancements are being made to the Notes installer on Linux to support platform-specific improvements 
such as better shared storage and improved install kit mechanisms. The ISMP method of install will be 
replaced by either an RPM or DEB install kit. For the Notes 8.5 beta you can choose between one of the 
following three install kits: 

ISMP install kit (same as we've used in the past) for install on any supported Linux client platform -- The 
install kit name is Notes.ismp.linux.prod. 
RPM install kit for Notes install on the SuSE and Red Hat Linux platforms -- The install kit name is 
Notes.rpm.linux.prod. 
DEB install kit for Notes install on the Ubuntu Linux platform -- The install kit name is 
Notes.deb.linux.prod. 
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For details on supported Linux platforms for Notes 8.5 beta, see the "Notes and Domino 8.5 platforms and 
system requirements" release note. 

Notes 8.5 Public Beta provides one required component (notes) and four optional components (activities, 
cae, sametime, symphony). Optional components have a dependency on the required component. The 
required component must be installed before installing optional components, and optional components 
must be un-installed before the required component is able to be un-installed. Optional components are 
independent to each other. 

Known issues 

1. Upgrade or downgrade from a previous Notes version is not supported for this beta release. Only a 
clean install is supported.   
2. The dependencies check is not working when installing/removing deb packages on Ubuntu.  
3. Installing several RPM/DEB packages in one command may not work. 

- RPM package list
Notes RPM package


ibm_lotus_notes-8.5.i586.rpm

Activities RPM package


ibm_lotus_activities-8.5.i586.rpm

CAE RPM package


ibm_lotus_cae-8.5.i586.rpm

Sametime RPM package


ibm_lotus_sametime-8.5.i586.rpm

Symphony RPM package


ibm_lotus_symphony-8.5.i586.rpm


- RPM package install (must have root authority)

install Notes component

#rpm -ih ibm_lotus_notes-8.5.i586.rpm


install Activities component

#rpm -ih ibm_lotus_activities-8.5.i586.rpm


install CAE component

#rpm -ih ibm_lotus_cae-8.5.i586.rpm


install Sametime component

#rpm -ih ibm_lotus_sametime-8.5.i586.rpm


install Symphony component

#rpm -ih ibm_lotus_symphony-8.5.i586.rpm


- To check which Notes related RPMs have been installed: 

>rpm -qa | grep ibm_lotus 
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- RPM package uninstall (must have root authority) 

uninstall Activities component

#rpm -e ibm_lotus_activities


uninstall CAE component

#rpm -e ibm_lotus_cae


uninstall Sametime component

#rpm -e ibm_lotus_sametime


uninstall Symphony component

#rpm -e ibm_lotus_symphony


uninstall Notes component

#rpm -e ibm_lotus_notes


- Notes DEB File list
Notes DEB package 

ibm_lotus_notes-8.5.i586.deb 
Activities DEB package 

ibm_lotus_activities-8.5.i586.deb 
CAE DEB package 

ibm_lotus_cae-8.5.i586.deb 
Sametime DEB package 

ibm_lotus_sametime-8.5.i586.deb 
Symphony DEB package 

ibm_lotus_symphony-8.5.i586.deb 

- DEB package install

Install Notes component 
$sudo dpkg -i ibm_lotus_notes-8.5.i586.deb 

Install Activities component 
$sudo dpkg -i ibm_lotus_activities-8.5.i586.deb 

Install CAE component 
$sudo dpkg -i ibm_lotus_cae-8.5.i586.deb 

Install Sametime component 
$sudo dpkg -i ibm_lotus_sametime-8.5.i586.deb 

Install Symphony component 
$sudo dpkg -i ibm_lotus_symphony-8.5.i586.deb 
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- DEB package uninstall

uninstall activities component 
$sudo dpkg -P ibm_lotus_activities-8.5.i586.deb 

uninstall cae component 
$sudo dpkg -P ibm_lotus_cae-8.5.i586.deb 

uninstall sametime component 
$sudo dpkg -P ibm_lotus_sametime-8.5.i586.deb 

uninstall symphony component 
$sudo dpkg -P ibm_lotus_symphony-8.5.i586.deb 

uninstall notes component 
$sudo dpkg -P ibm_lotus_notes-8.5.i586.deb 

Domino for i 

Release Notes 

IBM i: System values required for install on Japanese systems 
IBM recommends setting the following system values before installing Lotus Domino on IBM i Japanese 
edition (Language Feature 2962). Specifically, please verify that the system value for QCCSID is 5035 
(the default system value for QCCSID is 65535).  

System Value Description Recommended Value 
QCCSID Coded character set identifier 5035 
QCHRID Graphic character set and code page 1172 1027 
QCNTRYID Country or region identifier JP 
QCURSYM Currency symbol Yen Mark 
QDATFMT Date format YMD 
QDATSEP Date separator 1 (/) 
QKBDTYPE Keyboard language character set JKB 
QLANGID Language identifier JPN 
QTIMSEP Time separator 1 (:) 

Domino for i 

IBM i: Domino installation and upgrade 
NOTE: Refer to Installing and Managing Domino  8 for System i  for complete details on preparing to 
install Domino and upgrade servers. 

About Beta Software 
Before installing Domino 8.5 Beta 1, remove any pre-beta software and configured servers; Domino 
upgrade is not supported with beta software. 

To remove the pre-beta or beta software, make sure that all Domino servers are ended and no users are 
running any Domino CL commands (i.e., WRKDOMSVR).  Delete any Domino servers configured with 
beta software using the command: 

CFGDOMSVR SERVER(<server-name>) OPTION(*REMOVE) 

Enter the following command to remove any pre-beta versions of Domino 8.5:   

DLTLICPGM LICPGM(5733L85) 
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Prepare to Upgrade from a Previous Release 
Domino 8.5 Public Beta 1 upgrade from the following releases is supported. Run the Display Software 
Resources (DSPSFWRSC) command to determine which version of Domino is currently installed.     

i 5.4: Domino 7.0, 8.0 and later MRs

i 6.1: Domino 7.0.3, 8.0.1 and later MRs


The product identifiers are: 

Domino 7 5733LD7

Domino 8 5733LD8


Back up the Domino data directories and all of the Domino libraries on the IBM i server.  For more 

information, see Chapter 10 "Managing Backup and Recovery" in Installing and Managing Domino 8 for 

System i (i400help.nsf and i400help.pdf). 


Stop all Domino servers; use the ENDDOMSVR command or i Navigator to end the servers.  After all

servers are ended, check that all Domino subsystems are also ended.


Obtain the Domino electronic image (Web kit)

Download the self-extracting zip file to your PC and extract the contents:  


READ1st.TXT Read First - Contains information on getting started and links to other sources of 
documentation. 
LICENSE.TXT Domino International Program License Agreement 
QNOTES SAVF - Lotus Domino 8.5 *BASE Option 
QNOTESAP SAVF - Lotus Domino 8.5 C API Option 1 
QNOTESRL SAVF - Lotus Domino 8.5 Server Option 10 
SETUP.EXE Installation Wizard 
VERSION.TXT Installation Wizard version file 
DOMWZD.EXE  Domino Configuration Setup Wizard 

Note 1: The C API is not multi-version capable.  If you install the C API option with another multi-version 
capable release of Domino, only the latest installation of the C API will be available. 

Follow the instructions below to install Domino using either the Installation Wizard or RSTLICPGM 
commands.  Be aware that additional time (up to 2 hours or more) is required for Domino program 
conversion in selected install and upgrade scenarios.  See the release notes for more information. 

Install Domino using the Installation Wizard 
From the directory where the Web kit files were extracted, run SETUP.EXE to launch the installation 
wizard. Follow the panels provided to install Domino. 
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Install Domino using RSTLICPGM 
Alternatively, you can install Domino using the RSTLICPGM command. Transfer each of the binary save 
files (QNOTES, QNOTESAP, QNOTESRL) from the PC to the IBM i server where Domino will be 
installed.  Use the RSTLICPGM commands to install each option.   

Create save files (SAVFs) on your IBM i server to contain the Domino product options: *BASE, option 1 
and option 10.  For example, create a library to contain the save files and then create save files for each 
option, as follows: 

> crtlib mylib

   > crtsavf mylib/qnotes

   > crtsavf mylib/qnotesap

   > crtsavf mylib/qnotesrl


Transfer the binary save files from the PC to the pre-created save files.  For example, issue these 
commands from a PC command prompt: 

cd xxxx {change to the directory that contains the
extracted save files
   ftp <system-name or IP@> {your i system name or IP address
   Name: {Enter your i user profile name and press enter
   Password: {Enter your i password and press enter

ftp>binary {Set transfer mode to binary
 Representation type is binary IMAGE.  


   ftp>put [drive letter]:qnotes mylib/qnotes  (replace

   ftp>put [drive letter]:qnotesap mylib/qnotesap (replace

   ftp>put [drive letter]:qnotesrl mylib/qnotesrl (replace


ftp>quit


The save files for the option(s) you plan to install should now be on your IBM i server.   Now use the 
RSTLICPGM CL command to install Domino.  Each option must be installed separately. 

NOTE:  Installing on a NON-English system 
If the primary language of your system is not English (2924), you should specify the LNG keyword on the 
RSTLICPGM command and change the value from the default value of *PRIMARY to 2924.  Otherwise, 
you will receive an error stating that LNG objects for the product were not found in the save file. 

Install Domino on i 6.1 
Program conversion is not required. Use the following commands to install each option.  

If the primary language of your system is English (2924): 

> rstlicpgm licpgm(5733L85) dev(*savf) option(*base) savf(mylib/qnotes)   

frcobjcvn(*NO)  

> rstlicpgm licpgm(5733L85) dev(*savf) option(1)     savf(mylib/qnotesap) 

frcobjcvn(*NO)    

> rstlicpgm licpgm(5733L85) dev(*savf) option(10)    savf(mylib/qnotesrl) 

frcobjcvn(*NO) 


If the primary language of your system is not English:  

> rstlicpgm licpgm(5733L85) dev(*savf) option(*base) lng(2924) 

savf(mylib/qnotes)  frcobjcvn(*NO)  

> rstlicpgm licpgm(5733L85) dev(*savf) option(1)     lng(2924)

savf(mylib/qnotesap) frcobjcvn(*NO)   

> rstlicpgm licpgm(5733L85) dev(*savf) option(10)    lng(2924) 

savf(mylib/qnotesrl) frcobjcvn(*NO) 
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Install Domino on i 5.4 
Plan for additional time during the install of option(10) which requires mandatory program conversion 
regardless of the value of the FRCOBJCVN keyword or the QFRCCVNRST system value.  

If the primary language of your system is English (2924): 

> rstlicpgm licpgm(5733L85) dev(*savf) option(*base) savf(mylib/qnotes) 
> rstlicpgm licpgm(5733L85) dev(*savf) option(1) savf(mylib/qnotesap)    

> rstlicpgm licpgm(5733L85) dev(*savf) option(10)    savf(mylib/qnotesrl) 

If the primary language of your system is not English:  

> rstlicpgm licpgm(5733L85) dev(*savf) option(*base) lng(2924) 

savf(mylib/qnotes) 

> rstlicpgm licpgm(5733L85) dev(*savf) option(1)     lng(2924)

savf(mylib/qnotesap)    

> rstlicpgm licpgm(5733L85) dev(*savf) option(10)    lng(2924) 

savf(mylib/qnotesrl) 


The installed version, release, modification (VRM) values of Domino 8.5 is V8R5M0.  Use the 
DSPSFWRSC command to display the installed software. 

Upgrade existing Domino servers 
Use the Update Domino Server (UPDDOMSVR) command to update existing multi-version capable 
Domino servers to latest release level.       

- Determine the release of Domino servers configured on your IBM i server. Use Work Domino 
Server (WRKDOMSVR) command to see all Domino servers. Then press F11=Display library to 
display the library and release of the servers. 

- Upgrade multi-version capable servers (e.g., 7.0.3, 8.0.1) to Domino 8.5 using the Update Domino 
Server command, as follows: 

  UPDDOMSVR SERVER(server-name)  TORLS('8.5.0') 

or 


  UPDDOMSVR SERVER(server-name)  TORLS(*LATEST)  


Configure a new Domino server 
As an alternative to upgrading an existing server to Domino 8.5,  you can configure a new server using 
the CFGDOMSVR CL command or the Domino Configuration Setup Wizard. 

Start the new or upgraded server 
You can now start the Domino server using the STRDOMSVR command or System i Navigator. 
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Domino Server, Domino for i 

IBM i: EZ Setup option not available with i  6.1 
With i 6.1, the option to "Install and Configure Domino" from System i Navigator (also referred to as EZ 
Setup) is no longer available.  The option remains visible on the i Navigator interface, but no actions are 
taken if selected.  It will be removed fully in the next release of the operating system.  

Use the alternative interfaces to install and configure Domino on i 6.1: 

Installation 
setup.exe the ISMP-based installation wizard 
LODRUN using physical CDs 
RSTLICPGM using save files 

Configuration 
domwzd Configuration setup wizard 
CFGDOMSVR CL command 

Note: You can launch the Configuration setup wizard from i Navigator as follows: 

1. Open System i Navigator. 

2. Select the system where Domino is installed. 

3. Expand "Network -> Servers" 

4. Select 'Domino' 

5. Right-click on "Domino -> New -> New Domino Server" 

Domino for i 

IBM i: Getting started 
Documentation Changes 
The latest information about Lotus Domino 8.5 for i is available in these release notes.  For general 
information about Notes and Domino Release 8.5, refer to the IBM Lotus Domino Administrator Help  at: 
http://infocenters.lotus.com/help7/index.jsp 

The Installing and Managing Domino  8 for System i guide, also referred to as Domino 8 for System i 
HELP, is not updated with this release but it continues to be available in the Domino 8.5 installed product 
directory (/qibm/proddata/lotus/domino850/data/help) and online: 

http://www.ibm.com/developerworks/lotus/documentation/domino/#systemi

http://publib-b.boulder.ibm.com/lotus/c2359770.nsf


Continue to refer to the Installing and Managing Domino  8 for System i guide for general information 
about product installation and removal, server configuration, multi-version support, and integration with 
IBM i. 

Preparing to Install or Upgrade 
Refer to the following release notes which provide information on preparing to install or upgrade to 
Domino 8.5. Read carefully the information on Program Conversion and plan for additional time during 
installation or selected operating system upgrade scenarios. 

z IBM i: Checklist for upgrading 
z IBM i: Program conversion 
z IBM i: Domino installation and upgrade 
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System Requirements 
Lotus Domino 8.5 is supported on IBM i 5.4 and i 6.1.  Refer to the following release notes for information 
on software and hardware requirements. 

z IBM i: Hardware requirements 
z IBM i: Software requirements 

References 

The Lotus Domino for i (i5/OS) Web site    
http://www.ibm.com/systems/i/software/domino/index.html 

Support information specific to Domino for i (i5/OS), including availability of Domino updates PTFs 
required for Domino: 

http://www.ibm.com/systems/i/software/domino/support/ 

General Domino for i (i5/OS) and IBM i product information: 
http://www.ibm.com/systems/i/software/domino/products.html 

Installing and Managing Domino 8 (HELP) 
http://www.ibm.com/developerworks/lotus/documentation/domino/#systemi 
http://publib-b.boulder.ibm.com/lotus/c2359770.nsf 

Lotus support for Domino and Notes: 
http://www.support.lotus.com 

IBM System i partner and education information: 
http://www.ibm.com/developerworks/eserver/systemi.html 

IBM "Redbooks," including IBM i (i5/OS) and Domino information: 
http://www.redbooks.ibm.com 

IBM System i and i5/OS Information Center has details about installing, setting up, and using TCP/IP. It 
also provides an overview of using IBM iSeries Access and iSeries Navigator.  

http://publib.boulder.ibm.com/iseries/ 
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Domino for i 

IBM i: Program conversion 
Read the following information carefully and plan for additional time required to convert Domino programs 
during the installation or upgrade process. 

i 5.4 
Plan additional time for installation of Domino 8.5 on i 5.4.  Installing Domino 8.5 on i 5.4 requires 
mandatory PROGRAM CONVERSION during product installation. The time required for program 
conversion, in addition to the product installation , can be from 10 minutes or up to 2 hours or longer 
depending on the system's performance characteristics and concurrent system activity.  

As with prior versions of Domino that install on i 6.1 (for example Domino 7.0.3 and Domino 8.0.1) there 
are no options to defer program conversion until after install. 

Tip: If you are planning to deploy Domino 8.5 on multiple i 5.4 servers, you can use the following 
method to reduce the installation time on subsequent i server installations: 

z Install Domino 8.5 on the first i 5.4 server.  Program conversion will occur during install. 
z Save the converted Domino 8.5 product. 
z Install the Domino 8.5 product that was saved from the first i 5.4 server on the remaining i 5.4 

servers.  Program conversion is not required on the subsequent installations. Use the 
FRCOBJCVN(*NO) keyword value on the RSTLICPGM command to ensure that program 
conversion does not occur unnecessarily.  Avoid using FRCOBJCVN(*YES *ALL) as it will 
cause program conversion to occur unnecessarily. 

i 6.1 
Installing Domino 8.5 on i 6.1 does not require program conversion.  If you are using the RSTLICPGM 
command to install, specify FRCOBJCVN(*NO).  Avoid using FRCOBJCVN(*YES *ALL) as this will cause 
program conversion to occur unnecessarily. 

Program conversion of Domino 8.5 on i 6.1 will occur in the following cases: 

z	 When upgrading from i 5.4 with Domino 8.5 already installed to i 6.1, or if installing Domino 8.5 
after saving it from i 5.4, program conversion is required again and will occur upon "first-touch" of 
the Domino product (i.e. STRDOMSVR, CFGDOMSVR, et.al.).  

 You can also force program conversion to occur following the upgrade or install, avoiding the 
"first-touch" conversion, using the following command: 

STROBJCVN LIB(QDOMINO850) 

z	 If you install Domino 8.5 on i 6.1 using the RSTLICPGM commands and specify 
FRCOBJCVN(*YES *ALL), this will cause program conversion to occur unnecessarily.  Specify 
FRCOBJCVN(*NO) when installing Domino 8.5 on i 6.1 using the RSTLICPGM command, or use 
the Installation GUI (setup.exe).    

Related Information 

· i5/OS V6R1: Installing Lotus Domino and related products (technote #1295455) 

· i5/OS V6R1 upgrade roadmap for Lotus Domino and related products (technote #1294587) 

· Support for Lotus Domino and related products on i5/OS V6R1 (Web page) 
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Upgrade notes 

Lotus Notes 

Uninstall Notes before upgrading to  8.5 beta 
Before installing or upgrading to Notes 8.5 beta, you should first uninstall your existing Notes client. 

Domino Server, Domino for i 

IBM i: Autonomy Keyview filter version 
Domino 8.5 for IBM i remains at version 9.2.0.12 of Autonomy's Keyview filter.  The viewer is not 
supported. 

These file types are not supported for System i: 

z Lotus Word Pro (LWP) 

Domino for i 

IBM i: Checklist for upgrading 
Refer to the following table for detailed steps to follow to ensure that your IBM i operating system and 
Lotus Domino server environment are ready to upgrade to Domino version 8.5. 

To-Do Task Description 
Determine if your system will support running 
Domino 8.5. 

See the release note: 
IBM i: Hardware requirements. 

Determine if a compatible OS level is being 
used, including all of the required licensed 
programs, options, cumulative PTF packages 
and group PTFs. 

Domino 8.5 is supported on i 5.4 and i 6.1.  See the 
Release note: 

IBM i: Software requirements 

Verify compatibility with other Lotus software 
products. 

Refer to the Lotus Software for IBM i operating system 
Compatibility Guide:  
http://www.ibm.com/systems/i/software/domino/pdf/relea 
sesupport.pdf 

Verify compatibility with any third-party add-on 
products. 

If you are running third-party applications such as 
anti-virus, spam blockers, administration tools, etc., 
verify Domino version 8.5 compatibility with your vendor.  

Plan for additional time required to install 
Domino 8.5 on i 5.4 and in select upgrade 
scenarios to allow for mandatory program 
conversion.  

See the release notes: 
IBM i: Getting started 
IBM i: Program conversion 

Plan for the new Lotus Notes client. There are two client configurations available: basic and 
standard.  For more information, refer to the Lotus Notes 
8.5 Help documentation.  
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To-Do Task Description 
Set a default size for the console log. When you upgrade to Domino 8 or later release, the 

console log maximum size is automatically set to 1 KB, if 
you have not already explicitly set a maximum size in 
your notes. ini file.  It is recommended that you set a 
maximum size prior to the upgrade so you do not lose 
valuable debugging information.  A value between 100 -
1000 KB is good for most customers. 

You can set the maximum size using the 
console_log_max_kbytes=<kbytes> parameter.  A value 
of 0 means no maximum. 

If you do not want console logging enabled, you can 
disable it with the setting console_log_enabled=0. 

Plan for the new ODS level. Domino version 8.5 public beta 1 introduces new ODS 
level 50.  Domino databases are not upgraded to the 
new ODS level by default, and no conversion is required 
as part of the upgrade. For details on 
Create_R8_Databases=1 and how to upgrade your 
databases to the new ODS, refer to the Domino 
Administration HELP:   

http://infocenters.lotus.com/help7/index.jsp. 

See also the release note IBM i: RUNDOMCMD CALL 
PGM(COMPACT) must run in *BATCH 
for changes regarding running COMPACT in release 
8.5. 

Plan to upgrade the design of the Domino 
Directory (names.nsf) and allow time to rebuild 
views in names.nsf. 

If you are upgrading the first server in the domain, you 
also need to upgrade the design of the Domino directory 
(names.nsf). 

To do so, start the Domino server and answer "Yes" in 
the Domino console (WRKDOMCSL <server_name>). 

Plan for any additional upgrade tasks if you are 
upgrading from an n-2 release. 

For example, if you are upgrading from Domino 7.0.x to 
Domino 8.5, read the documentation and upgrade 
recommendations for Domino 8 as well as the Domino 
8.5 information. 

Become familiar with the new features in Lotus 
Notes and Domino version 8.5 

See the release notes: 

New features in IBM Lotus Domino 8.5 
New features in IBM Lotus Notes 8.5 
New features in IBM Lotus Domino Designer 8.5 
New features in IBM Lotus Domino Web Access 8.5 

See also the Domino Blog. 
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Domino Server, Domino for i 

IBM i: Enable C/C++ Applications for 64-bit support

ENABLE Applications for  64-bit support on IBM i

A future release of Domino for i is being evaluated to provide 64-bit pointer and teraspace support.  This 

release note describes what you need to do to enable your Domino C and C++ applications to run with

Domino 64-bit and teraspace support on IBM i.


C and C++ Application Requirements 
Any applications that use the Domino C or C++ API on i need to be reviewed to make sure they are 
properly enabled for use with Domino for i.  If your application is not properly enabled, it may not be 
supported in a multi-version environment and may encounter run-time problems when Domino is changed 
to use 64-bit pointers.  There are two important considerations: 

z	 Bind to QNOTES/LIBNOTES 
Some applications incorrectly specify a library of *LIBL when binding to the LIBNOTES service 
program.  This can result in incorrect operation in a multi-versioned Domino environment.  
Applications must specify library QNOTES when binding to the LIBNOTES service program in order 
to function correctly in a multi-versioned environment.  

z	 Enable for Teraspace 
A future version of Domino for i may use the i 64-bit pointer and teraspace support.  To ensure proper 
operation of customer applications with a future version of Domino for i, applications using the 
Domino C or C++ API must be teraspace-enabled.  This can be accomplished by recompiling the 
application with the teraspace compiler option specified.  This is expected to provide significant 
improvement in Domino performance when 64-bit support is introduced. 

For more details, see the following documents: 

Considerations when developing Domino C and C ++ API applications for i 5/OS: 

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21238494

 Domino 7 for i5/OS Application Development Guide  (Chapter 2 - Application Development

Considerations)


http://www.lotus.com/ldd/doc/uafiles.nsf/docs/i5osdom7/$File/apdev400.pdf 

For information on Domino 64-bit plans, see this document: 

http://www-1.ibm.com/support/docview.wss?rs=463&context=SSKTMJ&dc=DB520&uid=swg21233872&l 
oc=en_US&cs=UTF-8&lang=en&rss=ct463lotus 
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Domino for i 

IBM i: RUNDOMCMD CALL PGM(COMPACT) must run in *BATCH

Starting with Domino 8.5, the COMPACT program is multi-threaded and must be run in *BATCH mode.  

Specify BATCH(*YES) ALWMLTTHD(*YES) on the RUNDOMCMD. 


Running the COMPACT program can be used to upgrade databases to a new ODS level.  For example, 

the following procedure can be used to upgrade a Domino 8.5 server's databases to ODS level 50.  


1. Update notes.ini to contain: Create_R85_Databases=1 

2. Run the following command with the server *ENDED to convert all existing 
server NSFs to ODS 50: 

RUNDOMCMD SERVER(<server-name>) 
CMD(CALL PGM(QDOMINO850/COMPACT) PARM('-C')) 
BATCH(*YES) ALWMLTTHD(*YES) 

Refer to the topic Including a database in attachment consolidation  in the IBM Lotus Domino 
Administrator Help for more information about ODS level 50:  http://infocenters.lotus.com/help7/index.jsp 

Domino Web Access, Domino for i 

IBM i: Sametime customization saved on upgrade 
The Domino server's data directory <data dir>/domino/html/sametime/stlinks was added in 
releases 6.0.5/6.5.4, and also exists in Domino 7.x and later releases, but did not exist in 6.5.3 and prior 
releases. This directory contains files that enable Sametime integration with iNotes (Domino Web 
Access) and files in this directory may be customized to support tunneling.    

When a Domino server is upgraded, any files in the existing <data 
dir>/domino/html/sametime/stlinks directory are copied to a backup directory called <data 
dir>/domino/html/sametime/stlinks/stlinks.sav in order to save any potential customized 
settings. The server upgrade process occurs: 

z	 during install for servers that are not multi-version capable (Domino 6.0.2 and earlier)  
z	 after install when the UPDDOMSVR command is run for a multi-version capable server (Domino 

6.0.3/6.5.0 and later) 

Files will only be copied to the stlinks.sav subdirectory during upgrade if the stlinks.sav directory is 
empty or does not exist (that is, if an install/upgrade occurs more than once for the same server, the copy 
of the files to stlinks.sav will only occur during the first install/upgrade).   

If you make additional customizations to the files in stlinks, be sure to either copy the new 
customizations to stlinks.sav or remove all files from stlinks.sav so that a subsequent 
install/upgrade will copy the latest files to the backup directory. 

52 



IBM Lotus Notes, Domino, Domino Designer 8.5 Beta 1 Release Notes 

Lotus Notes 

Mail Letterheads and upgrading from previous releases of Notes 
In Lotus Notes 8.x, there are a number of new and redesigned letterheads. There are a few caveats 
pertaining to letterheads: 

1. Your old letterhead graphic is still part of the template; it will still display in the redesigned forms.  The 
old letterhead design is wider than the new designs, however, and the picture may appear truncated in 
the Memo header. The only workaround at this time is to choose a different letterhead via Preferences. 

2. If you save Preferences for any reason, and had previously chosen a letterhead that is not included on 
the redesigned list, the letterhead image that displays in the Memo form will change to the "Envelope" 
image. 

3. If you choose to use one of the new letterheads, if the recipient of your e-mail is still using a mail 
template from a previous release, the letterhead area will appear blank. 

Domino Server 

Notes 8.0.1 to Notes 8.5 on Solaris requires clean installation 
When upgrading from Notes 8.0.1 to Notes 8.5 on Solaris, you cannot set up the server, since the symbol 
link is incorrect.  Instead, install Notes 8.5 cleanly. 

Domino Server 

Windows 2003 64-bit: Domino service will not install on upgrade 
On Windows 2003 64-bit, if upgrading from earlier Domino 8.5 beta builds to the current Domino 8.5 Beta 
1 build, the "Lotus Domino Server" Service will not be installed, and will remove any previous installation 
of the "Lotus Domino Server" Service from the 'Windows Services (Local)' list. 

Workaround 
Run the following command from a command prompt to install the "Lotus Domino Server" Service: 

C:\Program Files\IBM\Lotus\Domino\ntsvinst -c -t"Lotus Domino Server

(CProgramFilesIBMLotusDominodata)" -i"C:\Program

Files\IBM\Lotus\Domino\notes.ini"


Configuration notes 

Domino Web Access 

Configuring Domino Web Access 
To view the newest Domino Web Access features, you must have a Domino 8.5 server installed.  In 
addition, users must be registered using the Domino Web Access mail system, and the Mail (8.5) mail 
template. 
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Domino Server 

DCT - Java memory requirements 
The Domino Configuration Tuner (DCT) performs best with additional JVM memory; the default JVM 
memory for Notes is 64 MB. Before using the DCT, add the following setting to the Notes Client 
NOTES.INI file: 

JavaMaxHeapSize=268435456 

This entry should be the very first entry for DCT in the NOTES.INI file. 

Domino for i 

IBM i: Choose the format of HTTP log files 
HTTP log files are written in EBCDIC format by default on the IBM i platform.  You can change the format 
of these files to ASCII by setting the following in the NOTES.INI file.  The setting will take effect the next 
time the server starts or when HTTP starts again (for example, "tell http quit" then "load http").  

HTTPLogFormatAscii=1


If HTTPLogFormatAscii is not present in the NOTES.INI file or if the setting is HTTPLogFormatAscii=0, 
then the HTTP log files will revert to their default EBCDIC format. 

Domino for i 

IBM i: JVM property settings on a per Domino server basis 
A property in the NOTES.INI file can be used to specify JVM Properties for the Domino server. This 
property, JavaUserOptionsFile, specifies a text file which contains the properties to add to the JVM. This 
text file can be either ASCII or EBCDIC and have up to 256 properties specified.  Each entry must be in 
the form of "property=value" and be on a separate line. 

Any property that can be set with the -D Java option is valid. Domino already provides a way of adjusting 
the stack sizes, etc. 

If Domino specifies a property, and that property is also specified in the JavaUserOptionsFile, the 
JavaUserOptionsFile value is used. For example, if Domino specifies the property "Foo=1", and the 
JavaUserOptionsFile specifies "Foo=2", the JVM is created with "Foo=2". 

Note There are currently 2 exceptions to this: java.class.path and java.library.path. Domino will link the 
values specified in the JavaUserOptionsFile to what Domino is already setting for these two properties. 

Multiple Domino servers can share the same options file. 

One use of this feature is easier enablement of Java applications that have native methods. In order for 
the System.load() or System.loadLibrary() to find the service program, that service program must be in the 
current path. In this case, the administrator would have to know what directories the Domino for iSeries 
code uses.  With this change, the administrator can set the JavaUserOptionsFile in the NOTES.INI and in 
the referenced file specify "java.library.path=/QSYS.LIB/PGMAPP.LIB" where PGMAPP.LIB is the library 
containing the service program loaded by the java application. 
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For example: 

In the server's NOTES.INI the following line is added: 

JavaUserOptionsFile=/PGMApp/JvmOptions.properties


The file "/PGMApp/JvmOptions.properties" could have the following: 

java.library.path=/QSYS.LIB/PGMAPP.LIB 


java.class.path=/PGMApp/bin/PGMApp.jar 


PGMApp.debug=0 


PGMApp.serverName=Server1


Lotus Notes 

Macintosh: LotusScriptExtensions file on Mac OS X 
In the Notes client running on Macintosh OS X, the LotusScript Extensions file is located in 
~/Library/Preferences/Lotus/LotusScriptExtensions\2.0. This file is still a resource file, 
and requires either ResEdit (using Mac Classic mode or OS9) or Rez/DeRez (in the OS X Developer 
Tools) to modify.  On Windows platforms, this information is kept in the registry; on UNIX platforms, this 
file is a text file called "lotus.ini". 

Domino Server 

Notes.ini setting to control the Expires header for Dojo files 
New in the Domino 8.5 release is the Dojo JavaScript library, which is installed in a version specific 
subdirectory under the domino\data\domino\js directory. By default the web server maps the " 
/domjs" URL to the domino\data\domino\js directory. Since the files in this tree are static, the web 
server by default will add an 'Expires' header to each response for a file under "/domjs", which instructs 
the browser to cache the file for the next 364 days.  The interval can be controlled by a Notes.ini setting: 
HTTPDaysUntilJSLibExpires=n 

When 'n' is any positive value it will be used as the value in days which is set in the 'Expires' header.  A 
value of 0 will cause the web server to not add the 'Expires' header to the response. 

Domino Designer, Domino Web Access 

Rich text and attachment XPage controls  (web)

Notes has 2 types of storage for rich text fields: Native Notes editor format, and MIME (triggered when the 

field's storage is set to "Store contents as HTML and MIME").


Rich text that is stored in Native Notes editor format must be converted to HTML before it sent to a

browser.  The conversion from Native Notes format to HTML is not yet complete, causing the loss of some 

formatting information.


Saving a form or xPage with a browser will always cause rich text data to be sent back to the web server

as HTML, where it is converted to MIME.  The conversion from HTML to MIME is not yet complete, 

causing embedded objects to be dropped.


The attachment control can operate on a Rich Text item whose data is stored in Native Notes editor

format, and will not operate on MIME Rich text.
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Lotus Notes 

Sametime Awareness not showing in some Notes views 
On some Notes Standard configuration clients, Notes is not displaying Sametime awareness in views.  In 
order for all Notes views to display Sametime Awareness while using embedded Sametime in the Notes 
Standard client, the following variables may need to be added to your NOTES.INI file 

IMSHOW_STATUS=1

$USE_WCT_IM=1

$USE_ST_IM=0


Domino Web Access 

Use an HTTP-proxy Servlet to restrict URLs to external servers 
For Domino Web Access features that send requests to external servers or Web services, such as Quickr 
integration or Widgets,  administrators can use an HTTP-proxy servlet to intercept calls and retrieve 
information from a remote site. An  HTTP-proxy servlet specifies which sites are allowed. Then, instead of 
making a request call to an external server such as Quickr or Google, for example, calls are passed 
through the HTTP-proxy servlet. If an external server is defined in the HTTP-proxy servlet properties as 
one of the allowed sites, then the request is passed on to the external server. And any information 
received from the external server is returned through the HTTP-proxy servlet. 

An HTTP-proxy servlet protects the hosting Web server against malicious code by filtering out unwanted 
sites. Other servers are prevented from attacking the requesting server, because the requests are going 
to the HTTP-proxy servlet, not the Web server. For security reasons it is important that you limit the sites 
that can be access through your proxy. An open proxy that passes on connections to any Web site leaves 
the Web server vulnerable to abuse. You use a proxy-config.properties file to specify which servers are 
allowed. For each site you want to allow, you configure a proxy policy that includes the following set of 
properties as shown in this example: 

enabled=true

connectTimeout=200

sessionTimeout=30000


policy0.url=http://www.google.com/

policy0.context=/xsp/proxy/GoogleProxy/

policy0.actions=GET,POST

policy0.cookies=

policy0.headers=*

policy0.mime-types=*


Each policy setting that you configure must have a different number and the numbers must be sequential. 
That is, there is a policy0, then a policy1, then a policy2, and so on. The context entry determines which 
proxy servlet this setting is for. In the example above, the setting is for the GoogleProxy.  If you want the 
setting to be for the QuickrProxy, then the entry would look like this: 

policy1.context=/proxy/QuickrProxy/ 
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Property descriptions 

Property Description 
enable Set to true to enable this servlet 
connection timeout Length of time to attempt a connection; 
session timeout Length of time in before the session ends; default if 

unspecified is 30 minutes. 
policy<n>.url Address of the site to which this policy applies. 

The url attribute is the target of the proxy. So, in the above 
example, this policy will be enforced if the GoogleProxy tries 
to access http://www.google.com/. 

policy<n>.actions The set of HTTP actions this policy allows. 

These can be GET,POST,PUT,DELETE. The most frequently 
used are GET and POST. 

policy<n>.cookies Cookies allowed for this site. That is, the cookies that will be 
passed from the browser to the target URL server.  

Note: Cookies that come from outside our network will only 
be passed back to the source server/network.  A cookie from 
Yahoo, will only be passed back to Yahoo. These cookies are 
not listed in this list, this is handled automatically. 

policy<n>.headers Headers allowed for this site, or use * to allow all. This 
attribute determines which headers are forwarded to the 
target server.  

Note: Cookies are not handled as a standard header.  Putting 
the entry "cookie" in the headers list will have no effect. 

policy<n>.mime-types Content types allowed back from the target server. 

NOTE: All other entries tell the proxy server what to allow 
from the browser to the target server; the mime-types 
attribute determines if a response will make it from the server 
to the browser. 

For this Beta release, to configure an HTTP-proxy servlet, copy and paste the sample code provided 
below into a file you create named proxy-config.properties. Place this file in the 
c:\Domino\xsp\proxy directory. 

# Test properties for proxy policies


enabled=true

connectTimeout=200

sessionTimeout=30000


policy0.url=http://www.google.com/

policy0.context=/xsp/proxy/GoogleProxy/

policy0.actions=GET,POST

policy0.cookies=

policy0.headers=*

policy0.mime-types=*
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policy1.url=https://www.google.com/

policy1.context=/xsp/proxy/GoogleProxy/

policy1.actions=GET,POST

policy1.cookies=

policy1.headers=*

policy1.mime-types=*


# policy2.url=http://your_quickr_server:10038/

# policy2.context=/xsp/proxy/QuickrProxy/

# policy2.actions=GET,POST

# policy2.cookies=LtpaToken

# policy2.headers=*

# policy2.mime-types=*


Domino Server 

Windows: NTLMv1 and v2 proxy with integrated authentication 
NTLMv1 and NTLMv2 proxy support with integrated authentication is supported on Windows platforms 
only. 

The user may choose to specify a username and password in the Accounts framework.  If not specified, 
the current user's Windows credentials will be automatically obtained and used for authentication.  A user 
will only be prompted for credentials if the credentials provided are invalid or out of sync with Active 
Directory. 

When storing credentials in Accounts or entering credentials in a prompt, the domain should prefix the 
username.  For example, a user called "User" in the domain "DOMAIN" should specify the following in the 
username field:  DOMAIN\user.  See the Domino Administrator Help for moreinformation about 
configuring platform proxy settings. 

Note: The Apache Axis web service framework does not obey platform proxy settings. All remote 
connections will be direct. 
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Known limitations, problems, and workarounds 

Limitations 

Client issues 

Lotus Notes 

Cannot drag/drop attachments from Notes to Sametime 
On Windows and Mac OS, when dragging an attachment from a Notes document to a Sametime chat 
dialog box and dropping it, Sametime is unable to accept the file. 

Lotus Notes 

Citrix: Select Sound list is blank 
Using a Citrix client, in any Mail or Calendar dialog box where the user sets an alarm, the list of sounds 
will be blank.  The affected dialog boxes are: 

Follow Up - Add or Edit Flag

Mail Preferences:  Follow Up panel

Calendar Preferences:  Alarms panel


There is no known workaround at this time. 

Lotus Notes 

F1 Help for File -> Preferences not comprehensive 
Not all Preference dialogs bring up a Help topic when you press F1 (Note: On the dialogs for which F1 
Help is implemented, focus must be in the dialog when F1 is pressed).  To find comprehensive Help for 
preferences, click Help -> Help Contents from the main menu, and either use Help Search or look in the 
All Topics list. 

Tip: If you use F1 on a preference dialog for which it is implemented, for example on the Basic Notes 
Client Configuration dialog, leave the Help pane next to the dialog open as you click other preferences in 
the navigator. The Dynamic Help portion of the pane uses an automated search based on context and 
locates the relevant topic for you on most preference dialog boxes. 
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Lotus Notes 

Help Search -- Not all results can be synchronized with Contents 
In Lotus Notes Help, when you use Help Search, and click on a topic in the search results, usually you 
can see where in the Help Table of Contents that topic falls by clicking either the Refresh / Show Current 
Topic or Show in Table of Contents  icon. If nothing happens when you click one of these icons, the topic 
is an advanced topic that intentionally does not appear in the table of contents. 

Lotus Notes 

Notes Selection model may not work well with Select key 
At this time, the Notes Selection model (under File -> Preferences -> Basic Client Configuration) may not 
work well when a user holds the "Shift" key and selects additional messages. 

DECS issues 

Domino Server 

DECS is not available as part of  8.5 beta program 
The Domino Enterprise Connection Services (DECS) is not available as part of this Notes/Domino 8.5 
beta program. 

Domino Designer issues 

Domino Designer 

Changed limits on design element name length , uniqueness 
The UI for creating design elements does not, as yet, implement the same limits for design element name 
length and uniqueness as previous Designer versions.  We intend to implement the same length limits as 
previously, which for most design element types are 64 bytes LMBCS for each title or alias, 128 bytes 
overall.  As regards uniqueness, we hope to improve on the existing functionality, but at least, the 
intention is that we will either prevent or warn if you create design elements with conflicting names, 
however that functionality is not in the beta. 

Domino Designer 

Online Help plug-ins take long time to index when first accessed 
Indexing of the Domino Designer Eclipse Help plug-ins may take 20+ minutes to index when they are first 
accessed for the Dynamic Help view in Domino Designer.  During this time you are not presented with 
search results in that view. 
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Domino Designer 

Query Views on top of DAVs not operating correctly 
When executing a QUERY VIEW on top of a DAV, you get the following message: 

05/19/2008 02:44:01 PM  Glutton/Emp  Failed when DB2 was fetching a note.  

A DB

2 Access Error occurred.  Server log will contain more information.: 04003

- [IB
M][CLI Driver][DB2/NT] SQL0443N Routine "DOMINO.ISREADER4" (specific name 
"SQL07
1011141457200") has returned an error SQLSTATE with diagnostic text "690 : 
Null 
object handle". SQLSTATE=04003 - *LOCAL.DB2.080519141256(nserver) 

Domino Domain Monitoring issues 

Domino for i 

IBM i: DDM memory probe reports  2x usage for Java agent 
Due to platform differences, a Java agent on IBM i will be reported as using about 2x the CPU as on other 
platforms. 

Lotus Symphony issues 

Lotus Notes 

Domino Designer menu and toolbar are shown in Symphony 
If both Symphony and Domino Designer are installed, after launching Symphony, two extraneous menu 
items named "Search" and "Run", and the Domino Designer toolbars, will appear on Symphony's menu 
and toolbar. The extraneous menus and toolbars will not work when clicked 

Lotus Notes 

Forms are not saved correctly in  .PPT format 
If a Lotus Symphony Presentation document that contains forms is saved as a Microsoft PowerPoint 
(.PPT) file, and then re-opened by PowerPoint, the forms in that document will be shown as blank 
rectangular frames. 

Lotus Notes 

Formula result is incorrectly shown when opening Lotus  123 file

If a Lotus 1-2-3 file containing formula text in a cell with the "Text Formula" style is opened in Symphony, 

the calculated formula result will be displayed.
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Lotus Notes 

Graphics with text cannot be copied to other applications 
In Lotus Symphony Spreadsheet and Lotus Symphony Presentation, inserting a graphic and inputting text 
into it, and then copying the graphic to another editor, or to Lotus Notes, may result in the text inside the 
graphic to be lost. 

Lotus Notes 

Hyperlink with mixed-byte characters may be duplicated on Save 
If a Symphony spreadsheet cell contains a hyperlink which has double-byte and ASCII characters in the 
hyperlink text, saving to an .ODS file may cause the hyperlink to be duplicated. 

Lotus Notes 

Linux: No "Save as type" option available on SUSE 
There is no "Save as type" combobox in the 'Save as' dialog for Lotus Symphony running on the SUSE 
platform.  File extensions need be set specifically to save a file as a certain type. 

Lotus Notes 

Notes toolbar options are shown in Symphony 
Launch Symphony and then Notes, and start the toolbar context menu by right clicking Symphony's 
toolbar. The Notes toolbar options are also shown under Symphony's toolbar menu. These extraneous 
toolbar options will not work when clicked. 

Lotus Notes 

Save unsupported document type may cause data loss 
Unsupported document types can be opened by altering their extensions, but this can cause data loss 
when the file is saved back.  For example, changing a .HTML file into a .SXW file and opening it may 
result in the document content being lost when subsequently saving the file. 

Lotus Notes 

Spellcheck does not support user dictionaries for some languages 
Spell check does not support the user dictionaries of the following language versions: Hebrew, Simplified 
Chinese, Traditional Chinese, Turkish and Hungarian. 

Lotus Notes 

Tables in Notes cannot be copied to Lotus Symphony Presentations 
Selecting and copying a table in Notes, then pasting it into Lotus Symphony Presentations, will cause only 
the table text to remain. 

Lotus Notes 

User cannot Undo if a document is not completely loaded 
The "Undo" command does not work when a document is still loading (for example, if the page number in 
the status bar keeps on increasing), until that loading is finished. 
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Lotus Notes 

"Reversing Path Direction" is not supported for animation effect 
"Reversing Path Direction" is an attribute for the 'Motion Paths' animation effects in Microsoft PowerPoint. 
This attribute is not supported in Lotus Symphony Presentations; there will be no animation effect if this 
attribute is set to 'True'. 

Notes client on Macintosh issues 

Lotus Notes 

Cannot use embedded browser to run applets on Macintosh

On Mac OS X, the embedded browser does not support running applets inside the browser.  As a result, 

using the embedded browser to host a Web conference or to join a meeting results in an error message.  

This happens because of a Virtual Machine (VM) nesting limitation.


Lotus Notes 

Macintosh PowerPC is not supported with this beta 
The PowerPC is not supported with this beta release of the Notes 8.5, due to issues with the 10.5 
compiler.  You are able to install and run the beta on PPC machines, however, intermittent crashing or 
limited functionality may be experienced, and its use is not recommended at this time. 

A bug report has been filed with Apple and a resolution is being identified.  Lotus plans to support PPC 
when 8.5 is released for General Availability. 

Lotus Notes 

Spell checker not supported for some languages 
The LanguageWare V27 engine on Mac OS X is not supported.  As a result, you cannot spell check 
content in the following languages using the Rich Text Editor or Text Analyzer: 

z Chinese (Simplified & Traditional) 
z Hungarian 
z Israel 
z Turkish 

Lotus Notes 

Unable to consume Web Services on the Macintosh 
Web service calls from Notes applications on the Macintosh are not working correctly.  When your Notes 
application (in Java or LotusScript) tries to make a Web Service call through a Web server-enabled script 
library, it will fail. 
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Roaming user issues 

Lotus Notes, Domino Server 

Debug console for Java replication briefly appears 
When you launch the Notes client, you may see a Debug console for Java replication; you can ignore it 
because that console is automatically dismissed after the Notes client loads. 

Lotus Notes, Domino Server 

Do not apply roaming policy to registered roaming users 
Applying a policy to upgrade a user to roaming status can only be used with nonroaming users. This 
feature does not yet apply to those who have already been registered as roaming users with the User 
Registration tool in the Domino Administrator client. 

Lotus Notes, Domino Server 

Do not combine Domino server roaming with file server roaming 
Do not combine Domino server roaming and file server roaming for the same Notes client user. This 
configuration is not supported. 

Lotus Notes, Domino Server 

Ensure databases have replicated after policy upgrade to roaming 
When upgrading a user's status from non-roaming to roaming by assigning a roaming policy, the Person 
document in the Domino Directory may indicate that the roaming status change has occurred, when it has 
not. When you open the Person document, the "User can roam" status is set to Yes before all the roaming 
databases have been replicated. The roaming databases on the Notes client must be replicated to the 
Domino server; otherwise, when the user attempts to log onto the Notes client on another computer, the 
user receives a message requesting they again update their status to roaming. The upgrade process that 
was started did not actually complete but the Person document indicates that the update to roaming was 
successful. 

Workaround 
After you initiate an upgrade to roaming status, before you use the Notes client on another computer 
verify that all roaming databases on the replicator page have successfully replicated to the Domino 
server. Verify that the following databases have been replicated: 

z Names.nsf 
z Journal.nsf 
z Bookmarks.nsf 
z Localfeedcontent.nsf 
z Roamingdata.nsf 

To ensure that replication occurs, open your replicator page and manually replicate the databases.  Next, 
verify that the field "User can roam" is set to Yes in your Person document on the server. 

Lotus Notes, Domino Server 

Notes client Basic with roaming does not support policies 
Policy assignment for upgrading a user's status to roaming is not supported in the Notes client basic 
configuration. 
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Lotus Notes, Domino Server 

Some Notes.ini settings not retained for roaming
 Some Notes.ini settings that worked with roaming user configurations in Notes 8.0 and earlier releases, 
do not work correctly for roaming in Notes 8.5. If you have a problem retaining any Notes.ini settings in 
roaming configurations, use the alternate method for the settings. For example, some settings also exist 
on the menus in the user interface, in the server configuration document, or a policy. 

Lotus Notes, Domino Server 

Upgrading a second Notes client computer to roaming 
Prior to upgrading a second Notes client computer to roaming, be certain that the field "User can roam" in 
the Person document is set to Yes, and also verify that all roaming databases have replicated to the 
roaming server. 

Lotus Notes, Domino Server 

Upgrading to roaming with Notes client basic configuration 
When upgrading previously-registered Notes client users who use the Notes client basic configuration, 
first downgrade the user to non-roaming status. You can then use the new roaming features to upgrade 
the user to roaming status on the Notes client standard configuration . When a user is upgraded to 
roaming, the administration server and the roaming server must both be Domino 8.5 servers. 

Security issues 

Domino Server 

XPages runtime security is not fully enabled 
Runtime checking of XPages design element signatures for server access permissions is not enabled for 
this beta release.  This will be addressed for the Gold Availability (GA) release. 

Server issues 

Domino Server 

DCT - Check for Updates feature is temporarily unavailable

The "Check for Updates" feature has been temporarily removed from Domino Configuration Tuner (DCT) 

for this beta release.


Domino Server 

DCT not supported for use with DB 2 Access servers 
Domino Configuration Tuner (DCT) is not supported for use in a configuration that includes DB2 Access 
servers.  If your configuration includes DB2 Access servers and you run DCT, the DB2 Access Servers 
will display in the Domino server list.  If you select a DB2 Access server from the Domino server list, a 
LotusScript error is generated. 
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Domino Server, Domino for i 

IBM i: Java heap dump not generated with  "classic" JVM 
If you choose to use the non-default "classic" JVM using the Notes.INI value JavaUseClassicJVM=1, 
note that a heap dump (.phd file in the server's data directory) will not be generated if the JVM encounters 
an out of memory condition.  The heap dump will be generated if you use the default JVM, J9. 

See the "IBM i: Software requirements" release note for more information. 

Domino Server 

Limit number of users for Auto -Populated Groups feature 
The new group feature Auto-Populated groups allows you to pick the method of Home Server.  Currently, 
the feature performs slowly when running against large directories, or with secondary directory 
environments with large numbers of users. Therefore, at this time it is recommended to explore this 
feature in a test environment that contains no more than 3,000 mail users. 

Lotus Notes, Domino Server 

User registration tool creates some required roaming files 
In the Domino 8.5 Administrator client, when you use the user registration tool to register a Domino 
roaming user, it does not create two new files required for roaming users with Notes client standard 
configuration. The following two files are not created by the registration tool but are created later when the 
user sets up the client: 

z Roamingdata.nsf 
z Localfeedcontent.nsf 

The user registration tool also fails to rename the file Journal.nsf to the new name, Notebook.nsf.  The 
user registration tool does create the original roaming files Bookmark.nsf, Names.nsf, and Journal.nsf. 

Known problems and workarounds 

Activities issues 

Lotus Notes 

Cannot add a file to some entries after deleting a file 
Once a file has been deleted from a To-Do or a Comment, you cannot add another file. 

Lotus Notes 

Comments and To-do Responses to private entries are not private 
Comments and To-do entries created as Response documents to a private entry are not marked private 
by default.  To make Comments and To-Do entries private, the documents must be marked private by the 
responder. 
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Lotus Notes 

Completed To-do entries may appear in Calendar 
Completed To-do entries might still appear in the Notes calendar. 

Lotus Notes 

DBCS attachment displays incorrectly in the Activities sidebar 
Dragging-and-dropping mail with a DBCS attachment to the Activities side bar results in the attachment 
file name displaying unintelligible characters. 

Lotus Notes 

Local database document does not open correctly when launched 
A local database document added to Activities does not open correctly when launched 

Lotus Notes 

Log into Activities to see Activities To -Do in Notes calendar 
When you want to see your Activities To-Do entries within the Notes Calendar, the Activities sidebar 
needs to be activated (logged in via the side shelf). 

Lotus Notes 

Quick Find in Overview may not be desirable 
When searching for non-Activity level documents, it is recommended that the search be done in a view 
other than the Overview. Activities Overview will not likely contain all of your Activities and therefore 
entries. The search cannot be performed at entry-level unless the parent activity is open in the view. 

Lotus Notes 

Roundtrip editing of files is not supported 
Roundtrip editing of files opened from within an Activity is not supported for beta.  The workaround is to 
delete the original file entry and create a new one with the updated file. 

Lotus Notes 

Show Business Card might result in an error

While attempting to view a business card, the user might see an error dialog with the message: 

"'Retrieving business card data' has encountered a problem."


Workaround

Delete Activities Accounts and relaunch the client.  Choose "Menu -> Contacts -> Advanced -> Accounts", 

and delete accounts with names starting with 'Activities'.  Note: Once you delete accounts and relaunch

the client, you will have to re-specify the Activities server settings using Preferences.


Lotus Notes 

Show related activities not working for Notes mail 
The "Show related activities" feature is not working with Notes mail documents. 
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Lotus Notes 

The By Priority view and Overview are not drag /drop enabled 
Both the "By Priority" view and Overview are not enabled for drag-and-drop operations. 

Client issues 

Lotus Notes 

BIDI issues with brackets 
Following are issues associated brackets when using bi-directional settings: 

1.	 The type of page size should have left-to-right direction even on the translated and mirrored screen, 
thus it is expected appear as B5 (JIS) instead of (B5 (JIS 

2.	 Names of untranslated templates should have left-to-right direction even on the translated and 
mirrored screen, thus instead of (Microsoft Office Library (7  we would expect to see Microsoft Office 
Library (7) 

3.	 Formulae should have left-to-right direction even on the translated and mirrored screen; it is expected 
to appear as ACos() instead of ()ACos 

Lotus Notes, Domino Designer 

Cannot launch Notes if Admin and Designer are running 
In a sequence where the Domino Administrator client is launched first, then Domino Designer, and then 
the Notes client, Notes will fail to launch.  You must close Designer in order to successfully launch Notes. 

This is only occurs for this particular startup sequence. 

Lotus Notes 

Catalog update can hang Notes when certification is required 
Creating a local widgets catalog replica in Notes from the central widgets catalog on a server, may result 
in an error message, and hang Notes when cross-certification is needed.  This may happen when 
choosing File -> Preferences -> Widgets, and entering a catalog server and catalog name, then clicking 
"Apply" on the Widgets preference panel. The cross certificate dialog may open and quickly close 
hanging the client. Once this happens, the only workaround is to exit Notes. 

To avoid this error, manually open the widgets catalog first (File->Open->Lotus Notes Application-> < 
server_name>/toolbox.nsf ) to force the cross-certification dialog to open outside of the Preference page. 
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Lotus Notes, Domino Designer 

Command line launch w/db specified opens in wrong application 
Launching Notes or Designer via the command line, with a database specified, opens the database in the 
wrong application.  For example: 

1. Launch Notes 
2. Open a DOS console and type the path to Notes directory 
3. Add designer.exe to launch Designer 
4. Add MAIL as an extension argument, for example: c:\notes\designer.exe MAIL 

The expected result is that Designer launches, with mail database opened.  Instead, Designer launches, 
but the mail database is opened in Notes instead of Designer.  Note: The same is also true if you launch 
Notes via a command line with a database specified. 

Workaround: Launch via command line without specified database and manually open once loaded. 

Lotus Notes 

Create/Text menus may not work when editing a document 
Create and Text menus occasionally do not work when editing a document. 

Workaround 
Reset focus by switching to another open window tab and then return to the document being edited. 

Lotus Notes, Domino Designer 

Domino Designer Preferences showing in Notes Preferences window 
Domino Designer specific preferences are listed in the Notes Client preferences.  The extra preferences 
are: 

Ant

Domino Designer

Internet

Java

Java Script

Plug-in Development

Run/Debug

Server

Service Policies

Team

Validation

Web

Web Services

XML


and should be ignored by most Notes users. 
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Lotus Notes, Domino Designer 

Duplicate bookmarks when starting Notes after Designer

Duplicate Notes bookmarks appear upon Notes restart in the following very specific use case.


1. Start Notes 

2. Start Designer 

3. Exit Notes 

4. Restart Notes 

When the Notes interface appears, several duplicate bookmarks also appear.  Note that this display issue 
only occurs in Notes "docked" mode, and in this specific task sequence.  To avoid this issue, exit 
Designer when you exit Notes. 

Lotus Notes 

Notes sidebar display issue

In some instances, after installing this beta release and restarting Notes, the Notes sidebar may not be 

visible and the View -> Sidebar menu sequence may be disabled.


As a workaround, individually open the sidebar panels that you want to display using the View -> Sidebar 
panel menu sequence. The panels that you individually select will appear in the Notes sidebar, both 
immediately and when you restart Notes. 

Lotus Notes, Domino Server 

Removing an assigned widget policy can lock widgets

Removing an assigned user policy that uses a Widgets catalog can cause widgets to remain locked.  If 

the user was assigned a catalog server and database, category names, and the "Install widgets from

catalog" policy setting was set to "Disabled", and the user policy is then removed, the categories on the 

Widgets preference page will remain locked.  At this point, the user and administrator will not have the

ability to remove the widgets. 


As a workaround, assign another desktop policy which resets the settings to the desired values, for 

example, set "Install widgets from catalog" to 'Enabled'.


Lotus Notes, Domino Designer 

Roaming considerations for Beta

The following Beta considerations are specific to the new Roaming functionality introduced in Notes and

Domino release 8.5.


z	 Roaming user functionality for Notes users on the Mac OS platform and the Linux platform is not 
available in Lotus Notes standard configuration in this Beta. Roaming user in Lotus Notes basic 
configuration remains unchanged from earlier release capabilities. 

z	 If you start one of the Lotus Symphony editors before starting Notes, in a single Notes session, many 
Notes preferences will not be available for roaming in that Notes session. To ensure that all possible 
Notes preferences are available for roaming in your current Notes session, start Notes before starting 
Lotus Symphony. 
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z	 If you start Domino Designer before starting Notes, in a single Notes session, many Notes and 
Designer preferences will not be available for roaming in that Notes session. To ensure that all 
possible preferences are available for roaming in your current Notes session, start Domino Designer 
before starting Lotus Symphony. 

z	 Roaming against a DB2-enabled server is not available in this Beta release. 

z	 The Notes start-up sequence om the Windows client platform has been reordered as part of 
performance enhancement in this release. Notes users are now prompted to authenticate (log in 
using their Notes password) before the Notes workbench appears on-screen. The new NOTES.INI 
setting for this sequence is "ENABLE_EARLY_AUTHENTICATION" which has a default setting value 
of 1, enabling the new mode. Disabling the setting reverts to the old (pre-8.5) start-up mode. If the 
ENABLE_EARLY_AUTHENTICATION setting is disabled (0), the Roaming user functionality 
introduced in release 8.5 is not functional and performance enhancements gained in the reordered 
start-up sequence are not realized. 

z	 The Roaming preference panel, which is only available for file server roaming users only, may 
inadvertently be visible (but non-functional) for Domino server-enabled users in this Beta release. 

Lotus Notes, Domino Designer 

Unable to launch IBM Support Assistant 
Some users may experience problems launching the IBM Support Assistant (ISA) from the Notes client or 
Domino Designer UI. If you experience an issue, you may do one of the following: 

z	 Run ISA from a command line: 

- Run StartCollector from your Notes framework\rcp directory, for example, 
C:\notes\framework\rcp>startcollector.bat 

- Collect the .zip file created from the path you specified 

- Post that information to us

z	 Uninstall Domino Designer, then run ISA from the UI as you normally do 

Composite Applications issues 

Lotus Notes 

Cannot wire some Portal navigator actions 
When using the Buttons, Tab or Breadcrumbs navigator in a Portal application, you will not be able to wire 
to the "Page Opened", "Page opened as popup", or "Page opened in a new window" actions. 

This limitation does not affect NSF-based applications, or Local file-based applications. 
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Lotus Notes 

Clicking Apply for new wire can result in error 
Under certain conditions, creating a new wire and using the Apply button can result in an error.  For 
example, 

1.	 Open a composite application for editing. 
2.	 Drag two components from the component palette to to the component navigator. 

3.	 Right click on Component 2 and choose Edit component properties . Click the Advanced Tab. 
4.	 Click the Add button 
5.	 Enter a name. 
6.	 Delete the Value 
7.	 Check the wireable checkbox. Click OK. 

8.	 Right click on Component 1 and choose Wiring. 
9.	 Create a wire to the new 'action' just created from Step 6 above. You may have to disable strict type 

checking. 
10. Click Apply. 

Clicking Apply produces errors in this case. The wire is created, but the behavior is unstable. 

Workaround

Instead of using Apply, click OK to create a wire.


Lotus Notes 

Corrupted character appears in page title tab of local files 
If you are working on a composite application from your local file system, you might encounter corrupted 
characters in a page title when you are trying to create wires. 

Workaround

Edit the page properties and remove all the white space before and after the page title.
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Lotus Notes 

Deleting certain components from a Portal -based app causes error

If you are editing a composite application or composite application template hosted on a Portal server, 

and you delete a PIM component (such as the Contacts component) from your application, errors result, 

and are recorded in the log.  In the case of the mini mail view component, deleting the component can

produce a crash.


There is no workaround. 

Lotus Notes 

Error when adding NSF component to Portal application 
When adding NSF components to a Portal-based composite application, you will receive the following 
error: "CLFRI0051E: Component Manager experienced a problem. CLFRI0203E: 
Exception happened when running Portal Command". To work around this error, you can 
configure the Composite Application Error to not use the Domino Application Portlet when creating 
components on Portal, as follows: 

Edit <notes_install>\framework\rcp\plugin_customization.ini and add the line: 

com.ibm.rcp.aaf.portal/DontUseDAP=true 

The result of this change is that you will not be able to view your Notes content if you view this application 
on Portal (as opposed to in Notes). 

Lotus Notes 

Generic Web container visible on Linux but not supported 
A generic web container is visible on the palette for Linux systems; however, it will be hidden in the 
General Availability (GA) build. Do not use this component, as it is not supported. 

Lotus Notes 

Linux: Adding widget causes errors and requires restart in CAE 
On a Linux system, if you add a widget to a composite application, you will be prompted to install the 
widget, restart the Notes client, and save your changes in the Composite Application Editor. When you 
save changes, the Composite Application Editor will return the error: An Error occurred when closing the 
workbench Restarting client after adding plugin . 

Dismiss the error, and complete the restart of the Notes client and the Composite Application Editor.  Click 
OK to dismiss the error and resume working. 

Lotus Notes 

Linux: Generic Web container component displays on palette 
The Generic Web container component displays on the component palette in the Composite Application 
Editor, but it is not supported for the Linux platform. 
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Lotus Notes 

Property to property wiring not saved for Portal applications 
Properties marked as Wireable in the Advanced Component Properties of the Composite Application 
Editor are not supported for Portal-based applications.  If you wire to them, the wires will not be persisted 
when you save the application. 

Lotus Notes 

Source page in View All Wires not displaying when name is long 
If you assign a very long name to a page, the page may not display in the View All Wires view. This 
problem only occurs when you are working with an application from your local file system. 

Workaround 
Edit the page properties and remove all the white space before and after the page title, or shorten the title. 

Contacts issues 

Lotus Notes 

International Alpha tab issues 
International alpha tabs are not working properly in the local Contacts. 

Lotus Notes 

Moving a recent Contact with a domain in the address 
Two issues arise if a user clicks "Move to My Contacts" for a recent contact which has a domain in the 
mailing address, as in "Jane Dough/Acme@ACME_US": 

1.	 The canonical-ized name will appear in the 'Move to My Contacts' dialog box, as in "CN=Jane 
Dough/O=Acme@ACME_US". 

2.	 The recent contact is not removed from the Recent Contacts view. If this situation occurs, just 
press the DEL key to remove it from the view. 

Domino Designer issues 

Domino Designer 

Cannot close progress page in Domino Designer 
Clicking on the Progress/Status indicator in the lower right-hand corner of Domino Designer opens a 
progress window that cannot be closed.  To work around this issue, choose Window Open perspective, 
then choose Domino Designer to return to a working state. 
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Domino Designer 

Cannot initiate Sametime chat from Designer when logged in 
Domino Designer is capable of logging into Sametime, but is not able to initiate chats or view Contact 
lists.  The Domino Designer client can chat if an inbound chat message is received. 

Workaround 
Launch Notes to initiate Sametime chats. 

Domino Designer 

Cannot minimize Designer properties panel if Infobox is open 
Users cannot minimize the Designer properties panel if an infobox is open.  Close the info box, and then 
minimize the properties panel. 

Domino Designer 

Cannot replace image used in shared image resource 
In Domino Designer it is not possible to change the image associated with a shared image resource; once 
the image resource is created, the image cannot be updated or refreshed. 

Workaround 
Rename the existing image resource and create a new image resource with the original name and 
updated image. 

Domino Designer 

Changing WSDL files created in previous releases will not save 
If you created a Wiring Property file in a previous version of Designer, and you open the application with 
the WSDL file in Designer 8.5 Beta, you will not be able to save any changes. 

Lotus Notes, Domino Designer 

Create Agent does not open Agent editor if Designer not running 
Using the Create Agent menu item in Notes fails to open Agent editor unless Domino Designer is 
currently running. If Designer is not running it will launch, but will not open Agent editor 

Domino Designer 

Created Design element opens element then switches tab to list 
Attempting to create a new design element, or edit a recently modified design element, occasionally 
opens the element and then switches tabs back to the design element list. 

Domino Designer 

Creating a new design element via context menu may cause error 
Creating one of the following classic design elements (View, Folder, Frameset, Applet or Data 
Connection) via the contextual menu may cause a runtime exception error.  You can work around this 
issue by selecting another design element before invoking the context menu, or by creating the element 
via the New button or "File -> New" menu item. 
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Domino Designer 

Delete bookmarks manually 
Deleting an application will not delete the bookmark from your workspace.  You must manually delete the 
bookmark from your workspace. 

Domino Designer 

Designer Element List sometimes appears within Notes Client 
If you have Notes and Domino Designer open at the same time, you might see that the Element List 
Editor opens up in a Notes document.  If you see this behavior, close the Notes document, and the 
Element List Editor will go away. 

Domino Designer 

Designer menu duplications depending on launch sequence 
There may be some menu inconsistencies or duplication of items, depending on how Domino Designer is 
launched. 

Domino Designer 

Designer Search of templates or applications can cause a hang 
When using the eclipse based search option in Domino Designer, it is possible in some cases to cause a 
system hang. 

Domino Designer 

Designer Welcome page does not open if Notes already running 
The Domino Designer Welcome page does not open when the Notes client is already running. If you want 
to see the Designer Welcome page, launch Designer when the Notes client is not running. 

Domino Designer 

Extra Forms design list opened when invoking Designer from Notes 
An extra Forms design list may open in Designer when creating a new View, Folder, or Agent within 
Notes. If this happens, you can just close the Forms design list and continue creating your new element 
within Notes. 

Domino Designer 

Extra network activity generated when design locking is enabled 
If Design Locking is enabled, you may notice an extra amount of network activity connecting to the 
Administration server for every action.  This may cause a performance hit to Domino Designer if the 
Administration server is down, because it tries to search for the server. 

Lotus Notes, Domino Designer 

Forms Design element list can unexpectedly open in Notes 
It is possible in some rare occasions that opening a view or clicking an action button in the Notes Client 
while Domino Designer is also running causes the 'Forms' design element list to open in the Notes Client. 
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Domino Designer 

Generate and Source context menus appear in Notes 
'Generate' and 'Source' options may appear in some context menus in Notes.  Although these menu items 
appear, they are not functional, nor supported. 

Domino Designer 

Import Style Sheet button in element list editor does not work 
The Import Style Sheet button in the Style Sheets Element List Editor does not currently work.  To import 
a style sheet, click File -> Import and expand IBM Lotus Domino Designer.  Selecting Style Sheet will 
import the style sheet into your application. 

Domino Designer 

In Domino Designer, Notes Preview does not launch Notes client

Notes Preview fails to launch the Notes client when Notes Preview is selected from Domino Designer.  

The Notes Client attempts to load and gives error !CWPCA8515E: Application failed to open: 

Notes getting started!


Workaround

Have the Notes Client running when attempting to use Notes Preview.


Domino Designer 

Inconsistent Escape key behavior 
Standard Notes and Domino Designer functionality allows you to press the Escape key which will close 
the current window or tab; the classic Domino Designer elements (Forms, Views, Folders, etc.) still allow 
you to press the Escape key, however, the new Domino Designer elements, such as XPages and Custom 
Controls, will not close if you press the Escape key.  You can close those windows by clicking the red "x" 
in the tab name. 

Domino Designer 

Initial creation of a classic design element disables menu bar 
Creating a classic design element may initially cause the menu bar to be grayed out.  Click on the opened 
element editor or on the menu bar, and the menu bar will be enabled again. 

Domino Designer 

Issues specific to Domino Designer  8.5 Beta

Following are known issues with regard to this beta release of Domino Designer:


LotusScript and Java editors

Work is continuing on new Eclipse-based LotusScript and Java editors for Domino Designer.  However, 

they are not yet at beta quality and are not included in this beta release.
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Issues with switching IDs and locations 
Unexpected behavior or crashes may result from switching to a different Notes ID or location document 
from within Domino Designer. 

For this release, it is recommended that you do the following if you want to switch locations or Notes IDs: 

- Make sure Lotus Domino Designer is shutdown
- Switch IDs or Locations from within Lotus Notes
- Re-launch Domino Designer

Toolbar/Menu bleeding issues

Menu items and toolbars may behave unexpectedly within Lotus Domino Designer.  Behavior may include

incorrect menu placement and menu duplication.  Designer Toolbars also have not been fully

implemented in this release.


Notes/Designer interoperability issues

Problems may occur if you select an element/tab/action and choose "Open with Designer" or "Open in

Notes." The element/tab/action you wish to open may sometimes be visible if you switch to the correct

program (either Notes or Designer), but at other times the element/tab/action will not open automatically.


Open the element/tab/action manually.


Notes Preview issues

There are some unexpected behaviors when using the Notes preview function in Domino Designer. 

Notes preview is generally working better when the Notes client is also running.


Application branding

Window titles and help/about documents will be inconsistent when launching Notes after Designer is

running.


Notes bookmarks are missing from Launcher menu when Notes is opened after Designer running.


Open Notes prior to launching Designer.


Unexpected focus switchin g

Content re-parenting may occur between the applications when Notes and Designer are both running.


Domino Designer 

Open database in Designer does not select database in Navigator 
Opening a database in Designer from the Notes client does not select the correct database in the 
Database Navigator.  You must select that database in the Database Navigator to start working with it. 
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Domino Designer 

Pager Control 
In Domino Designer 8.5 Beta 1, when you drop a Pager control onto an XPage, you will have the option of 
setting the pager type to be one of five sample pagers or a custom pager.  When you select one of the 
Sample1 to Sample5 pagers, an image of that pager will display at design time. Those images do not 
match what is currently rendered at runtime. 

z	 Any images that represent 'First', 'Previous', 'Next', and 'Last' buttons in the pager will display with 
the text "First", "Previous", "Last", and "Next", respectively. 

z	 Any status shown in the sample pagers, for example "Page 1 of 10", will only show the current 
page at runtime. 

z	 Any ellipses shown in the images, for example "4|5|....10", will not render at runtime. 

z	 Any layout shown in the images, for example where the status is left-aligned and the page

selector is centered, will not render at runtime.


Domino Designer 

Provisional locking 
If you try to lock or unlock a document when you are not connected to the server, you will get an error.  To 
lock or unlock a document, you must be connected to the server. 

Domino Designer 

Renaming an image adds two file extensions to end of the name 
Renaming an image in Domino Designer will add an extra file extension to the end of the file name.  To 
avoid this, rename your file without adding a file extension to the end.  Domino Designer will append the 
original file extension to the image name. 

Domino Designer 

Status bar does not display Document is locked /unlocked message 
When you lock or unlock a document, the status bar at the bottom does not display the message that the 
Document is locked/Document is unlocked. You can tell if the document was locked or unlocked if there 
is a lock icon next to the element in the Element List Editor. 

Domino Designer 

Switching ID files in Designer causes unwanted results 
Using the Domino Designer client to switch Notes ID files can lead to a state that requires re-launching 
Designer to recover. 

Workaround 
If working in Domino Designer and switching ID files is required, please follow these steps: 

z	 Shutdown Designer 
z	 Switch to or launch the Lotus Notes client 
z	 Switch to the desired Notes ID file 
z	 Launch Domino Designer 
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Domino Designer 

View Agents in Notes does not open Agent element list 
Selecting the Menu item View -> Agents launches Domino Designer, but does not open the Agent Design 
Element list. 

Domino Server 

View Design does not always open to forms element list 
Selecting the menu item View -> Design for an application that is already listed in the database navigator 
in Designer causes the default element list to not open. 

Domino Designer 

XPages disabled on Domino for i 
XPages is disabled by default on Domino for i, for this beta release. 

Domino Web Access issues 

Domino Web Access 

Domino Web Access 8.5 Beta 1 issues 
Following are the issues specific to the Beta 1 release of Domino Web Access 8.5: 

z	 Some features of the sidebar are not operational for this beta release, such as some of the 

drag-and-drop capabilities, and "Open in new tab"


z	 When the chair attempts to delete a repeating meeting, an error occurs 

z	 An error occurs updating from the notice of a cancelled meeting 

z	 If an invitee accepts a meeting invite with an attachment, and then accepts an update notice with 
another attachment, both attachments are removed from the entry 

z	 Entries do not display in the final cell of the Calendar month view 

z	 Display issues when creating all-day events in the One Day view 

z	 To-do entries display in the preview pane in Edit mode, rather than Read mode 

z	 All instances of a repeating To-do are deleted without displaying a confirmation dialog offering 
deletion of "Just this instance" 

z	 Several of the icons on the rich text editor do not work with the Safari browser 

z	 If you have open work tabs, clicking 'OK' in Preferences closes all open tabs, at which time a user 
is prompted to save work in progress; in Firefox clicking 'OK' in the prompt results in a browser 
crash 

z	 Preference button erroneously displays in the archive database; clicking on it causes an error 

z	 Problem with a tab re-opening immediately after being closed; may be associated with presence 
of open sidebar 
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z	 Offline is not supported on SUSE 10 

z	 Personal categories cannot be synchronized to offline 

z	 Cannot open a message larger then 1MB in DWA Lite using the Safari browser 

z	 An error occurs, and there are display issues, when a meeting invitation is viewed in the preview 
pane in DWA Lite 

Domino Web Access 

Domino Web Access Ultralite 8.5 Beta issues 
The following are issues specific to the current Beta release of Domino Web Access Ultralite mode in 
Domino 8.5: 

z	 If you attempt to send e-mail using a replica on a Domino server that is not your mail server, it 
may cause the http server process to hang on that server. 
Workaround: Use the replica of your mail file that is on your home mail server in order to send 
mail.  If this is not possible, then an administrator will hvae to restart the http task from the server 
console on the server with the hung thread. 

z	 Sending mail to multiple recipients requires the use of a semi-colon separator.  A comma 

separator will not work correctly.


z	 In the Inbox and Unread view, reading unencrypted messages is supported.  Other types of 
documents may not read or display correctly. 

z	 New messages and replies only support plain text.  

z	 Reply to all, Reply with history, Reply with attachments are not supported in this beta.  

z	 Message Forwarding is not supported in this beta. 

z	 The Unread mail view only displays one page of unread documents starting with oldest at the top.  

z	 Navigation through documents in the Unread view does not work correctly. 

z	 Navigation actions from the compose new messages page or compose a reply page do not work 
correctly from the Unread view. 

z	 In the Contacts view, creating new or editing existing contacts is not supported.  

z	 Sending an email to a personal group in Contacts is not supported. 

z	 In the Calendar view, creating, editing, and reading individual entries are not supported.   Only 
reading the view for any given day is supported.  

z	 If the DWA time zone user preference is set to custom, there are known problems with the 
support for certain time zones. If the DWA time zone user preference is set to default, Ultralite 
mode will respect the Domino server time zone where the mail file resides (not the client time 
zone) 

Domino Web Access, Domino for i 

IBM i: iNotes with Sametime chat/awareness requires port  80 
Sametime chat and awareness do not work with iNotes (Domino Web Access) when the HTTP server is 
configured to use a port other than 80.  

Workaround 
Configure the HTTP server to listen on port 80. 
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Domino Web Access 

Some Mail policy settings not supported 
Mail policy settings (Domino Web Access tab) regarding Browser Cache Management and RSS Feeds 
are not supported for this beta release. 

Installation issues 

Lotus Notes 

Uninstall before installing or upgrading to Notes  8.5 beta 
Before installing or upgrading to Notes 8.5 beta, you should first uninstall your existing Notes client. 

Domino for i 

IBM i: CHKPRDOPT error messages in language environments 
Domino for i is only provided as an English (2924) language feature.  To deploy Domino in a language 
other than English, you must first install the English version of Domino, and then install the Language 
Pack. 

If you install Domino on a system where English (2924) is not the primary language installed, error 
messages will result from the CHKPRDOPT command as follows:   

CHKPRDOPT PRDID(5733LD8) 

Product 5733LD8 release V8R0M0 option *BASE load 2924 correctly installed.

Language *N not installed.                                                

Product 5733LD8 release V8R0M0 option *BASE load 5050 correctly installed.

Errors found by CHKPRDOPT.                                                


Similar messages may also result during the LODRUN or RSTLICPGM commands and are also normal.  
These conditions are normal and do not affect the ability to configure or run Domino servers. 

Domino for i 

IBM i: Domino installation may fail with signature violation 
When installing Domino on i, the installation may fail with the following error message (check the job log 
for the job that issued the RSTLICPGM command): 

Object has a signature that is no longer valid. 

This is likely the result of installing Domino to a system that has the more stringent levels of object 
signature validation enabled for restore operations. 

The policy to be used for object signature verification during a restore operation (for example, product 
installation) is controlled by the QVFYOBJRST system value, which has a default value of 3. 

When installing Domino for i, the system value QVFYOBJRST must be set to a value of 3 or lower prior to 
installing Domino. 
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After installation of Domino has completed, the system value may be changed back to a more restrictive 
setting. 

An example of changing the system value QVFYOBJRST is provided below: 

CHGSYSVAL SYSVAL(QVFYOBJRST) VALUE('1') 

Domino Server, Domino for i 

IBM i: Missing Java option not always reported during install 
Installing Domino on i 5.4 when the required Java option (5722JV1 option 8 J2SE 5.0 32 bit) is not 
installed should result in a warning message in the installation job log.   

Cause . . . . . : Domino 8 requires J2SE 5.0 (5722JV1 option 8) unless

  JavaUseClassicJVM=1 is specified in the server NOTES.INI file, then JDK 5

  (5722JV1 option 7) is required. Recovery . . .: In order to satisfy the

  software pre-requisites for the Domino product install product 5722JV1   

  option 7 or 8.   


In some cases, the missing Java option is not correctly detected and the message is not sent.   The 
Domino installation will proceed successfully, however, the missing Java option will be reported again 
when the Domino server is started and the JVM attempts to load. 

Refer to the Software Requirements section of these Release Notes, or to the Installation Guide for more 
information about Java software requirements and options. 

Instant Messaging issues 

Lotus Notes 

Exit Notes with an open video chat in progress causes hang 
If a telephony video chat is in progress and the user chooses to exit Notes, Notes will hang.  Instead, exit 
the video chat first before trying to exit Notes. 

Lotus Symphony issues 

Lotus Notes 

Application crashes when exporting new encrypted document to PDF 
If you use Symphony to create a new document and encrypt it with a password then, without saving the 
document, export the document to PDF format, Symphony may crash. 

Workaround 
Save this document to your local disk first, then export it to PDF format. 
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Lotus Notes 

Application will not exit with unsaved Symphony document 
If there are any Symphony documents that have been modified and not saved, Notes will not exit 
normally.  Save the modified documents, or close the modified documents without saving, before exiting 
Notes. 

Lotus Notes 

Colors setting cannot be applied or restored correctly 
Modifications on color settings in "File > Preferences" cannot be applied by clicking the "Apply" button.  As 
a workaround, click "Modify" to apply the modifications.  After completing modifications, clicking "Restore 
Defaults" will not restore the default colors setting. 

Lotus Notes 

Data validity list rule may not be saved in MS Excel format 
Create a Symphony Spreadsheet document and insert a data validity list rule into a cell.  If all the cells 
after this cell are empty, and you then save this file into Microsoft Excel (.XLS) forma, the data validity list 
rule set on this cell will not be successfully saved.  To work around this issue, insert content in any cell 
which is after this cell, and then save it. 

Lotus Notes 

Error message shows when activating restored documents 
If there are unclosed Symphony documents, spreadsheets or presentation files when Notes is closed, 
these Symphony files can be automatically restored in the next Notes launch. When the restored file tab is 
activated, there will be an error message, but the file can be loaded successfully. Discard the error 
message. 

Lotus Notes 

f32main.exe processes appear opening file with Freelance OLE 
If Lotus Freelance is installed, and a presentation file which contains Freelance OLE object is opened by 
Symphony, multiple f32main.exe processes may appear.  Users should kill these f32main.exe 
processes manually, since they will not disappear when the file is closed. 

Lotus Notes 

Failure to send crash report when Lotus Notes does not start up 
When only the Lotus Symphony Document/Presentation/Spreadsheet application is running, and Lotus 
Notes is not yet started, the editor may crash unexpectedly, displaying the "Send crash report" dialog.  If 
you then click the "Edit" button, Lotus Notes will start, but the mail with the crash report attachment will not 
be created as expected. 

If Lotus Notes is running when a crash happens, this is not an issue. 
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Lotus Notes 

Hyperlink target may be changed if pasted from Symphony document

In the Symphony document editor, copy a hyperlink with a non-empty frame type to another application, 

and the pasted hyperlink target will be appended with frame-type text.  Subsequently activating the

hyperlink will not open the target URL correctly.  Edit the pasted hyperlink and remove the appended

frame type text from the target URL.


Lotus Notes 

JAWS 8.0: Marked words cannot be read out consistently

JAWS 8.0 will not consistently read out words marked by the "Find & Replace" or "Spelling Check" dialog, 

if JAWS has been started with the operating system. As a workaround, close JAWS 8.0 and restart it.


Lotus Notes 

JAWS: Version 8.0 or higher is needed using Windows

For JAWS users on a Windows machine, JAWS 8.0 or higher is required for Lotus

Symphony.


Lotus Notes 

Notes with Symphony cannot be launched with JAWS running

When Lotus Notes with the embedded Symphony suite is installed before the standalone Lotus

Symphony suite, Lotus Notes embedded Symphony cannot be launched when JAWS is running.


Workaround

Manually register the library file required by JAWS for embedded Symphony:


z	 From the Start menu, select Run... 

z	 In the Run window, type cmd and then click OK 

z	 Change the directory path to <install_location> 
\framework\shared\eclipse\plugins\com.ibm.productivity.tools.base.system.wi 
n32_<version> 

z	 Type the command: set path=%path%;<install_location> 
\framework\shared\eclipse\plugins\com.ibm.productivity.tools.base.infra.win 
32_<version>; && regsvr32 /s <install_location> 
\framework\shared\eclipse\plugins\com.ibm.productivity.tools.base.infra.win 
32_<version>\UAccCOM.dll 

Rreplace <install_location>  with the Lotus Notes installation location, for example c:\Program

Files\IBM\Lotus\Notes. Replace <version> with the version of the plug-in, for example 

3.0.1.20080520-1702
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Lotus Notes 

ODF file association is overwritten 
If ODF (.odt, .ott, .ods, .ots, .odp, and .otp) or OO1.0 (.sxw, .sxi, .sxc, .stw, .sti, .stc) file types are selected 
to associate with Symphony during Symphony installation, these associations are overwritten on 
Windows platforms when you install Notes 8.x.  If you want to change the association, please consult your 
system administrator. The following gives one possible way to change the association of certain file 
extensions: 

z	 In the Windows Explorer, right-click on a file with the extension whose association you want to 
change, and click "Open With" 

z	 In the "Open With" dialog, click the program that you want to use to open the file, or click "Browse" to 
choose the program on a disk 

z	 Select the check box "Always use the selected program to open this kind of file" 

If ODF (.odt, .ott, .ods, .ots, .odp, and .otp) or OO1.0 (.sxw, .sxi, .sxc, .stw, .sti, .stc) file types are not

selected to associate with Symphony during Symphony installation, users can add/remove file

associations on the Preference page.


Lotus Notes 

Portrait orientation may be changed when opening Freelance files

If Symphony opens a SmartSuite Freelance file which is set with a Portrait page orientation, the page 

orientation may be changed to Landscape. Users can modify the page orientation in the Page Properties

dialog.


Lotus Notes 

Red Hat: Toolkit samples will not run in development environment

If a development environment has been set up on a Red Hat Linux platform, and you launch samples in

the Symphony Toolkit, the sample plug-ins will not run successfully.


Workaround

This is a known limitation for the Red Hat Linux platform; please switch to the SUSE 10 platform to run in

this configuration. 


Lotus Notes 

SLED 10: SCIM 1.4.5 or higher is needed

On SLED 10, text cannot be input correctly with SCIM 1.4.4 using Lotus Symphony . It needs to be

upgraded to SCIM 1.4.5 or later.


Lotus Notes 

Some bullets may not be displayed in Numbering and Bullet dialog

On Red Hat 5.1, some bullet types will not be displayed correctly in the "Numbering and Bullet" dialog, 

due to having insufficient fonts installed for the operating system.  Be sure to install all the language

packages for Red Hat 5.1 so that bullets can be displayed correctly.
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Lotus Notes 

Some customized Preference settings are not kept after upgrading

Some Lotus Symphony customized Preference settings will be lost after upgrading from a previous

version. Users need to recover their Preference settings manually. The default settings will remain

unchanged after upgrading. Reconfigure your customized Preference settings manually after upgrading.


Lotus Notes 

Symphony documents cannot be opened correctly via LotusScript

When opening documents with LotusScript code, if the LotusScript code is executed directly after the

Windows system or Lotus Notes is restarted, the document is loaded into a separate window, not a 

tabbed window within Notes.


Workaround

There are two workarounds:


z	 Kill the soffice.exe process before executing LotusScript code 
z	 Disable preloading from the preference page; reference the preference page from File -> Preferences 

-> Symphony 

Lotus Notes 

Symphony freezes when invoking system menu with JAWS running 
With JAWS running, pressing "Alt + F" then left arrow, or "Alt + Space" to launch Lotus Symphony's 
system menu, leads to a Lotus Symphony freeze.  To recover from the freeze, please press "Alt + Tab" to 
switch focus to another application, then back. 

Workaround

Please press "Ctrl + Tab", "Alt + F", or "F10" to switch focus to menu bar, then press "Alt + Space" to 

launch Lotus Symphony's system menu.


Lotus Notes 

TOC hyperlink in MS Word document does not work in Symphony

Open a Microsoft Word document with a Table of Contents (TOC) in Symphony; the TOC hyperlink does 

not work as expected.  To work around this issue, select the TOC and launch the Context menu, choose

"Update Index/Table", and the TOC hyperlink will be enabled.


Lotus Notes 

Toolkit: Need to add links when setting up Linux dev environment 
The Notes client cannot be launched from a development environment running on the Linux platform if the 
user has set up the development environment according to the Developer's Guide. Instead, add the 
following links (this assumes you install Notes to the default location): 

sudo ln -sf /opt/ibm/lotus/notes/libxmlproc.so /usr/lib/libxmlproc.so

sudo ln -sf /opt/ibm/lotus/notes/libndgts.so /usr/lib/libndgts.so

sudo ln -sf /opt/ibm/lotus/notes/libnotes.so /usr/lib/libnotes.so

sudo ln -sf /opt/ibm/lotus/notes/libnoteswc.so /usr/lib/libnoteswc.so
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Lotus Notes 

UI labels may be truncated with an ellipsis at the end 
UI labels may be truncated with an ellipsis (. . .) at the end.  To work around this issue, hover your mouse 
over the truncated label text, and the full text will be shown as a hover tip. 

Mail issues 

Lotus Notes 

Copy/paste DBCS characters from View Attachment issue

Copying DBCS characters from View Attachment and pasting them into a mail subject causes the last

character to display incorrectly.


Lotus Notes 

Interoperability of built-in view icons 
The Notes client includes several built-in view icons. These icons are used in the version 8.x Inbox, and 
other Mail and Calendar views; most of the icons have the same meanings as previous version 7.x icons, 
but a new look. 

There is an interoperability issue with the version 8.x mail file that makes it display version 7.x -style icons, 
or no icons, in mail views and folders when used in a mixed-version environment.  This occurs when the 
mail file is accessed on a server that has a different version of Notes code than the client. Specifically: 

z	 If the server is version 8.x and the client is version 7.x (or earlier), some icons are not displayed at all, 
including the "high importance" indicator. 

z	 If the server is version 7.x (or earlier) and the client is version 8.x, the 7.x-style icons are displayed 
instead of the new graphics. 

The incompatibility occurs because the view index calculated by the server includes icon numbers based 
on the server's version, not the client's.  Any version 8.x mail file accessed locally will display the 
appropriate icons for the client version you are using.  Any version 7.x mail file will always display 
7.x-style graphics, because it doesn't know about the new icons. 

The updated icons were added and given new numbers, rather than replacing the old icons with the same 
meanings, to avoid affecting custom applications that use the old icons. 

Recommendations 

z	 Either use local mail files, or do not update mail files to 8.x before you upgrade clients to 8.x. 
z	 Update servers before clients (this is the recommended sequence for all upgrades). 

Lotus Notes 

Status area may not display correct number of messages selected

When you use Notes selection mode (under File -> Preferences -> Basic Client Configurations), the 

status area sometimes does not reflect the correct number of messages selected. The status area 

display may go out of sync with check marks displayed. The workaround is to go to Edit -> Deselect All

and start selecting messages.
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Notes client on Linux issues 

Lotus Notes 

Cannot install to Arabic locale

There is a data type error that prevents installation of the Notes client on Linux, to an Arabic locale.  

Instead, install to an English locale.


Lotus Notes 

Cannot use ComboBoxEditor on Linux 
If you have the Composite Application Editor installed on a RHEL 5 system, and you select to open a 
Page Properties dialog from the Navigator, selecting Translate -> Add -> Combo Box will cause you to be 
unable to scroll or select an item. 

This is caused by Eclipse bug #229651, which you can see at: 
https://bugs.eclipse.org/bugs/show_bug.cgi?id=229651 

Lotus Notes 

Crash when trying to switch replicas 
In some cases, if the mail server is not available, it may report as available and then crash. 

Lotus Notes 

Date picker is inconsistent for Thai locale 
For a Thai locale setting, if the default year for a Calendar entry is inconsistent with a To Do, then a new 
To Do entry will not be shown correctly in the date slot.  As a work around, when creating a To Do, 
change the year to the Calendar entry default year. 
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Lotus Notes 

Error message pops up when installing Notes RPM 
If you install the Notes RPM packages via the GUI (double-click RPM on the file browser), there will be an 
error message: 

Workaround 
Ignore the error message, and continue the installation. 
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Lotus Notes 

Font size does not display in the infobox 
Highlight some text in a document RTF field, select File -> Properties to open the properties infobox, and 
you will see that the Font Size choices are missing; you will be unable to change the font size: 

Workaround 
In the Preferences -> Basic Configuration -> Display -> Default Fonts, set the default font family settings 
from Luxi xxx to Bitstream xxx. 

Lotus Notes 

Issue importing an Excel file into RTF 
When importing an Excel file with a DBCS chart into an RTF field in Notes, the chart title is not displayed 
properly. 

Lotus Notes 

Missing components if many RPM/DEB are installed at one time 
If ibm_lotus_notes.rpm/deb is installed on your system, the other four RPM package components 
will not be installed properly if transferred as the last argument of rpm -ivh. For DEB package 
installation, the issue will happen to the first argument of dpkg -i. For example: 

On RHEL 5.1, the following command would result in the Activities component missing after installation: 
# rpm -ivh ibm_lotus_notes-8.5.i586.rpm 
# rpm -ivh ibm_lotus_sametime-8.5.i586.rpm ibm_lotus_activities-8.5.i586.rpm 

91 



IBM Lotus Notes, Domino, Domino Designer 8.5 Beta 1 Release Notes 

On Ubuntu 8.04, the following command would result in the Sametime component missing after 
installation: 
$ sudo dpkg -i ibm_lotus_notes-8.5.i586.deb 
$ sudo dpkg -i ibm_lotus_sametime-8.5.i586.deb 
ibm_lotus_activities-8.5.i586.deb 

Workaround 
Install all of the 5 packages at one time, or install the 5 packages one by one. 

Lotus Notes 

No new mail notification in system tray 
This is a Linux-only issue.  When you set up the New Mail Receiving options in 
File/Preferences/Mail/Sending and Receiving, and check the box to check for mail every "x" minutes, new 
mail arriving will refresh the Inbox, but no pop-up notification or New Mail icon appears in the system tray. 

Lotus Notes 

Notes hangs when closing after previewing any Activities entry 
Launch the Notes client with Activities installed, uncheck 'Do not prompt when exiting Notes' in the 
Preferences settings. Then, log into Activities, and single-click any of the Activities entries to pop-up a 
preview frame. Click the 'close' icon of the Notes window, and the Exit confirmation dialog box will blink, 
hanging the Notes client. 

Lotus Notes 

NSF files cannot be opened by Notes via double click 
Double-clicking an NSF file, will not open the file in Notes. 

Lotus Notes 

Paper size different though settings are the same

In the Print View dialog box, set the same paper size using both "Printer tab -> Settings -> Paper size" 

and "Page Setup tab -> Size"; the output paper size is not consistent, though they should be.


92 



IBM Lotus Notes, Domino, Domino Designer 8.5 Beta 1 Release Notes 

Lotus Notes 

Print preview and actual print result is not fully consistent 
In the Calendar One Week view, set the "Work Week Style" in the Printer tab and "landscape" in the Page 
Setup tab, then print. The print result misses words in the left edge (below) while Print preview displays 
the whole page correctly. 

Lotus Notes 

Printer always prints A4 size even if size setting is changed 
After installing a cups-pdf printer on SLED 10, printing a document with a paper size other than A4 will 
always cause the output .PDF file to be printed with an A4 paper size. 

Lotus Notes 

Resizing OS font without Notes running will cause display issue 
If you want to change the OS font, you should ensure that Notes is running, otherwise Notes will display 
abnormally. This is because the Notes Core font can only be resized when the Notes client is active.  
Resize the OS font to 160DPI (the defaut is 96) without Notes running, then launch Notes. 

Lotus Notes 

Some attachments cannot be dragged /dropped to OS folder 
Some large attachments cannot be successfully saved to the local OS folder by using drag-and-drop. 
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Lotus Notes 

Some imported/attached files will not be displayed correctly 
In Notes RTF fields, importing the following files may cause display issues: 

1.	 .DOC, .XLSX, and .PPTX files display unintelligible characters when imported 
2.	 When importing Office 2003 .DOC files, table borders and backgrounds are not consistent with the 

actual document 
3.	 When importing SODC files the font, list, paragraphs, table, picture, chart and spreadsheet types are 

displayed incorrectly 
4.	 When importing Office 2007 files, tables are displayed incorrectly 
5.	 Importing/Exporting "Microsoft RTF" with tables, may cause some characters to be lost 

In Notes RTF fields, when viewing attachments like .XLS files, the charts inside the .XLS file will not be 
correctly displayed. 

Lotus Notes 

Spell check dialog UI display is misleading

Choose "Tool-> Spell check" and, for any misspelled word, you will see that the "Skip" and "Replace" 

buttons are grayed-out in the spell check dialog box:


Lotus Notes 

Thai language is missing from Primary Dictionary 
When setting "File -> Preferences -> Spell Check", there is no option for the Thai language to be set as 
the default dictionary. 

Lotus Notes 

Ubuntu: Cannot input DBCS characters into phone message 
You cannot input DBCS character into the Message area of a phone message. This problem only exists 
for the Ubuntu OS, not for other Linux platforms such as Red Hat and SUSE. 
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Lotus Notes 

Ubuntu: Embedded browser does not support SSL -connected URLs 
On Linux Ubuntu 8.04, the embedded browser does not support Secure Socket Layer (SSL)-connected 
URLs (https://). The following error  message is displayed, and loading is denied after you click the OK 
button. 

This document cannot be displayed unless you install the Personal Security
Manager (PSM). Download and install PSM and try again, or contact your 
system administrator. 

Lotus Notes 

Ubuntu: Text truncated in some Archive panes /dialogs 
Using an Ubuntu client, open your mail file and choose "Actions - Archive - Settings" . On the Criteria 
pane, click New (or select any existing criteria set and click Edit); various static text items are truncated: 
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Click the Selection Criteria button; again, various text items are truncated 

. 

Go back to the Archive Settings dialog Basics pane, Advanced pane, and Schedule pane; all of these 
include truncated text, too. 

Lotus Notes 

Ubuntu: "Open with . . ." does not work for Notes RTF fields

Attach a file into a rich-text field in Notes, then right-click on the attachment and select "Open with . . ."; 

there will be no response.


Notes client on Macintosh issues 

Lotus Notes 

Attachment issues 
Known attachment issues when using Macintosh are as follows: 

z	 If you are attaching Mircosoft Office Word 2008 files into a Notes mail message, and sending the 
mail to a SMTP mail box, the attachment will have an extraneous .hqx extension or have 
duplicates. As a workaround, you can compress the file into a .zip file before attaching. 

z	 Notes does not support the attaching of iWork files. 

z	 The following Office file attachments cannot be viewed: *.sxd, *.sxm, *.odb, *.odg, *.odf, *.sxi, 
*.sxc, and *.sxw 

z	 The following file attachments cannot be viewed: *.mp3, *.rm, *.sitx, *.lwp, *.tgz, *.wma, *.wav 

z	 Charts in file attachments with an *.xls extension cannot be viewed. 

z	 Macintosh client conversion filters are not used for attachments.  As a result, searching an 
attachment fails for many file formats. 
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Lotus Notes 

Cannot preview all mail using the arrow keys on Macintosh 
On Mac OS X, you might not be able to preview all mail items using the arrow keys inside your Inbox. The 
reason for this is that the Preview pane of the mail view gets focus after Multipurpose Internet Mail 
Extensions (MIME) mail is previewed automatically.  This issue also occurs in the Chat History view of 
mail database. 

Lotus Notes 

Cannot preview mail via arrow key 
If you are stepping through mail items via the arrow keys, with the Preview pane open, then the keyboard 
focus will go to the preview pane for mail with HTML content.  You need to set the focus back to the next 
mail entry manually when previewing HTML mail. 

Lotus Notes 

Drag-and-drop issues on Mac

The following drag-and-drop operations do not work well on Macintosh:


1.	 Cannot drag-and-drop a document from the Notes view to the Open List. 

2.	 Drag-and-drop document in mail, calendar and contact database may be very slow with text edit box 
open. You need close the search toolbar and Sametime sidebar before performing the drag-and-drop 
operation. 

3.	 Drag-and-drop attachment to Sametime chat window is not supported on Mac. 

Lotus Notes 

Google gadget does not render properly in the Widget view

On Macintosh, Google gadgets do not display in the window, tab, or sidebar panel when first opened.  A 

blank page is displayed instead. 


Workaround

Drag the window to resize it and display the content. 


Lotus Notes 

Launch and exit Notes issues

Following are issues exiting or launching the Notes client on Macintosh:


z	 Notes may crash on exit if the user has a customized Homepage open; please do not customize your 
home page on Mac. 

z	 If you cannot launch Notes via double-clicking the Notes icon in Finder, you can try to drag the Notes 
icon from Finder to Desktop and drag it back, then you can launch Notes via double-clicking. 
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Lotus Notes 

Macintosh: Java Agents on the Notes client 
The Notes Client on Macintosh now runs Java agents. Locally scheduled background Java agents, 
foreground Java agents (actions), and Java agents running in a background client thread are all 
supported. 

Note: Java applets are not supported. 

Caveats 

z	 Java agents on the Macintosh that consume the AWT thread for long periods of time can cause 
the Notes main thread to hang.  Any Java agent code that interacts with the Java GUI should be 
written to execute what is necessary and then return. 

z	 The methods parseXML, transformXML and generageXML in the Notes objects require the 
org.apache.xerces.* and org.apache.xalan.* classes.  These do not come with the 
Apple JVM.  If these methods are being used in your applications, they should be downloaded 
separately from http://xml.apache.org.  Once downloaded, the jar file(s) containing these classes 
should be placed in /Library/Java/Extensions or in the Notes Bundle in 
Notes.app/Contents/MacOS/jvm/lib/ext. Keep in mind that if copying the jar files to 
Notes.app, you will need to reapply these changes for subsequent upgrades of Notes. 

z	 There is no Java Console in Notes on Macintosh.  To view Java output (in addition to other Notes 
output) use the Console application to view console.log. 

z	 Agents that generate Java GUI are not yet supported 

z	 Background agents that use LS2J do not yet work 

z	 Calling Agent.run() from a Java API program will cause a crash 

z	 The Java infopane in the agent editor is not populated 

z	 On the Notes Standard configuration client, any Notes Preference setting that affects Java startup 
parameters is not honored. This is due to the maclauncher application invoking Eclipse with 
startup parameters, but not looking in the Notes Preferences file for the parameters normally used 
at startup. As a workaround, it is possible to directly edit the ~/Library/Application 
Support/Lotus Notes Data/Expeditor/rcpinstall.properties file. 

z	 Java generates a StackOverFlowException on startup, which can be ignored 

Lotus Notes 

Macintosh: Make Notes Basic client my default e -mail client 
Users cannot set Notes Basic client as their default e-mail client during installation on Macintosh, but can 
make Notes the default e-mail client via the Notes preferences dialog after installation: 

z	 Go to the menu item Lotus Notes -> Preferences -> User Preferences to open the User

Preferences dialog


z	 Go to the tab page Mail -> Internet 

z	 Check the "Use Lotus Notes as my default e-mail program" checkbox 

Lotus Notes 

Right-click will not work if right-double-click is enabled 
Right-click does not work if the "Right double click closes window" option is enabled in the Advanced 
options of the Preferences dialog.  The workaround is to disable the "Right double click closes window" 
option on the Preferences dialog. 
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Lotus Notes 

Some shortcut keys are not supported

The following hotkeys are unsupported:


1.	 Option+F9 does not refresh the view 

2.	 Escape does not close the Workspace tab 

3.	 Command+End and Command+Home do not work 

4.	 Option+Up, Option+Down, Option+Left, and Option+Right do not work 

5.	 Pressing the F2 key does not enlarge the selected text 

6.	 Accelerator keys "N" and "D" do not work on the Print Preview dialog 

7.	 The Command+Z hotkey may not restore deleted characters in the 'Search for' field of the Search

view


8.	 Command+A does not select the content in the formula field when creating a view or a folder 

9.	 In some dialog boxes, choosing Command+?, or the Help button on the keyboard, results in no Help 
page displayed. 

10.	 The Address bar does not support the keyboard "Home" key or "End" key. 

11.	 You cannot use the 'Tab' key or arrow keys to move through an infobox. 

12.	 In a rich text field, the Up and Down keys cannot be used to select a value in the Text Properties 
infobox. 

13.	 Clicking Command +?, or the Help button, will not display a help page in the properties infobox. 

14.	 Windows will not switch normally when pressing keyboard shortcuts ax. 

15.	 The ALT key does not work on Macintosh. The number menu prompted by ALT key does not work on 
Macintosh. 

16.	 Option+B does not open the Open list. 

17.	 Ctrl+F2 does not switch focus to the top menu on the Notes client (basic configuration). 

18.	 Some items cannot be navigated to by pressing Tab key. 

Programming issues 

Lotus Notes 

Path separator issues in formula language /LotusScript 
In versions of Notes for Macintosh before version 7.0.2, filenames were expressed using the colon (:) as a 
path separator.  On OS X, the path separator character is the forward slash ("/").  After Notes 7.0.2, the 
forward slash character is used as a path separator as well.  This can cause some issues when paths are 
used in formula language. 

In Notes for Macintosh, most of the formula language calls will expect and return pathnames with a

forward slash path separator.  If you have legacy code or databases that have pathnames separated by

colons, and try to use them in a formula on Mac OS X that expects forward slashes (for example, 

@Picklist), the formula will fail.


Also, if you try to build a pathname that uses a combination of forward slashes and colons as separators 
in a single path, that will fail. 
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This issue also existed in LotusScript.  If you retrieve a file path from a source outside of LotusScript, for 
example the Directory value in the Notes Preferences file, the FilePath property of a NotesDatabase 
object (for a local database on the Macintosh), or OSGetExecutableDirectory from a C callout to 
libnotes.dylib, you will probably get a path that uses the forward slash as the path separator.  If your 
LotusScript code then constructs a path using this slash-delimited filepath, but uses colons to extend the 
filepath, the result will be a string that is not a valid path, and will cause errors if used in LotusScript 
statements that take a file path parameter. 

For example, if you use the C Callout OSGetExecutableDirectory as follows: 

Declare Sub OSGetExecutableDirectory Lib "libnotes.dylib"  Alias 
"OSGetExecutableDirectory" (Byval mydirname As String) 

Dim FilePath As String*256 
FilePath = "" 
Call OSGetExecutableDirectory(FilePath) 

FilePath will have a value that looks something like 
"/Users/NotesUser/Applications/Notes.app/Contents/MacOS/" 

If the LotusScript code then tries to add on something more like "myExecutables:myfile" using a colon 
path separator, you end up with: 
"/Users/NotesUser/Applications/Notes.app/Contents/MacOS:myExecutables:myfile" which is an invalid 
file name.  This would generate an error if used in an Open statement, for example. 

Also note that if your code tries to parse filenames and assumes a colon separator, it will not function 
correctly when presented with a file path that is separated by forward slashes. 

Note: Paths that that are entirely colon-delimited or totally forward-slash-delimited will work correctly in 
LotusScript functions that expect file paths. 

Note: Some methods on Notes and Domino objects, which are not part of the core LotusScript language, 
may expect only slash-separated paths. 

Roaming user issues 

Lotus Notes, Domino Server 

Connection issues impact replication 
If changes to your roaming data are not roaming from one computer to another, the problem may be due 
to intermittent connection issues that are impacting replication.  Check whether you are receiving 
replication issues and errors on startup. If you are receiving replication errors on the replicator page for 
your roaming data on startup, but you can manually replicate the data, be sure to create a Server 
Connection document. The Server Connection document should resolve the replication issues.  The 
easiest way to create the document is as follows: 

1. From the Notes client, click File - Open - Lotus Notes Application. 
2. Specify the server IP address in the field "Look in." 
3. Save and close the document. 

You should now see that your data is roaming. 
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Lotus Notes, Domino Server 

File server roaming in links mode 
This release note describes issues related only to file server roaming in links mode. 

Roaming policy settings for file server roaming in links mode 
You need to be aware of the following information prior to configuring and using file server roaming in 
links mode.  When you are setting up the roaming policy settings document, in the Roaming Options 
section, use the following settings: 

Field 
Put roaming data on 
Access mode 

Specify 
File Server 
Remote 
Note Do not set the How to Apply value to "Do not 
set value." When you allow the Access mode to be 
changed by users, the Notes client users can 
specify a Local or Remote Access mode on the 
Roaming Preferences panel. The Access mode will 
be changed when the Notes client is shutdown, so 
the client requires a restart for this setting to take 
effect. 

Upgrading the Notes client to file server roaming in links mode 
When you upgrade the Notes client to file server roaming in links mode, the roaming databases are added 
to the replication page. The client replicates once and then removes the roaming databases from the 
replication page after the "upgrade completed" message is generated. 

Restart Notes client after upgrade 
In Links mode, links are created when the Notes client shuts down. Restart the Notes client when 
Upgrade is complete. 

Restart Notes client after downgrading a user status to nonroaming 
When you downgrade a user to nonroaming, the links files are replaced with databases. 
Roamingdata.nsf is removed from the Notes data directory when you downgrade. Restart the Notes client 
to allow the downgrade process to take effect. 

Opening file server while roaming data not available causes client to crash 
When you configure a roaming user for File server roaming in Links mode, the Notes client crashes if you 
open the Notes client while the file server with roaming data is not available. 

Concurrent use of Notes file server roaming is not supported 
If one computer is running the Notes client and using the file server files in Links mode, another computer 
cannot run the Notes client and access those same file server files in Links mode. The second computer 
running Notes client and attempting to access those same files will crash. Concurrent use of Notes file 
server roaming is not supported. 

No indication of lost connection 
If you have file serving roaming with links mode and you lose your connection, no indication of the lost 
connection is provided. Your Notes client may crash when you attempt to access your Personal Address 
Book or other roaming databases. 
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Lotus Notes, Domino Server 

File server roaming issues 
This release note describes issues related only to file server roaming. 

User ID file issues with file server roaming 
When you register a roaming user with the user ID file stored in the Personal Address Book, the ID file 
should automatically be extracted from the Personal Address Book when the Notes client user logs on to 
the Notes client on another computer.This is not working correctly in this Beta software. The ID file is not 
detaching from the Personal Address Book. 

File server roaming users must be provided with their Notes.ID file on portable media such as a diskette 
or CD. They need to have a retrievable copy of their Notes.ID in order to roam to another computer. 

Text you specify in  "Text for the roaming complete dialog " field not displaying correctly 
When upgrade to roaming is complete for a Notes client user and you have specified text in the field "Text 
for the roaming complete dialog" on the roaming policy settings document, that text should display the 
next time the user logs on to the Notes client. This is not working correctly in this Beta build and the text 
you enter does not display the next time the newly upgraded roaming user logs on the Notes client. The 
following text displays: 

"You have now completed the roaming upgrade process.  You are now able to 
roam to other machines." 

Downgrade is generating multiple administration process requests 
This issues applies if one user has multiple computers. If  multiple computers running Notes client 
roaming are downgraded to nonroaming status by removing them from the applied policy for roaming 
users, an additional Administration Process request is generated in the Administration Requests database 
(ADMIN4.NSF) for each of those downgraded computers.  Only one administration process request 
needs to be generated for the downgrade of multiple computers downgraded at the same time. 

Second client may hang on shutdown 
If two Notes clients are set up and the first one is upgraded to file server roaming, when you start the 
second Notes client, a dialog box prompting you to convert your files displays. The prompt indicates that if 
you choose to convert now, the Notes client will shutdown and you will have to restart the Notes client.  If 
you then choose to convert now, the dialog box continues to display, and the Notes client attempts to shut 
down. Another dialog box displays indicating that you have a window open. When you choose OK, the 
client eventually hangs while shutting down, 

Lotus Notes, Domino Server 

Notebook.nsf not replicated to local server after roaming setup 
When you complete the roaming setup for a newly-registered Notes client user, five roaming files should 
be replicated to the local server from the remote server. Open the Home page, and then open the local 
Notebook database. A dialog box displays the following error: 

"Database is not fully initialized yet. (It does not contain any views.) You 
will have to use Replicate on the File - Replication menu to initialize it." 

No personal Notebook item is displayed on the replicator page. You can manually replicate the Notebook 
from the remote server to the local server. 
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Lotus Notes, Domino Server 

Some changes to bookmarks may not roam 
Some bookmark changes made by Notes client users may not roam.  This is an intermittent issue that is 
currently under investigation. 

Lotus Notes, Domino Server 

Upgrading or downgrading a user 's roaming status 
We recommend that you use policies to upgrade or downgrade a user's roaming status.  Using policies to 
define roaming status saves you time and decreases the amount of work involved in setting a user's 
roaming status. Use the roaming policy settings document to define or upgrade a user's status to 
roaming. To downgrade a roaming user to a nonroaming status, simply remove the policy assignment for 
the user you are downgrading. 

Search issues 

Domino Server, Domino for i 

IBM i: Summary information for Domain Search not displayed

Domain Search Results for File Systems are not displaying the Summary information for PDF File Types.  

On IBM i, the name of the PDF files is displayed instead of the Summary information.


Server issues 

Domino for i 

Domino crash from agent .run() with DIIOP on IBM i 6.1 
If a remote Java application creates a DIIOP session with the Domino server on IBM i 6.1, and runs an 
agent via the Lotus.Domino.Agent.run() method, the Domino server may crash. 

Domino for i 

IBM i: CFGDOMSVR with TIMEZONE (*SYSVAL) 
A problem occurs when a Domino server has been setup from i Navigator and you specify *SYSVAL in 
the TIMEZONE field.  When the command is submitted, the process finishes without errors but the 
TIMEZONE value is zero (indicating that the system value was not assigned). 

Workaround:  When you set up a Domino server using the server setup wizard from i Navigator, choose 
any Timezone value except *SYSVAL. 
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Domino for i 

IBM i: Database name with extended characters not displayed 
TM

With IBM i 5.4 and the HTTP (powered by Apache ) Domino plug-in based on WebSphere 6.0.2.3 (PTF 
SI19429), the following error is displayed on the Web browser when attempting to load a URL that 
contains a Domino database name with double-byte or other characters that are not a-z and 0-9 (for 
example, 删除.nsf, Å.nsf or Ë.nsf). 

HTTP Web Server: Unknown Command Exception

[/%E5%88%A0%E9%99%A4.nsf/(/All)?OpenView]  


The same URL/Domino database name is successfully served using Domino HTTP via Domino Web 
Access. 

This issue also occurs with the IBM i 6.1 plugin. 

Domino for i 

IBM i: HTTP crash when same port used by IPV 4/IPV6 
The HTTP task of a server that is configured to use IPV6 will crash if the HTTP port is already in use by 
another server that is configured to use IPV4.  

Workaround 
In the Domino Directory, specify the host name(s) with an IPV4 or IPV6 address, and then enable "Bind to 

host name." 

When you start a Domino server that was configured to use all of the available IPv4 addresses on the 
system (*SYSTEM) and then try to start a Domino server which is configured to use also IPv6, the server 
with IPv6 will crash. This happens because both try to use the 1352 port and the Domino server with IPv6 
also tries to bind to the IPv4 address ports. 

You must solve this issue by correctly assigning and binding specific IPv4 or IPv6 addresses to each 
Domino server. 

Install i 5.4 PTF 5722999 MF42024 to avoid the Domino server crash, but you will still get "the requested 
TCP/IP port is in use on this system", which is correct - you must assign IP addresses correctly as 
mentioned above. 

This applies to any other port in the same circumstances, for example on port 80 for HTTP, etc. 

Domino Server 

Non-English DAOS directory name may be problematic 
Possible multi-byte character issues exist for the DAOS directory name.  As a workaround, use an English 
name, or the default DAOS directory name. 
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Documentation updates 

Notes Client Help 

Lotus Notes 

Application Catalogs help 
The Application Catalogs (titled Portal Applications Catalog) section of the Lotus Notes Help will not be 
included in the online Notes Help. 

To view this section of help, see Lotus Notes 8.5 Beta in the Information Center at the following URL: 

http://infocenters.lotus.com/help7/index.jsp 

Lotus Notes 

Compressing in-line images 
Users can set a Basic Notes Client configuration preference to automatically compress bitmap (.bmp) 
images that are pasted into documents.  When you set this preference, bitmap images that are pasted 
into a Notes document from other applications are compressed and converted to a graphics interchange 
format (.gif) image. 

1. Click File > Preferences. 
2. Click Basic Notes Client Configuration . 
3. Under Additional options, check Compress images pasted into documents . 

Note: This feature supports pasting images from other applications into Notes. It is currently not supported 
for copying/pasting images within the Notes client. 

Lotus Notes 

New drag-and-drop features 
The following table outlines the new drag-and-drop functionality in this release: 

You can drag and drop it into 
Notes rich text selection  (as plain text or rich External applications, Lotus Symphony editor 
text) 
A name from the embedded Sametime contact A name field in a Notes document 
list 
A group from the embedded Sametime contact A name field in a Notes document 
list 
A name from a Notes name field Another Notes names field, or into a different z 

position in the same name field. 

A rich text field in a Notes document or to an externalz 

application 
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You can drag and drop it into 
Text or rich text from an external or Notes Notes text fields 
document 
Notes text fields Another Notes text field or an external application 
Notes rich text from a rich text field in a Notes Another area within the same rich text field or to another 
document rich text field in the same Notes document (currently 

supported on Microsoft Windows only) 
A name from an external application A name field in a Notes document 

Note: You can also double-click in a Names field to select the entire name. 

Domino Administration Help 

Lotus Notes, Domino Server 

Cannot use policy to create server connection document 
The IBM Lotus Domino Administrator documentation contains the topic "NRPC name-to-address 
resolution over TCP/IP" which contains the subtopic "Internal alternatives to DNS." The subtopic contains 
a "Tip" which is incorrect. The "Tip" stated that you can use policies to create a server configuration 
document. That is incorrect. The tip has been removed. The revised subtopic is shown here: 

Internal alternatives to DNS
 If you don't use DNS at your site or if a Domino server is not registered with DNS (as is sometimes the 
case if the server offers Internet services), use one of these methods to enable each Notes workstation 
and Domino server to perform name resolution locally. Keep in mind that the upkeep required for both of 
these approaches is considerable. 

z	 Place a hosts file, which is a table that pairs each system name with its IP address, on every system 
that needs private access. Set up each system so that it accesses the hosts file before accessing 
DNS. 

z	 Create a Connection document that contains the destination server's IP address on every Notes

workstation and Domino server that needs to access that server.


Domino Server 

WebSphere Services DDM probe not available for use 
The IBM Lotus Domino 8.5 Administrator documentation contains information pertaining to the 
WebSphere Services probe. The WebSphere Services probe is not being made available.  Please 
disregard all references to that probe.  The documentation has been changed, and the revised DDM 
topics are shown here: 

Server probes 
There is one server probe subtype -- Administration. Use the Administration probe subtype to monitor 
whether selected administration requests run and to report on any requests that fail. You select the 
administration process requests that are monitored by the probe. After you select administration requests 
in the Probe document, run the administration request as you would any administration request. For each 
reported administration request failure, there is a corresponding error report in the IBM(R) Lotus(R) 
Domino(TM) Domain Monitor database (DDM.NSF). 
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This table contains the names and descriptions of the Server probes that you can define. 

Server Probe name Description 

Server -- Administration Reports any administration process requests 
that fail to run when the request is scheduled 
to do so. 

Creating Server probes 
1. From the IBM(R) Lotus(R) Domino(TM)  Administrator, click the Files tab. 

2. Open the Monitoring Configuration database. 

3. Choose DDM Configuration. 

4. Choose any DDM probe view, and then click New DDM Probe. 

5. Choose Server. 

6. Complete these fields: 

Composite Application Editor Help 

Lotus Notes 

New features for Composite Application Editor 
The following features are new for this release. They are documented in the on-line Help for the 
Composite Application Editor. 

z	 Support for container components that let you rapidly assemble a specific type of application, 
such as a Web application. 

z	 Support for Landmarks that allow you to manage data integration for container components. 

z	 Property Value Editor that allows you to globally update component property values. 

z	 Support for re-ordering wires so they execute in an order that you specify. 

z	 New UI features that provide quicker access to component wiring. 

z	 Support for adding components so they display in the left or right sidebar of the application. 

Lotus Notes 

Wildcard search and replace can produce unexpected results 
Choose Edit -> Property Values to open the Property Value editor.  If you use a wildcard in a 
find-and-replace field, you may get unexpected results.  For example, if you want to replace all URLs in an 
application, you might enter the expression [W:?/]* in the 'Replace' field, and then enter the 
replacement URL in the 'With' field.  This command would paste the URL twice in each field; for example, 
www.myurl.com would be entered as  www.myurl.com www.myurl.com. 

This is because the wildcard * replaces zero or more instances, which is useful if you are putting values 
into a field where there are no existing values, though it can create duplicates if there are existing values.  
To avoid this double entry, enter the wildcard expression like this instead: [W:?/]+ 
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Domino Web Access Help 

Domino Web Access 

Add an external calendar overlay 
The external calendar overlay feature is enabled by default in this Beta release. However, administrators 
should read the release note "Use an HTTP-proxy servlet to restrict URLs to external servers" for 
information about configuring the proxy-config.properties file to allow the use of external servers for this 
feature. 

Users can add an external calendar, such as a Google calendar, to their Domino Web Access calendar.  
From a Calendar view, click Add, and then chose which calendar to add to their calendar. 

Domino Web Access 

Domino Web Access client help not updated 
The Help that displays in Domino Web Access is not fully supported in this Beta release, and has not 
been updated with the new features.  For information on new client features, please refer to the 
Documentation Updates section of these release notes. 

Domino Web Access 

New Web server tell command 
There is a new server console command that allows administrators to replace or update the Domino Web 
Access forms.nsf file without having to restart the Domino server: 

1. Open the Domino server console 
2. Enter the command tell http inotes flushforms
3. Replace or update the forms.nsf file in the lotus/domino/data/inotes directory 
4. When you are notified that a file will be overwritten, type y to confirm 
5. The new or updated file is saved 

Domino Web Access 

Using Quickr with Domino Web Access 
Quickr integration is enabled by default for this Beta release. However, administrators need set up an 
HTTP-proxy servlet and add an entry or entries for the Quickr server(s) in the proxy-config.properties file. 
Note also that if the Quickr server is in the same SSO domain as the Domino server, then LtpaToken 
should be included in the list of allowed cookies in the proxy-config.properties file. For information on 
setting up an HTTP-proxy servlet, see the release note "Use an HTTP-proxy Servlet to restrict URLs to 
external servers" in these release notes. 

For this Beta release, you can perform the following tasks when creating or reading mail: 

z Add a Quickr place using your Domino Web Access user preferences. 
z Insert a Quickr link into an email 
z View Quickr links in messages sent to you 
z Save an attachment in mail you receive to a Quickr place or to a folder in a place. 

To insert a link into a message, from an open message click the Quickr icon , select one or more 
Quickr place documents, and then click Add as links. When you insert a Quickr document link, it has two 
parts: <filename> | Open document summary. 
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When you receive a message that includes a Quickr document link, the link will also have two parts. If it 
has been sent by another Domino Web Access user, it will have the format <filename> | Open document 
summary. If the message was sent from Notes using the Lotus Quickr Connector, the link will include an 
icon. To view a Quickr link document in an e-mail you receive, click the appropriate link. The link to the 
document in the first half requires that connectors are installed. The second link opens a Web page. 

Note: If you have connectors installed, Domino Web Access does not support the connectors preferences 
and place settings. To use those place settings in Domino Web Access, you must configure them using 
Domino Web Access preferences. 

Domino for IBM i Documentation 

Domino for i 

IBM i: C and C++ Application requirements 

C and C++ Application Requirements 

Any applications that use the Domino C or C++ API need to be reviewed to make sure they are properly 

enabled for use with Domino on IBM i.  There are two important considerations: 


z	 Bind to QNOTES/LIBNOTES 
Some applications incorrectly specify a library of *LIBL when binding to the LIBNOTES service 
program.  This can result in incorrect operation in a multi-versioned Domino environment.  
Applications must specify library QNOTES when binding to the LIBNOTES service program in order 
to function correctly in a multi-versioned environment. 

z	 Enable for Teraspace 
When 64-bit support for Domino becomes available, Domino for i5/OS will also change to use the 
i5/OS 64-bit pointer and teraspace support.   To ensure proper operation, applications using the 
Domino C or C++ API must be teraspace-enabled.  This can be accomplished by recompiling the 
application with the teraspace compiler option specified.  This is expected to provide significant 
improvement in Domino i5/OS performance when 64-bit support is introduced.   

For more details, see the following documents: 

Considerations when developing Domino C and C ++ API applications for i 5/OS: 

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21238494 

Domino 7 for i5/OS Application Development Guide  (Chapter 2 - Application Development

Considerations)


http://www.lotus.com/ldd/doc/uafiles.nsf/docs/i5osdom7/$File/apdev400.pdf 

For information on Domino 64-bit plans, see this document: 

http://www-1.ibm.com/support/docview.wss?rs=463&context=SSKTMJ&dc=DB520&uid=swg212 
33872&loc=en_US&cs=UTF-8&lang=en&rss=ct463lotus 
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Domino Server, Domino for i 

IBM i: CFGDOMSVR maximum length of DOM and ORG keywords 
When configuring a Domino server using the CFGDOMSVR CL command, the maximum length of the 
following keyword values are changed as follows: 

Keyword Maximum length 
Organization (ORG) 63 

Domain (DOM)  31 

Domino for i 

IBM i: CFG/CHGDOMSVR TIMEZONE and DAYSAVTIME keywords 
The CL commands CFGDOMSVR and CHGDOMSVR that are used to configure Domino servers on 
System i are changed to incorporate support for the system value QTIMZON that was introduced in 
V5R3. 

CFGDOMSVR 
The Configure Domino Server (CFGDOMSVR) CL command is used to set up either a first Domino 
server or an additional Domino server. It is also used to remove an existing Domino server. 

CHGDOMSVR 
The Change Domino Server (CHGDOMSVR) CL command changes the configuration of an existing 
Domino server. You can use this command to change specific characteristics or to add features that 
were not included in the original server configuration.                                    

The TIMEZONE keyword of the CFGDOMSVR command is modified to accept a new value *SYSVAL 
which is the new default value.   

TIMEZONE-Specifies the time zone to be used by the Domino server. The possible values are: 

*SYSVAL 
Specify the Timezone for this Domino Server based on QTIMZON system value.        

time-zone 
Specify a new value for the time zone (GMT, ZW1, et. al.).                        

The DAYSAVTIME keyword of the CFGDOMSVR command is modified to accept a new value 
*TIMEZONE. 

DAYSAVETIME Specifies whether the server time stamp should be adjusted for Daylight Savings 
Time.  This value does not affect the actual system time.  The possible values are: 

*YES 
Adjust the time stamp for Daylight Savings Time.                   

*NO 
Do not adjust the time stamp for Daylight Savings Time.            

*TIMEZONE 
Adjust the time stamp for Daylight Savings Time according to the Timezone system value. 

Note: *TIMEZONE cannot be specified here if *SYSVAL is not specified on the TIMEZONE 
parameter 

Similar values are accepted on the CHGDOMSVR CL command, along with the *SAME keyword.   

Refer to each command's Help Text for additional information and usage details. 
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Domino for i 

IBM i: Daylight Savings Time changes 
The United States and parts of Canada are extending the period of Daylight Savings Time (DST), 
beginning in 2007.  From 2007 onward, DST will commence on the second Sunday in March (three weeks 
earlier than previously), and end on the first Sunday in November (a one week extension).  For detailed 
information about these changes, and how they affect Notes and Domino, please see technote 
#21247972 at the following URL: 

http://www.ibm.com/support/docview.wss?rs=899&uid=swg21247972 

In addition, you can refer to the following Web page for additional information that pertains to DST on IBM 
i. 

http://www-03.ibm.com/systems/i/software/domino/dst2007.html 

Domino Server, Domino for i 

IBM i: How to obtain additional spell-check dictionaries
  Lotus Domino for i installs four of the most common spell-check dictionary files for use with Domino: 

z canadien.dic 

z uk.dic 

z us.dic 

z wpdic.dic 

Additional dictionary files may be obtained from the dictions.exe file of the Domino 8 or 8.5 for i 
physical CD or Web kit. For more information, including instructions on how to install, refer to Chapter 20 
of the Installing and Managing Domino 8 for System i Help documentation, in the topic "Language 
Dictionary Files".  

In prior releases, customers were directed to obtain the additional dictionaries from the Notes client CD.  
However, with Domino 8 and later releases,  the server dictionary support has been upgraded, and is no 
longer consistent with the client dictionary versions. 

Domino for i 

IBM i: Parallel save capability with BRMS and i  5.4 
BRMS has extended the parallel save and restore capability to the Integrated File System (IFS) with i 5.4.  
Domino users of BRMS may want to investigate whether this new capability will help to minimize their 
Domino backup window. 

Use the Work with Backup Control Groups (WRKCTLGBRM) CL command and specify option 8 (Change 
Attributes) for the QLTSSVR (or your own) control group to change the Parallel device resources from 
"*NONE" to '2', or more, parallel devices.   

If parallel backup is selected, then BRMS is required on the restore operation. 

Customers who run concurrent backups with Domino servers may already be minimizing the save time, if 
the servers consume approximately the same storage.   

For more information on this feature, refer to the BRMS Web page at the following URL:  

http://www-03.ibm.com/servers/eserver/iseries/service/brms/domino.html 
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Domino for i 

IBM i: Retrieve Domino Server Attributes API 
The Retrieve Domino Server Attributes  (QnninRtvDominoServerAttr ) API is used to retrieve specific 
information about each Domino server.  This API program retrieves all of the information provided by 
QnninRtvDominoServerI, plus additional information based on the format name.  It is modified in 
Domino 8 to additionally retrieve IPv6 information. 

Retrieve Domino Server Attributes  (QnninRtvDominoServerAttr ): 
Required Parameter Group: 

1 Data buffer for Domino server information O Char(*) 
2 Data buffer length I Binary(4) 
3 Server name I Char(255) 
4 Server name length I Binary(4) 
5 Format name I Char(8) 
6 Error Code I/O Char(*) 

Service Program Name: QNNINLDS 
Similar Commands: None 

Authorities and Locks 
Default public authority 

*USE 

Required Parameter Group 
Data buffer for Domino server information 

OUTPUT; CHAR(*) 
This returns the information about a specific Domino server. For the format, see "Data Buffer". 

Data buffer length 
INPUT; BINARY(4) 
The length of the data buffer. The length must be at least big enough to hold the Bytes returned field 
and Bytes available field. Failure to provide enough room for the data will result in errors or 
incomplete data being returned. 

Server name 
INPUT; CHARACTER(255) 
The name of the Domino server to retrieve information. This is a blank padded field. If the server 
name was 10 characters long, then there would be 245 blanks following the server name. 

Server name length 
INPUT; BINARY(4) 
The length of the server name including the blanks. It should always be 255. 

Format name 
INPUT; CHARACTER(8) 
The name of the format used to retrieve different Domino server attributes. You can use the following 
format names: 
DATR0100, DATR0200 

Error code 
I/O; CHAR(*) 
The structure in which to return error information. For the format of the structure, see Error Code 
Parameter. If this parameter is omitted, diagnostic and escape messages are issued to the 
application. 

Data Buffer 
For detailed descriptions of the fields in these tables, see Field Descriptions. 
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DATR0100 Attribute Buffer

   Offset Dec Offset Hex Type Field 
0 0 Binary(4) Bytes returned 
4 4 Binary(4) Bytes available
8 8 Binary(4) Primary type of Domino server
12 C Binary(4) Secondary type of Domino server
16 10 Binary(4) Number of active jobs in the subsystem
20 14 Binary(4) Offset to data directory path
24 18 Binary(4) Length of data directory path
28 1C Binary(4) Offset to executable directory path
32 20 Binary(4) Length of executable directory path
36 24 Character(20) Subsystem description
56 38 Character(10) Library name
66 42  Binary(1) Server status
67 43  Binary(1) Auto-Start with TCP/IP Servers
68 44  Binary(4) Partition Number
72 48  Binary(4) Offset to generic information
76 4C  Binary(4) Length of generic information
80 50  Character(16) Server release
* * Character(*) Variable data

DATR0200 Attribute Buffer

   Offset Dec Offset Hex Type Field 
0 0 Binary(4) Bytes returned 
4 4 Binary(4) Bytes available
8 8 Binary(4) Primary type of Domino server
12 C Binary(4) Secondary type of Domino server
16 10 Binary(4) Number of active jobs in the subsystem
20 14 Binary(4) Offset to data directory path
24 18 Binary(4) Length of data directory path
28 1C Binary(4) Offset to executable directory path
32 20 Binary(4) Length of executable directory path
36 24 Character(20) Subsystem description
56 38 Character(10) Library name
66 42  Binary(1) Server status
67 43  Binary(1) Auto-Start with TCP/IP Servers
68 44  Binary(4) Partition Number
72 48  Binary(4) Offset to generic information
76 4C  Binary(4) Length of generic information
80 50 Character(1) Log replication events
81 51 Character(1) Log client session events
82 52 Character(1) DOLS enabled
83 53 Character(1) Day light savings time enabled
84 54 Character(6) Time zone
90 5A  Character(10) Collation sort order
100 64  Character(11) SMTP type
111 6F  Character(1) Directory type
112 70  Character(1) Service provider configuration
113 71  Character(3) Reserved
116 74  Binary(4) Offset to organization name



IBM Lotus Notes, Domino, Domino Designer 8.5 Beta 1 Release Notes 

DATR0200 Attribute Buffer (cont'd) 

Offset Dec Offset Hex Type Field 
120 78  Binary(4) Length of organization name 
124 7C  Binary(4) Offset to web browser list, 

List Type 1 
128 80  Binary(4) Offset to News Readers List 

List Type 1 
132 84  Binary(4) Offset to Mail services List 

List Type 1 
136 88  Binary(4) Offset to Advanced services List 

List Type 1 
140 8C  Binary(4) Offset to Connection Services List 

List Type 1 
144 90  Binary(4) Offset to Directory Services List 

List Type 1 
148 94  Binary(4) Offset to Additional Services List 

List Type 1 
152 98  Binary(4) Offset to TCP Info List 

List Type 2 
156 9C  Binary(4) Offset to canonical name 
160 A0  Binary(4) Length of canonical name 
164 A4  Binary(4) Offset to server title 
168 A8  Binary(4) Length of server title 
172 AC  Binary(4) Offset to server host name 
176 B0  Binary(4) Length of server host name 
180 B4  Binary(4) Offset to domain name 
184 B8  Binary(4) Length of domain name 
188 BC  Binary(4) Offset to administrator(s) name(s) 
192 C0  Binary(4) Length of administrator(s) name(s) 
196 C4  Character(16) Server release 
* *  Character(*) Variable data 

Field Descriptions 

Auto - Start with TCP/IP servers: This is a flag that indicates if the server will be started automatically 
when TCP/IP is started on the system. 

z 0 - The server will not be started with TCP/IP 
z 1 - The server will be started with TCP/IP 

Bytes available: The length of data that could be returned by this API. This value is greater than "Bytes 
returned" when the length of the receiving variable is too small, causing truncation of data. 

Bytes returned: The length of data returned in this structure. This value includes this and all following 
fields. If the data is truncated because the receiver variable is not large enough to hold all of the data 
available, this value will be less than the bytes available value. 
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Collation sort order : This field indicates which way the Domino server will sort characters.  The possible 
values are: 

*SAME HU Hungarian RU Cyrillic 
*STD Standard IS Icelandic SK Slovak 
CS Czech IT Italian SL-SI Slovenian 
DA-DK-AA Nordic 2to1 JA Japanese SQ-AL Albanian 
DE German KO Korean SV Swedish 
E2-ES Spanish - Modern LT Lithuanian TH Thai 
EL Greek LV Baltic TR Turkish 
EN Latin1                      NL Dutch ZH-CN Simplified Chinese 
ES Spanish - Traditional NO  Nordic ZH-TW Traditional Chinese 
ET-EE Estonian collation PL Latin2 
FI Finnish PL-PL  Polish
 FR French PT Portuguese
 HR Croatian RO Romanian 

Directory Type: This is a flag that indicates if the server is configured as a central directory or a 
config-only directory. The possible values are: 

z '1' - Central Directory 
z '2' - Config-Only Directory 

DOLS enabled: This is a flag that indicates if the server is enabled for Domino Offline Support (DOLS). 
The possible values are: 

z '0' - Not enabled for DOLS 
z '1' - Enabled for DOLS 

DST: This is a flag that indicates if the server is configured for Daylight Savings Time (DST). The possible 
values are: 

z '0' - Not configured for DST 
z '1' - Configured for DST 

Length of administrator name : This is the length of the data in the administrator name. 

Length of canonical name : This is the length of the data in the canonical name. If length is equal to 0 
(zero) then no canonical server name is available. Example of canonical server name:  

CN=MYSERVER/OU=SALES/O=ORG1/C=US


Length of data directory path : This is the length of the data in the data directory path. 


Length of domain name : This is the length of the data in the domain name (1-32).


Length of executable directory path : This is the length of the data in the executable directory path. 


Length of generic information : This is the length of the data in the generic information. 


Length of organization name : This is the length of the data in the organization name (1-64). 


Length of server host name : This is the length of the data in the server host name (0-255). If length is

equal to 0 (zero) then no server host name is available.


Length of server title : This is the length of the data in the server title (0-60). If length is equal to 0 (zero) 
then no server title is available. 
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Library name: This is the library name of the run time programs. 

Log client session events : This is a flag that indicates if client session events should be logged. The 
possible values are: 

z '0' - Do not log client session events 
z '1' - Log client session events. 

Log replication events : This is a flag that indicates if replication events should be logged. The possible 
values are: 

z '0' - Do not log replication events 
z '1' - Log replication events. 

Number of active jobs in the subsystem : This is the number of active jobs in the subsystem associated

with this Domino server. If the Domino server is currently not running this value will be 0. If a -1 is returned 

then the number of active jobs running in the subsystem could not be determined. If a -1 is returned there 

is a diagnostic message written that gives some more information on why this information could not be

retrieved. 


Offset to administrator name : This is the offset, from the start of the returned data, to where the 

administrator name can be found.  It will be somewhere within the variable data portion of the returned

data.


Offset to advanced services list : This is the offset, from the start of the returned data, to the list of

advanced services of the server. This list is in List Type 1 format.  See below for the description of the List

Type 1 format;


Offset to canonical name : This is the offset, from the start of the returned data, to where the canonical

name can be found. It will be somewhere within the variable data portion of the returned data.


Offset to connection services list : This is the offset, from the start of the returned data, to the list of

connection services of the server.  This list is in List Type 1 format.  See below for the description of the

List Type 1 format;


Offset to data directory path : This is the offset, from the start of the returned data, to where the data 

directory path can be found. It will be somewhere within the variable data portion of the returned data. 


Offset to directory services list : This is the offset, from the start of the returned data, to the list of directory

services of the server.  This list is in List Type 1 format.  See below for the description of the List Type 1 

format;


Offset to domain name: This is the offset, from the start of the returned data, to where the domain name

can be found. 

It will be somewhere within the variable data portion of the returned data.


Offset to executable directory path : This is the offset, from the start of the returned data, to where the 

executable directory path can be found. It will be somewhere within the variable data portion of the

returned data. 


Offset to generic information : This is the offset, from the start of the returned data, to where the generic 

configurat information can be found.  It will be somewhere within the variable data portion of the returned

data. 


Offset to mail services list : This is the offset, from the start of the returned data, to the list of internet mail

packages of the server.  This list is in List Type 1 format.  See below for the description of the List Type 1 

format;
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Offset to news readers list : This is the offset, from the start of the returned data, to the list of news readers

of the server.  This list is in List Type 1 format.  See below for the description of the List Type 1 format;


Offset to organization name : This is the offset, from the start of the returned data, to where the 

organization name can be found.  It will be somewhere within the variable data portion of the returned

data.


Offset to server host name : This is the offset, from the start of the returned data, to where the server host

name can be found. It will be somewhere within the variable data portion of the returned data.


Offset to server title : This is the offset, from the start of the returned data, to where the server title can be

found. 

It will be somewhere within the variable data portion of the returned data.


Offset to TCP/IP information list : This is the offset, from the start of the returned data, to the list of TCP/IP 

port information of the server.  This list is in List Type 2 format.  See below for the description of the List

Type 2 format;


Offset to web browsers list : This is the offset, from the start of the returned data, to the list of web browser

features of the server.  This list is in List Type 1 format.  See below for the description of the List Type 1 

format;


Partition Number: The internal partition number used by the Domino server to identifiy itself within a

partitioned server environment.


Primary type of Domino server : This is the type of Domino server. The possible values are: 


z 0 - Unknown Domino server type 
z 1 - Domino server 
z 2 - Stand alone QuickPlace server 
z 3 - Stand alone SameTime server 

If the server type is a Domino server, you may need to check the Secondary type of Domino server field to 
see if there are other capabilities of the server. 

Secondary type of Domino server : This Domino server also has these additional capabilities. The 
possible values are: 

z 0 - No additional capabilities. 
z 1 - Also a QuickPlace server 
z 2 - Also a SameTime server 
z 3 - Also a QuickPlace AND SameTime server 

This field is only valid if the Primary type of Domino server field indicates a Domino server. 

Service provider configuration : This is a flag that indicates if the Service Provider Configuration (XSP) is 
enabled in the server. The possible values are: 

z '0' - XSP not enabled 
z '1' - XSP Enabled 

Server release: This is the release of the server in the format VRM. Example of a server release: 8.0.0 
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Server status: This is the current status of the server. The possible values are: 

z 1 - Server ended 
z 2 - Server started 
z 3 - Server starting 
z 4 - Server ending 
z 5 - Server in standby mode 
z 99-Server in unknown status 

SMTP Type: This field indicates how the Domino server supports SMTP mail.  The possible values are: 

*MSF AS/400 SMTP server in combination with the AnyMail/400 Mail Server Framework (value 
is obsolete) 
*DOMINO Built-in Domino SMTP 
*QUICKPLACE Built-in QuickPlace SMTP (QuickPlace servers only) 

Subsystem description : This is the name of the subsystem description used for this Domino server. The 
first 10 bytes of the data will be the subsystem description name and the next 10 bytes will be the library 
name where the subsystem description can be found. 

Time Zone: This field indicates what time zone the server is configured for.  The possible values are: 

GMT Greenwich Mean Time BST Bering Standard Time HST Alaska-Hawaii 
Standard Time 
ZW1 1 hour West of GMT ZW12  12 hours West of GMT ZE6B 6 1/2 hours 
East of GMT 
ZW2 2 hours West of GMT ZE12C 12 3/4 hours East of GMT ZE6 6 hours East 
of GMT 
ZW3 3 hours West of GMT ZE12 12 hours East of GMT ZE5C 5 3/4 
hours East of GMT 
NST Newfoundland Standard Time ZE11B 11 1/2 hours East of GMT ZE5B 5 1/2 hours 
East of GMT 
AST Atlantic Standard Time ZE11 11 hours East of GMT ZE5 5 
hours East of GMT
 EST Eastern Standard Time ZE10B 10 1/2 hours East of GMT ZE4B 4 1/2 hours 
East of GMT 
CST Central Standard Time ZE10 10 hours East of GMT ZE4 4 
hours East of GMT 
MST Mountain Standard Time ZE9B 9 1/2 hours East of GMT ZE3B 3 1/2 hours 
East of GMT 
PST Pacific Standard Time ZE9 9 hours East of GMT ZE3 3 hours East 
of GMT 
YST Yukon Standard Time ZE8 8 hours East of GMT ZE2 2 hours East 
of GMT 
ZW9B 9 1/2 hours West of GMT ZE7 7 hours East of GMT CET Central 
European Time 

Variable Data: This is the start of the variable data field. Use the offset and length fields to actually find 
and retrieve data from this area. 

List Formats 

List Type 1 

Offset Dec Offset Hex Type Field 
0 0 Binary(4) Number of Items in List 
4 4 Binary(4) Length of each item 
* * Character(*) Items in the list 
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List Type 2 

Offset Dec Offset Hex Type Field 
0 0 Binary(4) Number of Items in List 
* * Character(*) TCP/IP list items in TCP List Format 

TCP List Format 

Offset Dec Offset Hex Type Field 
0 0 Binary(4) OffsetToNext Item 
4 4  Character(17) IPv4 Address 
21 15  Character(1) Port Enabled 
22 16  Character(10) Port Encrypted 
32 20  Binary(4) Offset To Port Name 
36 24  Binary(4) Length of Port Name 
40 28  Binary(4) Offset To Network Name 
44 2C  Binary(4) Length of Network Name 
48 30  Character(1) Port Compression 
49 31  Character(1) Type of Remote system information 
50 32  Character(2) Reserved 
52 34  Binary(4) Offset To Remote system information 
56 38  Binary(4) Length of Remote system information 
* *  Character(*) Variable data 

TCP List Format Field Descriptions :


IPv4 address: This is the IPv4 address for this Domino Server Port.  It is blank if an IP host name or IPv6 

address is available.


Length of Network Name : This is the length of the Network Name data.


Length of Port Name: This is the length of the port name data.


Length of Remote system information : This is the length of the IP host name data, IPv4 address, or IPv6 

address.


Offset to Network Name : This is the offset, from the start of this list element, to where the network name 

can be found.


Offset to next item: This is the offset, from the start of the first element in the list, to where the next 

element can be found.


Offset to Port Name: This is the offset, from the start of this list element , to where the port name can be 

found.


Offset to Remote system information : This is the offset, from the start of this list element, to where the IP

host name, IPv4 address, or IPv6 address can be found.


Port Compression: This indicates if the data sent through the port is compressed. Possible values are;


z '0' - Data is not compressed. 
z '1' - Data is compressed. 
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Port Enabled: This is a flag that indicates if this Domino Server Port is enabled.  Possible values are; 

z	 '0' - Server port not enabled. 
z	 '1' - Server port is enabled. 

Port Encrypted: This indicates if the data sent through the port is encrypted.  Possible values are; 

z *ENCRYPT

z *NOENCRYPT


Reserved: This is a reserved field. 

Type of Remote system information : This indicates the type of address the Remote system information 
variable field contains for this Domino Server Port. Possible values are: 

z	 ‘1’ – “Remote system information” field contains an IPv4 address. 
z	 ‘2’ – “Remote system information” field contains an IPv6 address. 
z	 ‘3’ – “Remote system information” field contains the host name for this port. 

Variable Data: This is the start of the variable data field. Use the offset and length fields to actually find

and retrieve data from this area. 


Error Messages

CPF24B4: Severe error while addressing parameter list.

CPF3CF1: Error code parameter not valid

CPF3CF2: Error(s) occurred during running of &1 API.

CPF3C1E: Required parameter &1 omitted.

CPF3C21: Format name &1 is not valid.

CPF3C24: Length of the receiver variable is not valid.

LNT0907: The server name specified, &1, is not valid.


Domino for i 

IBM i: System Value QLOGOUTPUT

i 5.4 introduced a new system value - QLOGOUTPUT (Job Log output).  This affects Domino servers / 

jobs as follows:


z	 Each Domino server runs in a separate subsystem.  The subsystem name is specified on the 
CFGDOMSVR command; the default is DOMINOxx, where xx is a number.  The WRKDOMSVR 
command shows the subsystem name.  

z	 Information for Subsystem is stored in the library QUSRNOTES 

z	 Each subsystem has a Job Description (JOBD)  used when submitting jobs to a system 

z	 To view JOBD: Enter the command WRKJOBD JOBD(QUSRNOTES/*ALL) 

z	 One of the parameter of JOBD is Job log output  , Keyword LOGOUTPUT: 

z	 When a job completes, one of three actions occur that affects how the job log is created. 
The following are values of the LOGOUTPUT parameter: 

z	 The job log server produces the job log: (*JOBLOGSVR) 

z	 The job itself produces the job log; if the job cannot produce its own job log, the job 
log will be produced by a job log server. (*JOBEND) 

z	 The job log is not produced; the job log remains in pending until it is removed. 
(*PND) 
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z	 If LOGOUTPUT is set to *SYSVAL, the job uses the job log output value that is specified in 
the Job log output (QLOGOUTPUT) system value. 

z	 The shipped value for the Job log output (QLOGOUTPUT) system value is *JOBEND; the 
recommended value is *JOBLOGSVR. 

Additional information on JOBD and the QLOGOUTPUT can be found at: 

http://publib.boulder.ibm.com/iseries/ 

z	 Select V5R4 
z	 Search on qlogoutput 

Domino for i 

IBM i: Use of the forward slash "/" character 
When issuing Domino console commands on IBM i, be aware of the command syntax and use of the 
forward vs. backward slash.  For example, you may see the backward slash character "\" used to delimit 
directory and file names in general use examples.  On IBM i, use the forward slash "/" character. 

Domino for i 

IBM i: Using i Navigator tasks on the Web 
Overview 
System i Navigator is the user interface of choice for many IBM i administrators, system operators, and 
end users. This Windows-based GUI, which is a part of the System i Access for Windows product, gives 
administrators an easy-to-use, Windows-based interface for managing key i resources. 

However, in order to use System i Navigator, you must have the System i Access for Windows product 
installed, both on the System i and your PC. What if you are home or away from your primary PC at work, 
and you would like to perform some quick System i Navigator task. Maybe you need to check the system 
operator's message queue to make sure there are no messages needing a response before work can 
continue. Or you might need to check the status of a particular job that is currently running, or make sure 
a key piece of printer output is moved to the top of its print queue so it can be printed immediately. Well, 
with Domino 8 and i 5.4 or a later release, you can perform these and many other tasks, even though you 
are away from your main work PC!  All you need is a browser and access to the desired System i system. 

This browser support is provided with a feature called System i Navigator tasks on the Web. System i 
Navigator tasks on the Web allows you to perform a subset of System i Navigator tasks through an 
Internet Web browser.  The interface may look slightly different, but the tasks you can perform are the 
same as when using System i Navigator Windows interface.  

Administration of Domino servers from System i Navigator tasks on the Web is supported with i 5.4 or i 
6.1. This feature, allows you to perform most of the same tasks that you can perform when using the 
Domino plug-in for System i Navigator Windows interface, but from a browser. 

The System i Navigator Web interface for Domino differs from the System i Navigator Windows interface 
for Domino in that it is shipped with IBM i, whereas  the System i Navigator Windows interface for  Domino 
is shipped as a System i Navigator plug-in as part of the Domino for i product. Therefore, there is no need 
for any update operation to run on the client in order to get a newer version of the System i Navigator Web 
interface for Domino.  Whenever you update to a new IBM i OS level, you get the latest version of the 
System i Navigator Web interface for Domino. 

The Domino Plugin version that is provided with i 5.4 and i 6.1 is Domino release 8.0. 
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Domino releases suppor ted with i 5.4 and i 6.1 

z Domino 6.5.x 
z Domino 7.0.x 
z Domino 8.0.x 
z Domino 8.5 

Languages supported 
z English 

Browsers supported 

z Microsoft Internet Explorer 6.0 
z Mozilla 1.7 
z Firefox 1.0.2 

Initial setup steps 

Release Notes 

To administer Domino servers using System i Navigator tasks on the Web, you need at least one system 
at either i 5.4 with SP3 (or later) or i 6.1 that has the following products installed: 

i 5.4 i 6.1 
5722SS1 Option 3 Extended Base Directory 

Support 
5761SS1 Option 3 Extended Base Directory 

Support 
5722SS1 Option 12 Host Servers 5761SS1 Option 12 Host Servers 
5722SS1 Option 30 Qshell 5761SS1 Option 30 Qshell 
5722DG1 IBM HTTP Server 5761DG1 IBM HTTP Server 
5722JV1 IBM Developer Kit for 

Java 
5761JV1 IBM Developer Kit for 

Java 
5722JV1 Option 6 Java Developer Kit for 1.4 

for Domino 6 and 7 
5761JV1 Option 6 Java Developer Kit for 1.4 

for Domino 6 and 7 
5722JV1 Option 8 J2SE 5.0 32 bit 

for Domino 8 
5761JV1 Option 8 J2SE 5.0 32 bit 

for Domino 8 

Required i 5.4 PTFs: 

z 5722SS1 Option 3  PTF SI24255 
z	 5722DG1 Group PTF SF99114 Level 6 or later 

Prior to applying the V5R4 5722DG1 SF99114 Level 6 PTF(s),  end the following servers:   

IBM Help Server ENDTCPSVR *IBMHELP 
ADMIN HTTP Server ENDTCPSVR *HTTP HTTPSVR(*ADMIN) 
DDM Server ENDTCPSVR *DDM 
LDAP Server ENDTCPSVR *DIRSVR 

Note: You do not need the Domino product installed on the same IBM i system that has the System i 
Navigator tasks for the Web support installed.  From any i system that has the Web support installed, 
Domino servers on any i system in the network can be managed. Also, any supported release of Domino 
for i can be administered using this Web interface. 
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Before users can access System i Navigator tasks on the Web, the system administrator needs to modify 
the HTTP Administration server configuration to automatically start the system application server 
instance. This special "system instance" must be configured and started before the System i  Navigator 
Web application can function. To do this, the system administrator needs to perform these tasks: 

1.	 Start the HTTP Administration server if it is not already started

> STRTCPSVR SERVER(*HTTP) HTTPSVR(*ADMIN) 


2. Go to the HTTP Administration Web page: http://<system>:2001/HTTPAdmin (where <system> is 
the System i host name). 
3.	 Click on the "Manage" tab 
4.	 Click on the "HTTP Servers" tab, then select "ADMIN - Apache" from the Server list 
5.	 Click on "General Server Configuration" in the left pane of the current page 
6.	 Specify "Yes" for "Start the system application server instance when the 'Admin' server is started" 
7.	 Specify "Yes" for "Stop the system application server instance when the 'Admin' server is stopped 

" 
8.	 Click the "Apply" button 
9.	 Stop, then start the HTTP Administration server so these configuration changes take effect 

Once this "one time" configuration change is made to the HTTP Administration server, and the server is 
restarted, users will be able to access System i Navigator tasks on the Web. 

Note: For i 6.1 systems you do not need to modify the HTTP Administration server configuration manually 
because the system application server instance would be started automatically when the 'Admin' server is 
started. 

Note: For more information on how to set up this Web environment on your system, see the IBM iSeries 
V5R4 Information Center : 

http://publib.boulder.ibm.com/infocenter/iseries/v5r4/index.jsp?lang=en 

or the System i V6R1 Information Center: 

http://publib.boulder.ibm.com/infocenter/systems/scope/i5os/index.jsp 

After you have set up System i Navigator tasks on the Web, all you need on your PC is a Web browser 
that connects to the Internet and you can begin working with the Domino tasks by clicking View All Tasks 
and selecting the Network tab. 

Also, you do not need to worry about learning a new interface for these Web tasks. The exact same code 
and user interface that are used within System i Navigator on the client are also used on the Web.  So, for 
example, if you're already familiar with the System i Navigator for Windows panel that appears when you 
select the "properties" action of a Domino server, you will see the exact same interface when you select 
"properties" of a Domino server on the Web. 

You can also create your own URL that points to the Domino tasks on the Web, as well as other System i 
Navigator tasks on the Web, by using the URL Advisor. To use the URL Advisor, visit the following URL 
from a Web browser: 

http://<hostA>:<port>/webnav/WnServlet?task=home 

where: 

<hostA> is the System i host name. 
<port> is the HTTP port number set up with System i Navigator Web interface. 

Click Create a URL... to create the URL for the Domino tasks on the Web. 
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Working with the Domino tasks on the Web 
Not all Domino operations that are available with the System i Navigator Windows interface are allowed in 
the Web interface. The following table shows the Domino operations that can be performed using the 
Web interface to Domino servers that reside in the network, and the special authorities needed for the 
user profile performing them: 

Special 
Operations Authorities Steps to follow 

needed 

Change the 
properties of a 
Domino server 

*ALLOBJ 
*JOBCTL 
*SECADM 
*IOSYSCFG 

To change the properties of a Domino server: 
1. Locate the system where the Domino server resides. 
2. Select Network. 
3. Select Domino Servers. 
4. Click the pop menu from a Domino server in the server list 

and select Properties. 
5. Change any of the properties of the Domino server and click 

OK. 

Delete a 
*ALLOBJ 
*JOBCTL 

To delete a Domino server from a system: 
1. Locate the system where the Domino server resides. 
2. Select Network. 

Domino server *SECADM 3. Select Domino Servers. 
*IOSYSCFG 4. Click the pop menu from a Domino server in the server list 

and select Delete. 
To start a Domino server, controller, or both on a system: 

1. Locate the system where the Domino server resides. 
2. Select Network. 
3. Select Domino Servers. 

Start Domino 

4. Click the pop menu from a Domino server in the server list. 
5. Click Start and select one of the following: Server, Controller 

or Server and Controller . 
servers or *JOBCTL 
controllers To start all existing Domino servers, controllers, or both on a system: 

1. Locate the system where the Domino servers reside. 
2. Select Network. 
3. Select Domino Servers. 
4. In Select Action, select one of the following: Start > All 

Servers, Start > All Controllers or Start > All Servers and 
Controllers. 

To stop a Domino server, controller, or both on a system: 
1. Locate the system where the Domino server resides. 
2. Select Network. 
3. Select Domino Servers. 

Stop Domino 
servers or *JOBCTL 

4. Click the pop menu from a Domino server in the server list. 
5. Select Stop and click one of the following: Server, Server 

Immediately, Server and Controller  or Server and Controller 
Immediately. 

controllers To stop all existing Domino servers, controllers, or both on a system: 
1. Locate the system where the Domino servers reside. 
2. Select Network. 
3. Select Domino Servers. 
4. In Select Action, select one of the following: Stop > All 

Servers, Stop > All Servers and Controllers , Stop > All 
Servers Immediately or Stop > All Servers and Controllers 
Immediately. 
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Special 
Operations Authorities Steps to follow 

needed 
To launch WebAdmin.nsf: 

Launch 
WebAdmin.nsf *JOBCTL 

1. Locate the system where the Domino server resides. 
2. Select Network. 
3. Select Domino Servers. 
4. Click the pop menu from a Domino server in the server list 

and select Server Administration . 
5. Specify the HTTP port and click OK. 

Add a Domino 
Application 

*ALLOBJ 
*SECADM 
*IOSYSCFG 

To add a Domino Application to a Domino server: 
1. Locate the system where the Domino server resides. 
2. Select Network. 
3. Select Domino Servers. 
4. Click the pop menu from a Domino server in the server list 

and select Add Application. 

Usage notes: 
The Domino server must already be set up on the system.z 

The licensed program and option being added must bez 

installed on the system. 
To add QuickPlace or Sametime to a Domino server: 

Add QuickPlace 
or Sametime to 
a Domino 
server 

*ALLOBJ 
*JOBCTL 
*SECADM 
*IOSYSCFG 

1. Locate the system where the Domino server resides. 
2. Select Network. 
3. Select Domino Servers. 
4. Click the pop menu from a Domino server in the server list 

and select either of the following: Add QuickPlace or Add 
Sametime. 

To remove QuickPlace or Sametime from a Domino server: 
Remove 
QuickPlace or 
Sametime from 
a Domino 
server 

*ALLOBJ 
*JOBCTL 
*SECADM 
*IOSYSCFG 

1. Locate the system where the Domino server resides. 
2. Select Network. 
3. Select Domino Servers. 
4. Click the pop menu from a Domino server in the server list 

and select either of the following: Remove QuickPlace or 
Remove Sametime. 

To view the active jobs related to the Domino servers on a system: 
View the active 1. Locate the system where the Domino servers reside. 
jobs related to 
the Domino *NONE 2. Select Network. 

3. Select Domino Servers. 
servers 4. In Select Action, select Domino Jobs. The jobs are displayed 

in a new window, sorted by subsystem. 
To see the version of the Domino plug-in that you are using: 

Display the 1. Locate the system where the Domino server resides. 
Domino plug-in *NONE 2. Select Network. 
version 3. Select Domino Servers. 

4. In Select Action, select Display Plugin Version . 
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Special

Operations
 Authorities Steps to follow 

needed 
To work with existing Domino servers on a system: 

1. Locate the system where the Domino servers reside. 
2. Select Network. 
3. Select Domino Servers. 
4. The Domino servers list appears in a new window. You must have 
5. Click the pop menu from a Domino server of your choice toat least one of 

bring up a context menu where you can select differentthe following: 
operations to apply to the Domino server. Ability to run an 

Working with operation depends on the special authorities it requires, as 
Domino servers described in this table. *ALLOBJ 


*JOBCTL

Usage notes: *SECADM 

z	 You can sort the Domino servers by name or by creation date*IOSYSCFG 
in the new window. To sort the servers by name, click Server 
Name at the top of that column. To sort the Domino servers 
by creation date, click Server Name again. 

z	 To view the Domino server status the user profile must have 
*USE object authority  to the QUSRNOTES library. 

Other operations over Domino tasks on the Web 

z	 FIND TOOLBAR only searches for the first satisfied result, next search begins from previous 
search result. 

z	 On TABLE ACTIONS TOOLBAR, Select All only takes effect on current page, this functionality 
isn't supported by the Domino tasks on the Web, it uses the "Start All Domino servers or 
controllers" and "Stop All Domino servers or controllers" operations to work with all severs. 

z	 On TABLE ACTIONS TOOLBAR, when Edit Sort is used with Server Name, by descending the 
list appears by the date created in default and by ascending the list is shown alphabetically, 
sorting list by "Status" or "Version" are not enabled. 

z	 Launch WebAdmin.nsf is used as instance of "Start Domino console" and "Server Administration" 
options used on Domino plug-in for System i Navigator. 

Operations not supported 

z	 Configure a new Domino server. 
z	 Work with Domino console. 
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Activities Help 

Lotus Notes 

Activities sidebar documentation updates 
The following documentation updates apply to the Notes 8.5 Beta Help: 

z	 When you access the Members list, you can click a name to open the person's business card. 
From the business card, you can click Send Mail to send an e-mail to the person or you can click 
one of the Lotus Connections feature links to open the feature in a Web browser. 

z	 When you enable Activities to-do items to be displayed in the Notes calendar, the Activities

sidebar must be open and populated with content before the to-do items will be displayed. 


z	 The ability to work with Activities offline is not enabled by default. If you want to see a technical 
preview of the offline feature, contact the Beta administrator. 

z	 Adding a link to a related activity is not supported. 

z	 Comments added as replies to a private entry can be seen by other members of the activity from 
the List view. 

z	 The ability to create entry templates, which is a feature introduced in the Web version of Activities 
with Lotus Connections 2.0, is not supported in the sidebar. 

z	 If you modify the Activities server settings from the Activities preferences window, you may be 
prompted to provide credentials more than once. Enter a valid user name and password when 
you are prompted to do so. 

z	 You cannot drag a Notes document to the Overview and My Activities by Priority views. 

z	 When you click a link to a document stored in a local Notes database from an entry, the document 
does not open correctly. 

z	 If you download a file attached to an entry, make changes to the file, and then save the file, the 
draft of the file attached to the entry is not updated automatically. To update the draft attached to 
the entry, you must delete the existing file attachment, and then add the updated version of the 
file to the entry as a new attachment. This method only works with standard entries; it does not 
work with to-do items or comment entries. You cannot attach a file to a to-do item or comment 
entry from which a file attachment was previously deleted. 
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Notices 
This information was developed for products and services offered in the USA. IBM may not offer the 
products, services, or features discussed in this document in all countries. Consult your local IBM 
representative for information on the products and services currently available in your area. Any reference 
to an IBM product, program, or service is not intended to state or imply that only that IBM product, 
program, or service may be used. Any functionally equivalent product, program, or service that does not 
infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to 
evaluate and verify the operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter described in this document. 
The furnishing of this document does not give you any license to these patents. You can send license 
inquiries, in writing, to: 

IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A. 

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property 
Department in your country/region or send inquiries, in writing, to: 

IBM World Trade Asia Corporation Licensing 
2-31 Roppongi 3-chome, Minato-ku 
Tokyo 106, Japan 

The following paragraph does not apply to the United Kingdom or any other country/region where such 
provisions are inconsistent with local law: 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" 
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, OR 
FITNESS FOR A PARTICULAR PURPOSE. 

Some states do not allow disclaimer of express or implied warranties in certain transactions; therefore, 
this statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. Changes are periodically 
made to the information herein; these changes will be incorporated in new editions of the publication. IBM 
may make improvements and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 

References in this publication to IBM products, programs, or services do not imply that they will be 
available in all countries in which IBM operates. Product release dates and/or capabilities referenced in 
this publication may change at any time at IBM’s sole discretion based on market opportunities or other 
factors, and are not intended to be a commitment to future product or feature availability in any way. 
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Any references in this information to non-IBM Web sites are provided for convenience only and do not in 
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part 
of the materials for this IBM product, and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes appropriate without 
incurring any obligation to you. 

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the 
exchange of information between independently created programs and other programs (including this 
one) and (ii) the mutual use of the information that has been exchanged, should contact: 

Lotus Software 
IBM Software Group 
One Rogers Street 
Cambridge, MA 02142 
USA 

Such information may be available, subject to appropriate terms and conditions, including in some cases 
payment of a fee. 

The licensed program described in this document and all licensed material available for it are provided by 
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement, or by 
any equivalent agreement between us. 

Any performance data contained herein was determined in a controlled environment. Therefore, the 
results obtained in other operating environments may vary significantly. Some measurements may have 
been made on development-level systems, and there is no guarantee that these measurements will be 
the same on generally available systems.  Furthermore, some measurements may have been estimated 
through extrapolation. Actual results may vary. Users of this document should verify the applicable data 
for their specific environment. 

Information concerning non-IBM products was obtained from the suppliers of those products, their 
published announcements, or other publicly available sources. IBM has not tested those products and 
cannot confirm the accuracy of performance, compatibility, or any other claims related to non-IBM 
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of 
those products. 

All statements regarding IBM's future direction or intent are subject to change or withdrawal without 
notice, and represent goals and objectives only. 

This information contains examples of data and reports used in daily business operations. To illustrate 
them as completely as possible, the examples include the names of individuals, companies, brands, and 
products.  All of these names are fictitious and any similarity to the names and addresses used by an 
actual business enterprise is entirely coincidental. 
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Trademarks 
IBM, the IBM logo, AIX, DB2, DB2 Universal Database, developerWorks, Domino, i5/OS, iSeries, Lotus, 
Lotus Notes, LotusScript, Notes, Passport Advantage, QuickPlace, Quickr, Redbooks, Sametime, 
Symphony, System i, System i5, System z, Tivoli, WebSphere, xSeries, z/OS, and zSeries are 
trademarks or registered trademarks of IBM Corporation in the United States, other countries, or both. 

Additional IBM copyright information can be found at: http://www.ibm.com/legal/copytrade.shtml 
TM

This product is Built on Eclipse  (http://www.eclipse.org). 

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems, Inc. in the United 
States, other countries, or both.


Microsoft, Windows, Windows Vista, Aero, and the Windows logo are trademarks or registered

trademarks of Microsoft Corporation in the United States, other countries, or both.


Apple, the Apple logo, iCal, Mac, Macintosh, Mac OS, and Safari are trademarks of Apple Inc., registered 

in the U.S. and other countries.


Intel and Pentium are trademarks of Intel Corporation in the United States, other countries, or both.


Macrovision and InstallShield are registered trademarks of Macrovision Corporation.


Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or

trademarks of Adobe Systems Incorporated in the United States, and/or other countries.


Google and Google Desktop are trademarks of Google Inc.


Yahoo! is a trademark of Yahoo! Inc.


The Graphics Interchange Format© is the Copyright property of CompuServe Incorporated.  GIF(sm) is a 

Service Mark property of CompuServe Incorporated.


UNIX is a registered trademark of The Open Group in the United States and other countries.


Linux is a trademark of Linus Torvalds in the United States, other countries, or both.


Other company, product and service names may be trademarks or service marks of others.
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